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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the relevant information is not taken into account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 

Preface 

Scope of this manual 
The present manual contains the description of function module FM 451 applicable at the 
time the manual was published. We reserve the right to publish modifications of FM 451 
functionality in a separate Product Information. 

Content of this manual 
This manual describes the hardware and software of the FM 451 positioning module. 

It consists of the following: 

● Basic information: Chapters "Product overview" to "Commissioning FM 451" 

● Reference information: Chapters "Machine data and increments" to "Examples" 

● Appendices: Chapters "Technical specifications", "Connection diagrams", and "Data 
blocks/error lists" 

● An index 

Standards 
The SIMATIC S7-400 product series fulfills the requirements and criteria of IEC 61131-2. 

Recycling and disposal 
The FM 451 is low in contaminants and can therefore be recycled. For ecologically 
compatible recycling and disposal of your old device, contact a certificated disposal service 
for electronic scrap. 
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Additional support 
If you have any further questions about the use of products described in this manual and do 
not find the right answers here, contact your local Siemens representative 
(http://www.siemens.com/automation/partner): 

A guide to the technical documentation for the various products and systems is available on 
the Internet: 

● SIMATIC Guide manuals (http://www.siemens.com/simatic-tech-doku-portal) 

The online catalog and online ordering systems are also available on the Internet: 

● A&D Mall (http://www.siemens.com/automation/mall) 

Training center  
To help you get started with automation technology and systems, we offer a variety of 
courses. Contact your regional Training Center or the central Training Center in D-90327 
Nuremberg, Germany. 

● Internet: SITRAIN homepage (http://www.sitrain.com) 

Technical Support 
You can access technical support for all A&D projects via the following: 

● Online support request form: (http://www.siemens.com/automation/support-request) 

Service & Support on the Internet 
In addition to our documentation, we offer a comprehensive online knowledge base on the 
Internet at: 

Industry Automation and Drive Technologies - Homepage 
(http://www.siemens.com/automation/service&support)  

There you will find the following information, for example: 

● The newsletter that provides up-to-date information on your products. 

● The documents you need via our Search function in Service & Support. 

● A forum for global information exchange by users and specialists. 

● Your local partner for Automation and Drives. 

● Information about on-site service, repairs, and spare parts. Much more can be found 
under "Services". 

http://www.siemens.com/automation/partner�
http://www.siemens.com/simatic-tech-doku-portal�
http://www.siemens.com/automation/mall�
http://www.sitrain.com/�
http://www.siemens.com/automation/support-request�
http://www.siemens.com/automation/service&support�
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Product overview 1
1.1 FM 451 positioning module 

Description of the FM 451 
The FM 451 positioning module is used for controlled positioning with rapid traverse/creep 
speed drives in the S7-400 automation system. The module has 3 independent channels 
and, thus controls one rotary axis axis or one linear axis at a time. The module supports one 
incremental encoder or absolute encoder (SSI) for each channel. 

You can operate several FM 451 positioning modules simultaneously. The module also 
supports combinations with other FM/CP modules. A typical application is the combination of 
the module with an FM 452 electronic cam controller. 

 
Figure 1-1 Configuration of a SIMATIC S7-400 with FM 451 
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1.2 Application areas of the positioning module 

Overview 
● Packaging machines 

● Lifting and conveying equipment 

● Woodworking machinery 

Example: Controlling delivery processes 

Various wooden parts are processed using a profiling machine. Various work processes 
and, with that, different cutting heads, are required to machine the wood. The various 
cutting heads are exchanged by means of a controlled positioning process. 

● Paper making machines and printing machines 

● Rubber and plastics processing machines 

Example: Simply handling processes 

The injection molded parts in an injection molding machine are removed from the work 
piece by means of a gripper arm. The gripper arm is controlled by the positioning module. 

● Building materials industry 

● Machine tools 
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1.3 Configuration of a controlled positioning with an FM 451 

Control circuit   
The following figure shows the components of a controlled positioning with rapid 
traverse/creep speed drives. 

 
Figure 1-2 Controlled positioning 

Power unit and safety system    
The digital outputs of the FM 451 control the power unit (e.g., a protective circuit). The 
FM 451 has 4 control modes (see chapter "Machine data of the drive (Page 68)").  

The power unit shuts off the motor if the safety system responds (EMERGENCY STOP 
switch or hardware limit switch).    

Motor   
The motor drives the axis, controlled by the power unit. 
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Encoder   
The encoder returns position and direction data. Connectable encoders are: 

● Incremental encoder with 5 V differential signal, symmetrical 

● Incremental encoder with 24 V signal, asymmetrical 

● SSI absolute encoder 

FM 451 positioning module   
The FM 451 can position up to 3 axes independently based on the rapid traverse/creep 
speed process. 

The power section is controlled by the 4 digital outputs (see chapter "Machine data of the 
drive (Page 68)"). 

The FM 451 positioning module establishes the current actual position value of the axis from 
the encoder signals, which are proportional to the distance moved (see chapter "Machine 
data of the encoder (Page 79)" and chapter "Resolution (Page 86)"). 

The FM 451 provides the following operating modes and functions: 

● "Jog" mode 

(see chapter "Configuring jog mode (Page 101)") 

● "Reference point approach" mode: 

(see chapter "Configuring reference point approach mode (Page 105)") 

● "Absolute/relative incremental approach" mode 

(see chapter "Configuring incremental approach mode (Page 112)") 

● Set actual value / set actual value on-the-fly 

(see chapter "Configuring set actual value/set actual value on-the-fly/cancel set actual 
value (Page 121)") 

● Zero offset 

(see chapter "Configuring zero offset (Page 124)") 

● Set reference point 

(see chapter "Configuring set reference point (Page 127)") 

● Length measurement/edge detection 

(see chapter "Configuring length measurement / edge detection (Page 129)") 

● Loop approach 

(see chapter "Configuring loop approach (Page 132)") 
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CPU   
The CPU executes the user program. The user program and the module exchange data and 
signals by means of function calls. 

PG/PC 
The PG/PC is used for 

● Assigning parameters: You assign parameters for the FM 451 using the parameter 
assignment dialogs or the parameter DB (see chapter "Auto-Hotspot"). 

● Programming: You program the FM 451 functions you can implement directly in the user 
program. 

● Testing and commissioning: You test and commission the FM 451 with the help of the 
parameter assignment dialogs. 

Overview of the positioning module 
● 3 axes, axes types:  

– Linear axis 

– Rotary axis 

● 4 digital outputs per axis 

● 4 digital inputs per axis 

● Typical drives/motors: 

– Standard motor, contactor-controlled 

– Standard motor on frequency inverter (e.g. MICROMASTER) 

– Asynchronous motor on power unit with vector control 

● Position measuring systems: 

– Incremental encoder 5 V, symmetrical 

– Incremental encoder 24 V, asymmetrical 

– SSI absolute encoder 

● Monitoring functions: 

– Operating range monitoring by means of software limit switches 

– Standstill monitoring 

– Encoder monitoring 

– Monitoring for axis motion and target approach 
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● System environment: 

– Central use SIMATIC S7-400 

● System integration: 

– Module replacement without programming device is possible 

– Teleservice possible 
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Basics of positioning 2
2.1 Controlled positioning 

Controlled positioning   
Each positioning process is characterized by  

● A start position 

● The target of the positioning 

● Parameters that determine the sequence of the positioning 

The target is initially approached at a higher velocity (rapid traverse). At a specified distance 
from the target, the velocity switches to creep speed. The drive is switched off shortly before 
the axis reaches the target - also at a specified distance from the target. In doing so, the 
module monitors the target approach.  

The drive is controlled via digital outputs with rapid traverse or creep speed and in the 
appropriate direction.  
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2.2 Ranges and switching points of the positioning module 

Target 
The target is the absolute or relative position on the axis that is approached during a 
positioning process. 

Definition of the switching points and switching ranges 
The following areas and positions can be assigned for each controlled positioning: 

 
Range Description 

Operating range defines the area that you define for your task by means of the software 
limit switches and the end of the rotary axis. 

Changeover difference defines the distance from the target at which the drive changes from 
rapid traverse to creep speed. 

Changeover point defines the position at which the drive changes from rapid traverse to 
creep speed. 

Switch-off difference defines the distance from the target at which the drive is switched off. 
Switch-off point defines the position at which the drive is switched off. The positioning 

module then adopts the monitoring functions from this point on. 
Target range defines the positioning precision for your application and surrounds the 

target symmetrically. 
Standstill range defines a symmetrical area around the target that will be monitored by 

the positioning module. 
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The following figure shows how the switching points and switching differences can be 
arranged for a positioning. For simplification purposes, it is assumed that the actual velocity 
changes linearly over the distance traversed. The emerging ramps can be explained by 
mechanical inertia or by the parameter assignment possibilities of the power section. 

 
Figure 2-1 Switching points and switching differences 

The following figure shows how the switching ranges can be arranged around the target. 

 
① Operating range 
② Changeover difference in plus traversing direction 
③ Changeover difference in minus traversing direction 
④ Switch-off difference in plus traversing direction 
⑤ Switch-off difference in minus traversing direction 
⑥ Standstill range 
⑦ Target range 

Figure 2-2 Switching ranges around a target 
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Installing and removing the FM 451 3
Important safety rules 

Certain important rules and regulations govern the integrating of an S7-400 with FM 451 in a 
plant or system. These are described in the Installation Manual Automation System 
S7-400: Hardware and Installation 
(http://support.automation.siemens.com/WW/view/en/1117849). 

Selecting slots    
Like a signal module, the FM 451 positioning module can be installed anywhere in a central 
rack or expansion rack. 

Configuring the mechanical setup 
Refer to the Installation Manual Automation System S7-400: Hardware and Installation 
(http://support.automation.siemens.com/WW/view/en/1117849) for options on the 
mechanical setup and how to proceed during configuration. 

Installation and removal tools   
You require a 4.5 mm screwdriver to install or remove the FM 451. 

Installing the FM 451 positioning module    
1. Hook the top of the FM 451 and swivel it downwards. 

2. Screw-tighten the FM 451 (tightening torque approx. 0.8 Nm to 1.1 Nm). 

3. Label the FM 451 with its slot number. Use the number wheel supplied with the rack for 
this purpose. 

The required numbering scheme and the procedure for defining the slot numbers are 
described in the Installation Manual Automation System S7-400: Hardware and 
Installation (http://support.automation.siemens.com/WW/view/en/1117849). 

Removing the FM 451 positioning module    
1. Switch off the power unit. 

2. Loosen and remove the front connector. 

3. Release the cover of the encoder interface. 

4. Detach the sub D connector to the encoder. 

5. Loosen the fixing screws on the module. 

6. Swivel the module up, and then unhook it from the rail. 

http://support.automation.siemens.com/WW/view/en/1117849�
http://support.automation.siemens.com/WW/view/en/1117849�
http://support.automation.siemens.com/WW/view/en/1117849�
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Wiring the FM 451 4
4.1 Important safety information 

Important safety rules 
For the safety concept of the plant it is essential that the following switching elements are 
installed and adapted to the conditions of your plant.  

● EMERGENCY STOP switch with which you can switch off the entire plant.  

● Hardware limit switch that directly effects the power sections of all drives.  

● Motor circuit-breaker 
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4.2 Description of the encoder interface 

Location of the sub D sockets     
The following figure shows the installation position and designation of the sockets on the 
module. You can connect an incremental encoder or absolute encoder (SSI) to the sub D 
sockets (see chapter "Incremental encoder (Page 141)" and chapter "Absolute encoders 
(Page 144)"). 

 
CH  Channel 

Figure 4-1 Position of the sub D sockets (CH1, CH2, and CH3 encoders) 

Assignment of the encoder interfaces (CH1, CH2, and CH3 encoders)    
 
Pin Name Incremental encoder 

(24V) 
Incremental encoder (5V) Absolute encoder 

1 A* Encoder signal A  --- --- 
2 CLS --- --- SSI shift clock 
3 /CLS --- --- SSI shift clock inverse 
4 B* Encoder signal B --- --- 
5 24 VDC Encoder supply  Encoder supply  Encoder power supply  
6 5.2 VDC --- Encoder power supply  Encoder power supply  
7 M Ground Ground Ground 
8 N* Zero mark signal --- --- 
9 RE Current sourcing/current 

sinking1) 
--- --- 

10 N --- Zero mark signal  --- 
11 /N --- Zero mark signal, inverse  --- 
12 /B --- Encoder signal B, inverse --- 
13 B --- Encoder signal B  --- 
14 /A / /DAT --- Encoder signal A, inverse  SSI data inverse 
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Pin Name Incremental encoder 
(24V) 

Incremental encoder (5V) Absolute encoder 

15 A / DAT --- Encoder signal A  SSI data 
1) See chapter "Wiring diagram of the incremental encoder Siemens 6FX 2001-4 (Up = 24 V; HTL) 
(Page 186)". 
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4.3 Connecting the encoders 

More information 
You can find information about suitable encoders and encoder cables in the chapters 
"Encoder (Page 141)" and "Connection diagrams (Page 183)". 

Procedure   
Proceed as follows to connect the encoder: 

1. Connect the connecting cable to the encoder. 

For some encoders, the cable may have to be fabricated according to the manufacturer's 
specifications on the cable end for the encoder. 

2. The encoder cables must be shielded. 

3. Cables A and /A, B and /B, N and /N for the incremental encoder and cables DAT and 
/DAT, CLS and /CLS for the absolute encoder must be twisted in pairs. 

4. Open the front panel and plug the sub D connector onto the FM 451. 

5. Lock the connector using the finger screws. Close the front panel. 

6. Remove the insulation material on the connecting cable and connect the cable shield to 
the shield/protective conductor bar. 

 
Figure 4-2 Connection of an encoder to the FM 451 positioning module 
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4.4 Description of the front connector 

Front connector   
You use the 48-pin front connector to connect the supply voltages of the encoders and the 
digital outputs. Then, the digital inputs and outputs assigned to the channels are connected. 

Assignment of front connector (X1)     
 
Terminal Name Meaning Incremental encoder Absolute encoder 
1  
2  

Assigned; contains cable jumpers for detection of inserted front connector. 

3 1L+ 24 V DC auxiliary voltage for the encoder supply 
4 to 7  Not used 
8 1I0 Channel 1: Digital input 0 Reference point switch   Not used 
9 1I1 Channel 1: Digital input 1 Reversing switch   Not used 
10 1I2 Channel 1: Digital input 2 Enable input 
11 1I3 Channel 1: Digital input 3 Input for "Set actual value on-the-fly"/ length 

measurement/edge detection/external event for 
increment number 252 

12  Not used 
13 2L+ 
14 2L+ 

24 V DC auxiliary voltage for the load current supply 
Both terminals are internally connected on the module. 

15 2I0 Channel 2: Digital input 0 Reference point switch Not used 
16 2I1 Channel 2: Digital input 1 Reversing switch Not used 
17 2I2 Channel 2: Digital input 2 Enable input 
18 2I3 Channel 2: Digital input 3  Input for "Set actual value on-the-fly"/ length 

measurement/edge detection/external event for 
increment number 252 

19 3I0 Channel 3: Digital input 0 Reference point switch Not used 
20 3I1 Channel 3: Digital input 1 Reversing switch Not used 
21 3I2 Channel 3: Digital input 2 Enable input 
22 3I3 Channel 3: Digital input 3  Input for "Set actual value on-the-fly"/ length 

measurement/edge detection/external event for 
increment number 252 

23 to 24  Not used 
25 3L+ 
26 3L+ 

24 V DC auxiliary voltage for the load current supply 
Both terminals are internally connected on the module. 

27 1Q0 Channel 1: Digital output 0  
28 1Q1 Channel 1: Digital output 1  
29 1Q2 Channel 1: Digital output 2  
30 1Q3 Channel 1: Digital output 3  
31 2Q0 Channel 2: Digital output 0  
32 2Q1 Channel 2: Digital output 1  
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Terminal Name Meaning Incremental encoder Absolute encoder 
33 2Q2 Channel 2: Digital output 2  
34 2Q3 Channel 2: Digital output 3  
35 to 36  Not used 
37 4L+ 
38 4L+ 

24 V DC auxiliary voltage for the load current supply 
Both terminals are internally connected on the module. 

39 3Q0 Channel 3: Digital output 0  
40 3Q1 Channel 3: Digital output 1  
41 3Q2 Channel 3: Digital output 2  
42 3Q3 Channel 3: Digital output 3  
43 to 47  Not used 
48 M Ground for auxiliary voltages 1L+, 2L+, 3L+, and 4L+ 

Auxiliary voltage for the encoder supply (1L+, M)    
Here, you connect a 24 VDC auxiliary voltage for the encoder supply. The reference 
potential of this supply (M) is connected to the ground of the load current supply (M) in the 
FM 451. 

The 24 V DC auxiliary voltage for the encoder supply is monitored for undervoltage and wire 
break. 

On the encoder interface (sub D sockets: CH1, CH2, and CH3 encoders) are provided with 
24 V DC and 5.2 V DC for the different encoder types. 

 
 

CAUTION  
Verify the correct polarity of the 24 V DC auxiliary voltage for the encoder supply (1L+, M). 

If you reverse the polarity of the 24 V DC auxiliary voltage for the encoder supply, the 
module will be damaged and will have to be replaced. 

 

Auxiliary voltage for the load current supply (2L+, 3L+, 4L+, M) 
You must connect the 24 V DC auxiliary voltages for the load current supply of the digital 
outputs to the 2L+, 3L+, 4L+, and M terminals. 

 
 

CAUTION  
Verify the correct polarity of the 24 V DC auxiliary voltage for the load current supply (2L+, 
3L+, 4L+, M). 

If you reverse the polarity of the 24 V DC auxiliary voltage for the load current supply, the 
module will be damaged and will have to be replaced. 
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Wiring information for 24 V DC 
When wiring, note that the terminals 1L+ to 4L+ must be interconnected so that the module 
will operate error-free. 

Start by wiring the 24 V DC to terminal 38 and connect the auxiliary voltage of terminal 37 to 
terminal 26. Use the same procedure for the other terminals. 

Alternatively, you can also connect separate voltage supplies to the 1L+ (encoder), 2L+ 
(channel 1), 3L+ (channel 2), and 4L+ (channel 3) connections. Make sure that all voltage 
supplies have a common ground potential. In this case, synchronization of the axes will be 
retained following a power failure in the auxiliary voltages for the load current supply. 

Load current supplies 
The DC load current supply must meet the following requirements: 

Only a safe, isolated extra-low voltage of ≤ 60 V DC may be used as the load current supply. 
Safe isolation can be implemented, for example, by adhering to the specifications  

● VDE 0100 Part 410 / HD 384-4-41 / IEC 364-4-41 (as function low voltage with safe 
isolation) and/or 

● VDE 0805 / EN 60950 / IEC 950 (as safety extra-low voltage SELV) or VDE 0106 
Part 101. 

12 digital inputs (1I0 to 3I3)   
The FM 451 has 4 digital inputs per channel. 

You can connect bounce-free switches (24V current sourcing) or non-contact sensors (2- or 
3-wire proximity switches) to the 12 digital inputs. 

The digital inputs are not monitored for short circuits or wire break and have a non-isolated 
connection to the encoder supply ground. 

A separate LED indicates the state of each input. 
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12 digital outputs (1Q0 to 3Q3)   
The FM 451 has 4 digital outputs per channel. 

The power unit is controlled via the digital outputs. The function of the digital outputs 
depends on the control mode. You select the control mode (see chapter "Machine data of 
the drive (Page 68)") in the configuration software or in the parameter DB. 

The digital outputs are not monitored for short circuits or wire break and have a non-isolated 
connection to the encoder supply ground. 

The associated LED indicates the state of each output. 

Table 4- 1 Functions of the digital outputs, x for channel 1, 2, or 3 

Control mode   Output Q 

1 2 3 4 
xQ0 Rapid speed Rapid speed/Creep 

speed 
Rapid speed Rapid speed plus 

xQ1 Creep speed Position reached Creep speed Creep speed plus 
xQ2 Travel plus Travel plus Travel plus Rapid speed minus 
xQ3 Travel minus Travel minus Travel minus Creep speed minus 
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4.5 Wiring the power section 

Power section   
The power section, e.g. a simple contactor circuit, is connected to the digital outputs of the 
positioning module and controls the motor. 

Contactor circuit   
The following figure shows the control and load circuit of a power section.    

The functions of the digital outputs correspond to control mode 1(refer to the section entitled 
"Machine data of the drive (Page 68)"). 

 
K1 Direction - plus 
K2 Direction - minus 
K3 Rapid traverse 
K4 Creep speed 
E1 Hardware limit switch minus 
E2 Hardware limit switch plus 

Figure 4-3 Contactor circuit 
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Operating principle of the contactor circuit    
The contactors K1 and K2 control the rotational direction of the motor. Both contactors are 
mutually locked by means of the opening contacts K2 and K1. The hardware limit switches 
E1 and E2 are the limit switches minus / plus. The motor is switched off when one of these 
limit switches is overrun. 

The contactors K3 and K4 switch the motor from rapid traverse to creep speed. Both 
contactors are mutually locked by means of the opening contacts K4 and K3. 

 
 

CAUTION  
Mutually lock the network contactors. 

The previous figure shows the mutual locking of the network contactors.  

Non-compliance with these instructions could cause a short circuit in the power network. 
 

 
 

 Note 

Direct connection of inductances, e.g, of relays and contactors, is possible without an 
external protective circuit. 

If SIMATIC output circuits can be switched off by means of additionally installed contacts, 
e.g. relay contacts, additional overvoltage protection devices must be provided for 
inductances. See the following example of overvoltage protection 
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Example for overvoltage protection    
The following figure illustrates an output power circuit requiring additional overvoltage 
protectors. DC-activated coils will be wired with diodes or Z diodes. 

 
Figure 4-4 Relay contact in the output power circuit 
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4.6 Wiring the front connector 

Connecting cables  
● The cables for digital inputs and digital outputs must be shielded if they exceed a certain 

lengths: 

– Digital inputs: cable length > 50 m 

– Digital outputs: cable length > 100 m 

● The shields on the cables must be attached on both ends. 

● Flexible cable, cross section 0.25 to 1.5 mm2 

● End sleeves are not required. If you use want to use end sleeves then use only those 
without insulation collar (DIN 46228, Form A, short version). 

Required tools 
3.5 mm screwdriver or power screwdriver. 

Wiring steps   
 

 

WARNING  
Risk of injury or material damage if the power supply is not shut off. 

If you wire the FM 451 front connector while the system is in live state, you will risk injury 
from electric shock! 

Always switch off power before you wire the FM 451! 

If no EMERGENCY OFF switch is installed, damage may be caused by connected 
equipment units. 

Install an EMERGENCY OFF switch to be able to shut down the connected drives when 
using the configuration software to operate the FM 451. 

 

1. Remove the cover from the front connector. 

2. Strip 6 mm of insulation from the cables, and press on end sleeves, if applicable. 

3. Feed the accompanying strain relief clamp into the front connector. 

4. To exit the cables at the bottom, start the wiring at the bottom, otherwise at the top. 
Screw-tighten any unused terminals. Tightening torque = 0.6 Nm to 0.8 Nm. 

5. Attach the strain relief to the connector. 

6. Tighten the strain relief for the cable strand. 
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7. Push the front connector into the operating position. To do this, press the interlock 
element. 

8. Label the terminals on the enclosed labeling strip. 

Non-isolation 
The ground of the auxiliary voltages has a non-isolated connection to the CPU ground; i.e., 
you have to connect pin 48 (M) to the CPU ground using a low-resistance connection. 

For an external encoder supply, you must also connect the ground of the external encoder 
supply to the CPU ground using a low-resistance connection. 
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Installing the configuration package 5
Requirement   

Before starting to assign parameters for the positioning module, note the requirements in the 
readme.rtf file, in particular, regarding the required version of STEP 7. The readme.rtf file is 
available on the included CD. 

 

Content of the configuration package   

 
Figure 5-1 Content of the configuration package 

Procedure    
The entire configuration package can be located on the supplied CD.  

1. De-install any already existing configuration packages. 

2. Place the CD in the CD drive of your PC or PG. 

3. Start Setup.exe and follow the step-by-step setup instructions displayed by the 
installation program. 
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Result 
The components of the configuration package are installed in the following directories: 

● SIEMENS\STEP7\S7LIBS\FMx51LIB: FCs, FBs, and UDTs 

● SIEMENS\STEP7\S7FABS: configuration software, Readme, online help 

● SIEMENS\STEP7\EXAMPLES: Examples 

● SIEMENS\STEP7\S7MANUAL\S7FABS: Getting Started, manuals 

 

 Note 

If, when installing STEP 7, you chose a directory other than SIEMENS\STEP7, then this 
directory will be entered. 
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Programming the FM 451 6
6.1 Basics of programming a positioning module 

Task   
You can assign parameters, control, and commission each channel of the positioning 
module via a user program. The following chapter illustrates how to design a user program to 
suit your application. 

Preparation 
1. In SIMATIC Manager, open the block library FMx51LIB and copy the required functions 

(FC) and block templates (UDT) to the block container of your project. If the block 
numbers are already being used, assign new numbers. The block names are entered 
unchanged in the symbol table of your S7 program.    

 

Name Meaning 
FC ABS_INIT (FC 0) Required to initialize the channel DB after a module start-up 
FC ABS_CTRL (FC 1) Required for data exchange and for controlling 
FC ABS_DIAG (FC 2) Required if you are processing detailed diagnostic information 

in the program or want to make this available for a operator 
control and monitoring system 

UDT ABS_CHANTYPE(UDT 1) Required in order to create a channel DB for each channel; 
this is then used by the FC ABS_INIT and FC ABS_CTRL 

UDT ABS_DIAGTYPE (UDT 2) Required in order to create a diagnostic DB for each module; 
this is then used by the FC ABS_DIAG 

UDT ABS_PARATYPE(UDT 3) Required in order to create a parameter DB with parameters; 
this is then used by the FC ABS_CTRL in order to write or 
read machine data and increment tables 

2. Create the data blocks (DBs) using the UDTs in the block container of your S7 program: 

– a separate channel DB for each channel. 

– If you want to write or read parameters using the user program, you need a separate 
parameter DB for each channel. 

– If you would like to execute the diagnostics using the user program, you require only a 
diagnostic DB for each module. 
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3. Enter the module address in the associated channel DB and, if necessary, also in the 
corresponding diagnostic DB in the "MOD_ADDR" parameter. 

Proceed as follows to enter the module address:  

– Recommended procedure: 

Assign the module address to the channel DB/diagnostic DB in the user program so 
that the assignment of the module address takes place when you call the user 
program in OB 100. 

– Alternative procedure: 

You can have the module address entered automatically if you select the module in 
HW Config, open the "Properties" dialog with the menu command Edit > Object 
Properties, and use the "Mod_Adr" button there to select a channel DB and diagnostic 
DB, if necessary. But in this case the values entered in the channel DB/diagnostic DB 
(including the module address) are reset to their initial values in the event of a 
consistency check (menu command Edit > Check block consistency opens the "Check 
block consistency" dialog) followed by a compilation (menu command Program > 
Compile All in the "Check block consistency" dialog box).  

The values are not changed if there is only a consistency check without compilation. 

The menu command Edit > Compile All is only required within the consistency check if 
the project was last edited with STEP 7 V5.0 Service Pack 2 or later. 

4. Enter the channel number and, if necessary, the number of the parameter DB also in the 
respective channel DB. 

5. If your programming device or PC is connected to a CPU, you can now download the 
FCs and DBs to the CPU. 
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The following figure shows you how the positioning module, FCs, DBs and OBs 
communicate with each other. 

*) The module address (channel DB/diagnostic DB) entered in the "MOD_ADDR" parameter is used for accessing the 
module. We recommend you assign the module address to the channel DB/diagnostic DB in the user program so 
that the assignment of the module address takes place when you call the user program in OB 100. 

Figure 6-1 Data exchange between FCs, DBs and positioning module 
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6.2 FC ABS_INIT (FC 0) 

Task 
The FC ABS_INIT deletes the following data in the channel DB: 

● The control signals 

● The checkback signals 

● The trigger bits, done bits, and error bits of the jobs 

● The function switches and their done bits and error bits 

● The job management for the FC ABS_CTRL 

Call 
The function must be run through for each channel after start-up (supply voltage on) of the 
module or the CPU. Call the function, for example, in the start-up OB 100 and the 
insertion/removal OB 83 or the initialization phase of your user program. This ensures that 
your user program does not access obsolete data after a CPU or module restart. 

Data block used 
Channel DB: 

The module address must be entered in the channel DB. 

Call parameters 
 
Name Data type P-type Meaning 
DB_NO INT IN Number of the channel DB 

Return values 
The specified function does not supply a return value.  
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6.3 FC ABS_CTRL (FC 1) 

Tasks     
You can use FC ABS_CTRL to read operating data for each channel of the module, assign 
channel parameters, and control the operation. For these tasks, you use control signals, 
checkback signals, function switches, and write and read jobs. 

Each time it is called, the function performs the following actions: 

● Read checkback signals: 

The FC ABS_CTRL reads all checkback signals for a channel and enters them in the 
channel DB. The control signals and jobs are not executed until this task is completed, 
which means the checkback signals reflect the channel status prior to the function call.    

● Job management:  

The FC ABS_CTRL processes the write and read jobs and transmits data between the 
channel DB, parameter DB, and the module. 

● Write control signals:   

The control signals entered in the channel DB are transmitted to the module. 

Call    
The FC ABS_CTRL must be called cyclically for each channel, e.g., in OB 1.  

Before you call the FC ABS_CTRL, enter all the data needed to execute the required 
functions into the channel DB. 

Data blocks used    
● Channel DB: 

The module address and the channel number must be entered in the channel DB. 
Incorrect information can lead to I/O access errors or to an incorrect module accesses, 
which can produce data corruption. 

● Parameter DB: 

If you want to write or read machine data using jobs, you require a parameter DB whose 
number must be entered in the channel DB. 

Call parameters    
 

Name Data type P-type Meaning 
DB_NO INT IN Number of the channel DB 
RET_VAL INT OUT Return value 
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Return values    
The function provides the following return values: 

 
RET_VAL BR Description 

1 1 At least 1 job active 
0 1 No job active, no error 
-1 0 Error: data error (DATA_ERR) or communication error (JOB_ERR) occurred

Jobs    
Data exchange with the module other than the control and checkback signals is handled 
using jobs.  

To start a job, set the corresponding trigger bit in the channel DB and provide the relevant 
data for write jobs. You then call FC ABS_CTRL to execute the job.  

Due to the required confirmations from the module, a write job requires at least 3 calls or OB 
cycles. A read job is executed immediately. 

Once a job has been completed, the function cancels the trigger bit. The next time the 
function is called, the subsequent job is identified and executed.  

For each job there is not only a trigger bit (extension _EN as in "enable") but also a done bit 
and an error bit. In their names, they have the ending _D for "done" or _ERR for "error". The 
FC ABS_CTRL updates the done bits and error bits when execution of a job is complete. 
You should set these bits to 0 after they have been evaluated or before a job is started. 

If you set the JOBRESET bit, all the done bits and error bits are reset before the pending 
jobs are processed. The JOBRESET bit is then reset to 0. 

Function switches    
The function switches activate and deactivate the states of the channel. A job for writing the 
function switches is only executed if changes were made to a switch setting. The setting of 
the function switch is latched after the job has been executed. 

Function switches and jobs can be used at the same time in one FC ABS_CTRL call. 

As with the jobs, there are trigger bits with the ending _ON/_OFF, done bits with the ending 
_D, and error bits with the ending _ERR for the function switches. 

To be able to evaluate the done bits and error bits of the function switches, you should set 
these bits to 0 before you issue a job to change a function switch. 
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Job processing sequence    
You can issues several jobs at the same time. If no jobs are active, the job management of 
the FC ABS_CTRL searches starting with the MDWR_EN job to determine whether trigger 
bits are set or changes have been made to function switches. If a job is found, it is 
processed. If the job is finished, the job management searches for the next job to be 
processed. If the search reaches the last job (ENCVAL_EN), searching starts over with the 
MDWR_EN job. This search is repeated until all jobs have been processed.  

The jobs are processed in the following technologically appropriate order: 

 
Sequence Address in the 

channel DB 
Name Meaning Reset by 

Write jobs   
1 35.0 MDWR_EN Write machine data FC 1 
2 35.1 

35.2 
35.3 
36.4 

MD_EN 
DELDIST_EN 
AVALREM_EN 
DELDIAG_EN 

Enable machine data 
Delete distance-to-go 
Cancel set actual value 
Clear diagnostic buffer 

FC 1 

3 35.4 TRGL1WR_EN Write increment table 1 FC 1 
4 35.5 TRGL2WR_EN Write increment table 2 FC 1 
5 35.6 REFPT_EN Set reference point FC 1 
6  

34.0 
34.1 
34.2 
34.3 
34.4 

Function switches: 
PLOOP_ON 
MLOOP_ON 
EI_OFF 
EDGE_ON 
MSR_ON 

 
Loop approach in plus direction 
Loop approach in minus direction 
Do not evaluate enable input 
Edge detection ON 
Length measuring ON 

User program 

7 35.7 AVAL_EN Set actual value FC 1 
8 36.0 FVAL_EN Set actual value on-the-fly FC 1 
9 36.1 ZOFF_EN Set zero point offset FC 1 
10 36.2 TRG252_254_EN Write increment for increment number 

252/254 
FC 1 

11 36.3 TRG255_EN Write increment for increment number 255 FC 1 
Read jobs   
12 36.5 MDRD_EN Read machine data FC 1 
13 36.6 TRGL1RD_EN Read increment table 1 FC 1 
14 36.7 TRGL2RD_EN Read increment table 2 FC 1 
15 37.0 MSRRD_EN Read measured values FC 1 
16 37.1 ACTSPD_EN Read current velocity, distance-to-go, and 

current increment 
FC 1 

17 37.2 ENCVAL_EN Read encoder data FC 1 

This sequence enables you to initiate a complete positioning operation with a set of jobs and 
control signals. The jobs start with the writing and activating of machine data, and continue 
with the setting of the external enable input and, finally, the writing of increments for the 
incremental approaches.  
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Control signals    
If a STOP signal or an operator error is pending or the drive enable is missing, the function 
resets the START, DIR_M, and DIR_P control signals. 

You can restart an approach after you have acknowledged the operator error 
(OT_ERR_A=1). With this acknowledgement, you cannot issue additional jobs and control 
signals. 

The function sets the acknowledgement for the operator error (OT_ERR_A) to 0 if there is no 
operator error pending. 

The function resets the START, DIR_P, and DIR_M start signals when the channel signals 
the start of the approach, except in "Jog" mode. 

The function withholds all control signals with the exception of the OT_ERR_A operator error 
acknowledgement if the axis parameters are not assigned. 

Jobs and control signals    
You can issue several jobs at the same time, if necessary, along with control signals 
required for the positioning. If at least one write job has been issued simultaneously with the 
START, DIR_M, or DIR_P control signal, the function withholds these control signals until the 
write jobs have been processed. 

Jobs during active positioning 
If issued during active positioning, the write jobs listed in the following table are withheld until 
positioning is finished and then implemented on the next call of the function. 

 
Address Name Type Initial value Comment 

34.0 PLOOP_ON BOOL FALSE 1 = Loop approach in plus direction 
34.1 MLOOP_ON BOOL FALSE 1 = Loop approach in minus direction 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 
34.3 EDGE_ON BOOL FALSE 1 = Edge detection on 
34.4 MSR_ON BOOL FALSE 1 = Length measurement on 
35.1 MD_EN BOOL FALSE 1 = enable machine data 
35.2 DELDIST_EN BOOL FALSE 1 = Delete distance-to-go 
35.3 AVALREM_EN BOOL FALSE 1 = Cancel set actual value 
35.6 REFPT_EN BOOL FALSE 1 = Set reference point coordinate 
35.7 AVAL_EN BOOL FALSE 1 = Set actual value 
36.1 ZOFF_EN BOOL FALSE 1 = Set zero offset 
36.4 DELDIAG_EN BOOL FALSE 1 = Clear diagnostic buffer 

Startup      
Call FC ABS_INIT at the startup of the module or CPU (see chapter "FC ABS_INIT (FC 0) 
(Page 40)"). Among other things, this resets the function switches. The FC ABS_CTRL 
acknowledges the module startup. During this time, RET_VAL and JOBBUSY = 1. 
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Job status   
You can read the status of the job execution using the RET_VAL return value and the 
JOBBUSY activity bit in the channel DB. You can determine the status of a single job by 
evaluating its trigger, done, and error bits.  

 
 RET_VAL JOBBUSY Trigger bit 

_EN 
Done bit _D Error bit 

_ERR 
Job active 1 1 1 0 0 
Job completed 
without errors 

0 0 0 1 0 

Job completed with 
errors 

-1 0 0 1 1 

Write job aborted -1 0 0 0 1 

Reaction to errors    
If faulty data have been written during a write job, the channel supplies checkback signal 
DATA_ERR = 1 in the channel DB. If an error occurs in the communication with the module 
during a write or read job, the error cause is stored in the JOB_ERR parameter in the 
channel DB.  

● Error in a write job: 

If an error occurs in a job, the trigger bit is canceled and error bit _ERR and done bit _D are 
set. The trigger bit is also canceled for all write jobs still pending, but only error bit _ERR is 
set. The pending write jobs are canceled because jobs could pile up in this case. 

The pending read jobs will continue to be processed. JOB_ERR is reset again for each job. 

● Error in a read job: 

If an error occurs in a job, the trigger bit is canceled and error bit _ERR and done bit _D are 
set.  

The read jobs still pending continue to be processed. JOB_ERR is reset again for each job. 

For further error information, refer to the description of the JOB_ERR and DATA_ERR 
parameters (see chapters "Diagnostics (Page 147)" and "Data and structure of the 
diagnostic DB (Page 196)"). 
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Program structure   
The figure below shows the basic structure of a user program that is used to cyclically 
control a channel of the module after a one-time startup initialization. The RET_VAL return 
value of the FC ABS_CTRL is used in the user program for a general error evaluation.  

For every other channel, a sequence according to the following figure can be executed 
independently in parallel. 

 
Figure 6-2 General program structure 
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6.4 FC ABS_DIAG (FC 2) 

Tasks     
With the FC ABS_DIAG you read out the diagnostic buffer of the module and make it 
available for a display in the HMI system or for a programmed evaluation. 

Call    
The function must be called cyclically, e.g., in OB 1. An additional call in an alarm OB is not 
allowed. At least two calls (cycles) are required for a complete execution of the function. 

The function reads out the diagnostic buffer when checkback signal DIAG = 1 in the channel 
DB indicates a new entry in the diagnostic buffer. After reading the diagnostic buffer, the 
DIAG bit is set to 0 in the channel DB of the module. 

Data block used   
Diagnostic DB: 

The module address must be entered in the diagnostic DB. The latest entry in the diagnostic 
buffer will be entered in the structure DIAG[1] and the oldest entry in the structure DIAG[9].  

Call parameters   
 
Name Data type P-type Meaning 
DB_NO INT IN Number of the diagnostic DB 
RET_VAL INT OUT Return value 

Return values   
The function provides the following return values: 

 
RET_VAL BR Description 
1 1 Job active 
0 1 No job is active, no error 
-1 0 Error  

Jobs   
You can read the diagnostic buffer independent of a new entry by setting the trigger bit 
DIAGRD_EN in the diagnostic DB. After the diagnostic buffer is read, the trigger bit is set to 
0. 

Carry out this job after a CPU start-up and a module start-up. This way you can ensure that 
the content of the diagnostic DB corresponds with the content of the module´s diagnostic 
buffer, even if the module has not made a new entry in the diagnostic buffer. 
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Start-up   
The function does not perform a start-up processing. 

Reaction to errors   
In the case of a faulty execution, the cause of the error can be found in the diagnostic DB in 
the JOB-ERR parameter (see chapter "Diagnostics (Page 147)" and chapter "Data and 
structure of the diagnostic DB (Page 196)"). 
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6.5 Data blocks 

6.5.1 Templates for data blocks 

Block templates UDT 
For each data block there is a block template UDT stored in the provided library (FMx51LIB). 
From these UDTs you can create data blocks with any numbers or names. 

6.5.2 Channel DB 

Task     
The channel DB (refer to the section entitled Content of channel DB (Page 189)) is the data 
interface between the user program and the positioning module. It contains and accepts all 
data required for control and operation of a channel.  

Structure    
The channel DB is divided into different areas: 

 
Channel DB 
Module address *) 
Channel number 
Number of the parameter DB 
Control signals 
Checkback signals 
Function switches 
Trigger bits for write jobs 
Trigger bits for read jobs 
Done bits 
Error bits 
Job management for functions 
Data for jobs 

*) You can also enter the address using the configuration software 
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6.5.3 Diagnostic DB 

Task     
The diagnostic DB (refer to the section entitled Data and structure of the diagnostic DB 
(Page 196)) is the data storage for the FC ABS_DIAG and includes the diagnostic buffer of 
the module that has been prepared by this function.  

Structure    
 
Diagnostic DB 
Module address 
Internal data 
Job status 
Trigger bit 
Processed diagnostic buffer 

6.5.4 Parameter DB 

Task     
If you want to change the machine data and increment tables during operation, you require a 
parameter DB (refer to the section entitled Contents of parameter DB (Page 194)) in which 
this data is stored. The parameters can be changed from the user program or from an 
operator control and monitoring system.  

You can export the data displayed in the configuration software into a parameter DB. You 
can also import a parameter DB into the configuration software and view it there. 

Each module channel can have several sets of parameter assignment data, e.g., for different 
recipes. You can switch among these in your program.  

Structure    
 
Parameter DB 
Machine data 
Increment tables 
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6.6 Technical specifications of the FCs and DBs for the FM 451 

Technical specifications     
The following table offers you an overview of the technical specifications for the functions 
and data blocks. 

Table 6- 1 Technical specifications of the functions and data blocks for the FM 451 

No. Block name Version Assignment in 
load memory 
(bytes) 

Assignment in 
work memory 
(bytes) 

Assignment in local 
data area 
(bytes) 

MC7 
code / 
data 
(bytes) 

System functions 
called 

FC 0 FC ABS_INIT 1.0 184 130 2 94  
FC 1 FC ABS_CTRL 1.0 4548 4176 34 4140 SFC 58: WR_REC, 

SFC 59: RD_REC 
FC 2 FC ABS_DIAG 1.0 1800 1658 42 1622 SFC 59: RD_REC 
 Channel DB - 638 184 - 148  
 Parameter DB - 840 556 - 520  
 Diagnostic DB - 524 388 - 352  

Module cycle  
The checkback signals of a channel are updated by the module every 8 ms. The actual value 
is updated every 3 ms. 
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6.7 Quicker access to module data 

Application    
In special applications or in an alarm level, a particularly fast access to checkback and 
control signals could be required. You can reach this data directly via the input and output 
areas of the module.  

For start-up coordination, after each start-up of the module (e.g. after connecting the module, 
after CPU STOP → RUN) you must call the FC ABS_CTRL until the end of the start-up is 
indicated by RET_VAL = 0. After this you must not use the FC ABS_CTRL any more. 

 

 Note 

It is not possible to use the FC ABS_CTRL together with a write access. 
 

Reading checkback signals by means of direct access      
The byte addresses must be specified relative to the start address of the outputs of the 
respective channel. The names of the parameters correspond with the names in the channel 
DB (see chapter "Content of the channel DB (Page 189)"). 

Start address channel 1 = start address of the module 

Start address channel 2 = start address of the module + 8 

Start address channel 3 = start address of the module + 16 

In STL, you access the data using the commands PEB (read 1 byte), PEW (read 2 bytes) 
and PED (read 4 bytes).  

 
Address Bit number 
 7 6 5 4 3 2 1 0 
Byte 0 PARA Internal Internal DATA_ERR OT_ERR DIAG Internal Internal 
Byte 1 CHGOVER CUTOFF ZSPEED SPEED_OUT 0 WAIT_EI WORKING ST_ENBLD 
Byte 2 MODE_OUT 
Byte 3 POS_RCD 0 FVAL_DO

NE 
0 GO_P GO_M MSR_DONE SYNC 

Byte 4 
Byte 5 
Byte 6 
Byte 7 

ACT_POS 
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Example: Actual position value ACT_POS    
The start address of the module is 512 

 
STL  

L PED 516 Read the current actual position value (ACT_POS) from channel 1 
with direct access: 

Start address of the channel + 4 

Write control signals using direct access      
The byte addresses must be specified relative to the start address of the inputs of the 
respective channel. The names of the parameters correspond with the names in the channel 
DB (see chapter "Content of the channel DB (Page 189)"). 

Start address channel 1 = start address of the module 

Start address channel 2 = start address of the module + 8 

Start address channel 3 = start address of the module + 16 

In STL, you access the data using the commands PAB (write 1 byte), PAW (write 2 bytes) 
and PAD (write 4 bytes).  

 
Address Bit number 
 7 6 5 4 3 2 1 0 
Byte 0 0 0 0 0 OT_ERR_A 0 0 0 
Byte 1 DRV_EN SPEED252 0 0 DIR_P DIR_M STOP START 
Byte 2 MODE_IN 
Byte 3 MODE_TYPE 
Byte 4 
Byte 5 
Byte 6 
Byte 7 

Reserved 

Example: START signals of channel 2    
The start address of the module is 512 

 
STL  

L 2#10001000 

T PAB 521 

Set DRV_EN and DIR_P to 1 

Write signals with direct access for channel 2: 

Start address of the module +8 + 1 
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6.8 Parameter transmission paths 
Parameters include the following machine data and increments. 

 
1 Saving parameters in the configuration software. 
2 Save and compile the HW configuration. 
2a Download the HW configuration to the CPU. The CPU automatically carries out step 3. 
3 The CPU writes the parameters when system parameter assignments are carried out for the 

module. 
4 With the command "download target system to PG" download the parameters of a channel of 

the module to the PG. 
5 With the command "download target system" download the parameters from the configuration 

software into a channel of the module. 
6 Write parameters using jobs of the user program in a channel of the module. 
7 Read parameters using jobs of the user program from a channel of the module. 
8 Store parameters from the user program into the online DB. 
9 Read in parameters from the online DB into the user program. 
10 Export parameters from the configuration software to the offline DB. 
10a Download the offline DB to the CPU. 
10b Export parameters from the configuration software to the online DB. 
11 Import parameters from the offline DB into the configuration software. 
11a Load parameters from the online DB to the PG. 
11b Import parameters from the online DB into the configuration software. 

Figure 6-3 Parameter transmission paths 
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Some applications for transmission of parameters:  
● You process the parameters using the configuration software. The channels of the 

module should then be automatically assigned upon start-up. 

Carry out steps 1, 2, and 2a. 

● You change the parameters during commissioning in debug mode in the configuration 
software: 

Carry out steps 4 and 5. 

● The parameters changed during commissioning should then be automatically loaded 
upon start-up: 

Carry out steps 1, 2, and 2a. 

● You create the parameters using the configuration software. The channels of the module 
should be assigned upon start-up only by the user program via the data blocks: 

Carry out steps 10, 10a and 6 or 10b and 6. 

● You would like to create convenient stored data for recipes: 

Carry out steps 10 and 10a. 

● You create the parameters using the configuration software. These should be made 
available to the user program for temporary changes. 

Carry out steps 1, 2 and 2a for the automatic parameter assignment. 

Carry out the steps 10, 10a, 9, 8 and 6 for access by the user program. 

● You change existing parameters solely via the user program: 

Carry out steps 7, 9, 8 and 6. 

● You would like to use the configuration software to view the data that has been changed 
via the user program: 

Carry out steps 11a and 11 or just 11b. 

● The parameters changed by the user program should also be automatically loaded upon 
start-up: 

Carry out steps 11b or 11a, 11 and then 1, 2, 2a. 
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Commissioning the FM 451 7
Important Note   

Please observe the points listed in the following warnings. 
 

WARNING  
Risk of injury and material damage. 

In order to prevent injury and material damage: 
 Install an EMERGENCY STOP switch in the area of the computer. 

This is the only way to ensure that the system can be switched off safely in the event of 
a computer or software failure. 

 Install hardware limit switches that act directly on the power units of all drives. 
 Always make sure to prevent access to the plant areas containing moving parts. 
 Concurrent controlling and monitoring of the FM 451 from your user program and on the 

"Test > Commissioning" screen form can lead to conflicts with unforeseeable effects. 
Hence, always set the CPU to STOP when working in the Test screen form, or disable 
the user program. 

 

Setting up a project    
Create a project in STEP 7. 

The section below describes the steps when using SIMATIC Manager (without assistance 
from the wizard). 

 
Step Action ✓ 
1 If not already done, install the configuration package. ❒ 
2 Create a new project in SIMATIC Manager (File > New). ❒ 
3 Add a station to your project (Insert > Station). ❒ 
4 Select the station, then run the "HW Config" configuration interface by double-clicking "Hardware". ❒ 
5 Insert a rack in your hardware configuration with the following: 

 Power supply module (PS) 
 CPU 
 Function module (FM 451) 

❒ 

6 Save this hardware configuration in HW Config (Station > Save). ❒ 
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Hardware installation and wiring    
In this first section you install the FM 451 in your S7-400 and wire up the external peripheral 
elements. 

 
Step Action ✓ 
1 Installing the FM 451 (see chapter "Installing and removing the FM 451 (Page 19)") 

Insert the module in one of the slots available. 
  

❒ 
2 Wiring the FM 451 (see chapter "Wiring the FM 451 (Page 21)") 

 Wire the front connector of the FM 451: 
– Auxiliary voltage for the encoder supply 
– Auxiliary voltage for the load current supply 
– Digital inputs 
– Digital outputs 

 Encoder connection 

 
 

❒ 
❒ 
❒ 
❒ 
❒ 

3 Check the safety-relevant switches    
Check the function of the following: 
 EMERGENCY STOP switches 
 Hardware limit switches 

  
  

❒ 
❒ 

4 Front connector 
The front connector must be engaged. 

  
❒ 

5 Check the shielding of the individual cables. ❒ 
6 Switch on the power supply 

Switch the CPU to STOP (safe state). 
If necessary, switch on the 24 V supply for the auxiliary voltages. 

  
❒ 
❒ 

Getting prepared for programming    
Create the necessary blocks in your project if you would like to access the module with the 
user program. 

 
Step Action ✓ 
1 Select the FMX51LIB library in SIMATIC Manager (File > Open > Libraries). ❒ 
2 Copy the FC 0 and FC 1 functions, and the channel DB template UDT 1 from the library to the blocks 

folder. 
❒ 

3 Create a channel DB from the UDT 1 template for each channel and enter the channel number. ❒ 
4 If you want to use a programmed diagnostic evaluation, copy FC 2 and UDT 2 and create a diagnostic 

DB for each module. 
❒ 

5 If you want to write or read machine data and increment tables in the user program, you need UDT 3 in 
order to create a parameter DB for each channel. 

❒ 
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Assigning parameters using the configuration software    
For initial commissioning of the module, assign parameters for the module using the 
parameter assignment dialogs of the configuration software. 

 
Step Action ✓ 
1 Select the tier in the rack containing the FM 451 module. ❒ 
2 Next, double-click to open the parameter assignment dialogs for the FM 451. ❒ 
3 Select File > Properties to edit the following settings: 

 General 

You can edit the name and enter a comment. 
 Addresses 

If you change the start address, you must also change the end address. Note the module address 
displayed. 

Note the module address displayed. 
 Basic parameters 

You can set the interrupt class and the reaction to a CPU STOP. 

❒ 

4 You assign the relevant parameters in the Drive, Axis, Encoder, and Increments dialog screens. ❒ 
5 You can create your channels in Edit > Create channel. ❒ 
6 Save the parameter assignment with File > Save. ❒ 
7 Close the parameter assignment dialogs with File > Exit. ❒ 
8 Save the hardware configuration in HW Config with Station > Save and Compile. ❒ 
9 Go online and download the hardware configuration to the CPU. This will transfer the parameter 

assignment data to the FM 451. 
❒ 

Testing and commissioning   
You can now test your entries and changes with the parameter assignment dialogs of the 
configuration software. 

 
Step Action ✓ 
1 To test your commissioning data, select the Test > Commission, Test > Error Evaluation, and Test > 

Service screen forms. 
❒ 

2 You can change any incorrect machine data in the Test > Commission screen. These modifications 
remain valid until the next STOP-RUN transition on the CPU. 

❒ 

3 You can save the corrected machine data in the CPU by repeating steps 6 to 9 of the previous 
sequence. 

❒ 

 
 

 Note 

If you set the drive enable in the commissioning screen form when the CPU is in STOP 
mode and then close all the parameter assignment dialogs, the drive enable is canceled. 
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Test steps for operating modes, jobs, and function switches     
The tests described in the next section help you to validate the FM 451 parameter 
assignment. 

 
Step Action ✓ 

Synchronize the axis  

 Incremental encoder 
– Select "Set reference point". To do this enter 

the required value (see chapter "Configuring 
set reference point (Page 127)"). 

or  
– Select the "Reference point approach" mode 

(see chapter "Configuring reference point 
approach mode (Page 105)"). 

 Absolute encoder 
– The FM 451 is always synchronized 

immediately following parameter 
assignment. 

– Adjust the absolute encoder (see chapter 
"Determining the absolute encoder 
adjustment (Page 83)"). 

❒ 
1 

Check the actual status of the axis. The physical position must match the value output on the display. ❒ 
Select Jog mode. ❒ 
Check the interconnection of the outputs (control mode) and the actual value. Approach in creep speed 
in the plus and minus directions. Approach in rapid traverse in the plus and minus directions. 

❒ 
2 

 Check the encoder resolution (see chapter "Resolution (Page 86)") 
– Move the drive a defined distance in a defined direction. 

The actual traversing distance must agree with the value indicated in the Debug > Commission 
screen. 

❒ 

3 Select incremental approach mode 
 Absolute with increment number 255  

– Check the process with the defined increment 
– And adapt the changeover difference and switch-off difference based on increment 255 to the 

circumstances of your system. 

  
  

❒ 
❒ 

4 Test the other function switches and jobs according to your application 
 e.g., loop approach, set actual value 

❒ 

Preparing the channel DB    
 
Step Action ✓ 
1 Open the channel DB. ❒ 
2 Check the following entries: 

 The module address in the MOD_ADDR parameter (refer to the section entitled Basics of 
programming a positioning module (Page 37)) 

 The channel number in the CH_NO parameter 
 If applicable, the number of the parameter DB in the PARADBNO parameter 

  
❒ 
 

❒ 
❒ 

3 Save the channel DB (File > Save). ❒ 



 Commissioning the FM 451 
  

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 61 

Preparing the diagnostic DB    
 
Step Action ✓ 
1 Open the diagnostic DB. ❒ 
2 Make sure that the module address is entered in the MOD_ADDR parameter (refer to the section 

entitled Basics of programming a positioning module (Page 37)). 
❒ 

3 Save the diagnostic DB with File > Save. ❒ 

Integrating the functions 
 
Step Action ✓ 
1 Integrate the required functions in your user program. ❒ 

Downloading blocks to the CPU    
 
Step Action ✓ 
1 Select the blocks in SIMATIC Manager, then download these with PLC > Download to CPU. ❒ 

See also 
Important safety information (Page 21) 
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Machine data and increment dimensions 8
8.1 Writing and reading machine data and increment tables 

Changing and reading out parameters during operation    
This chapter describes how you can use the user program to change and read out 
parameters during operation. 

All parameters are stored in the parameter DB: 

● Machine data is located in the parameter DB at the addresses 4.0 to 116.0. 

● Increment tables are located in the parameter DB at the addresses 120.0 to 516.0. 

The number of the parameter DB must be entered in the respective associated channel DB. 

You can enter the parameters with the DB Editor or also easily using the dialog screens 
"Drive", "Axis", "Encoder" and "Increments" and then write in the parameter DB with the 
"Export" function. 

You can use the function "Import" to import parameters that are in an already available 
parameter DB into the dialog screens. 

Writing, enabling and reading machine data      
You can use the machine data to adapt the positioning module to the axis and the encoder. 

First parameter assignment    

If the channel still contains no machine data, proceed as with a first parameter assignment 
without the parameter assignment screens in the following way: 

1. Enter the new values in the parameter DB and then save these. 

2. Download the parameter DB to the CPU. 

3. Set the following trigger bit in the channel DB for the job: 

– Write machine data (MDWR_EN). 

4. Call the FC ABS_CTRL in the cyclic user program. 

Modifying machine data    

Proceed as follows to change machine data using the user program: 

1. Enter the new values in the parameter DB. 

2. Set the trigger bits in the channel DB for the jobs: 

– Write machine data (MDWR_EN) 

– Enable machine data (MD_EN) 

3. Call the FC ABS_CTRL in the cyclic user program. 
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If you set the trigger bits for these jobs all at once, the FC ABS_CTRL makes sure the jobs 
are processed in the correct order. 

Otherwise change the machine data always in the following sequence: 

● Write machine data 

● Enable machine data 

Reading machine data    

In order to read the current machine data from a channel, proceed as follows: 

1. Set the following trigger bit in the channel DB: 

– Reading machine data (MDRD_EN) 

2. Call the FC ABS_CTRL in the cyclic user program. 

The current machine data is then stored in the parameter DB on the CPU. 

Excerpt from the channel DB 
 
Address Name Type Initial value Comment 
35.0 MDWR_EN BOOL FALSE 1 = write machine data  
35.1 MD_EN BOOL FALSE 1 = enable machine data  
36.5 MDRD_EN BOOL FALSE 1 = reading machine data  

Writing and reading increment tables      
First parameter assignment    

If the channel still contains no increment tables, proceed as with a first parameter 
assignment without the configuration software in the following way: 

1. Enter the new values in the parameter DB and then save these. 

2. Download the parameter DB to the CPU. 

3. Set the trigger bits in the channel DB for the jobs: 

– Write increment table 1 (TRGL1WR_EN) and / or increment table 2 (TRGL2WR_EN) 

4. Call the FC ABS_CTRL in the cyclic user program. 

Changing increment tables    

Proceed as follows to change increment tables using the user program: 

1. Enter the new values in the parameter DB. 

2. Set the trigger bits in the channel DB for the jobs: 

– Write increment table 1 (TRGL1WR_EN) and / or increment table 2 (TRGL2WR_EN) 

3. Call the FC ABS_CTRL in the cyclic user program. 
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Reading increment tables    

In order to read the increment tables from a channel, proceed as follows: 

1. Set the trigger bits in the channel DB for the jobs: 

– Read increment table 1 (TRGL1RD_EN) and / or increment table 2 (TRGL2RD_EN) 

2. Call the FC ABS_CTRL in the cyclic user program. 

The increment tables are then stored in the parameter DB on the CPU. 

Excerpt from the channel DB 
 
Address Name Type Initial value Comment 
35.4 TRGL1WR_EN BOOL FALSE 1 = write increment table 1 (1 ... 50)  
35.5 TRGL2WR_EN BOOL FALSE 1 = write increment table 2 (51 ... 100)  
36.6 TRGL1RD_EN BOOL FALSE 1 = read increment table 1 (1 ... 50)  
36.7 TRGL2RD_EN BOOL FALSE 1 = read increment table 2 (51 ... 100)  

 

 

 Note 

If synchronization-relevant parameters have been changed, when the machine data is 
enabled the module will carry out the following actions for the respective channel: 
 the synchronization is deleted 
 the function switches and zero offset are reset 
 all the machine data and increment tables so far will become invalid 

Synchronization-relevant parameters are: 
 Axis type 
 End of rotary axis 
 Encoder type 
 Distance per encoder revolution 
 Increments per encoder revolution 
 Number of revolutions 
 Reference point coordinate 
 Absolute encoder adjustment 
 Type of reference point approach 
 Counting direction 
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8.2 System of units 

Choosing a system of units    
In the configuration software of the positioning module, for the input and output of the data 
you can select from the following systems of units: 

● mm (default) 

● inch 

● degrees 

  Note 

If you change the system of units in the parameter assignment screens under STEP 7, 
the values are converted into the new system. This may lead to rounding errors. 

If you change the system of units programmed via the jobs "Write machine data" and 
"Enable machine data", the values will not be automatically converted. 

System of units in the parameter DB 
 
Address Name Type Initial value Comment 
8.0 UNITS DINT L#1 System of units 

1 = 10-3 mm  
2 = 10-4 inch 
3 = 10-4 degrees 
4 = 10-2 degrees 
6 = 10-3 degrees 

Standard system of units    
In this manual we will always use the mm system of units to specify the Limits. To determine 
the limits in the other systems of units, carry out the following conversion: 

 
To convert from you calculate 
mm → inch Limit (inch) = limit (mm) × 0.1 1) 

10-4 (4 decimal places) 
10-3 (3 decimal places) 

mm → 
degrees 

10-2 (2 decimal places) 

Limit (degrees) = limit (mm) × 0.1 
Limit (degrees) = limit (mm) × 1 
Limit (degrees) = limit (mm) × 10 

1) The number of decimal places affects the number of pre-decimal places for the maximum value. 
Four decimal places are used in the "inch" system of units, which means the maximum entry your 
can make is 100,000.0000 inch. The "millimeter" system of units uses three decimal places, which 
means the maximum entry you can make is 1,000,000.000 mm. 
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Connection between increments and system of units 
The encoder signals of a connected encoder will be evaluated by the positioning module and 
converted into the current system of units. The resolution is used for the conversion (refer to 
the section entitled "Resolution (Page 86)"). 

If the positioning module 

● has counted 10 increments and 

● a resolution of 100 µm per increment is assigned in the encoder data, 

this means that the axis will be moved by a distance of 1 mm. 
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8.3 Machine data of the drive 

Drive data     
 

Address Name Type Initial value Comment 
92.0 CTRL_TYPE DINT L#1 Control mode:  

The control mode describes how the 4 digital outputs 
per channel operate a connected motor by means of 
the power control. 
x stands for channels 1, 2, and 3 

Control mode 1 

 
  
Control mode 2 

 
  



 Machine data and increment dimensions 
 8.3 Machine data of the drive 

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 69 

Address Name Type Initial value Comment 
Control mode 3 

 
  
Control mode 4 
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Table 8- 1 Table with states of 4 outputs for each control mode, x stands for channels 1, 2, and 3 

Rapid speed Creep speed  

Direction + Direction - Direction + Direction - 

PEH position 
reached stop 

Control mode 1  
xQ0 1 1 0 0 - 
xQ1 0 0 1 1 - 
xQ2 1 0 1 0 - 
xQ3 0 1 0 1 - 
Control mode 2  
xQ0 1 1 0 0 0 
xQ1 0 0 0 0 1 
xQ2 1 0 1 0 0 
xQ3 0 1 0 1 0 
Control mode 3  
xQ0 1 1 0 0 - 
xQ1 1 1 1 1 - 
xQ2 1 0 1 0 - 
xQ3 0 1 0 1 - 
Control mode 4  
xQ0 1 0 0 0 - 
xQ1 1 0 1 0 - 
xQ2 0 1 0 0 - 
xQ3 0 1 0 1 - 
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Address Name Type Initial value Comment 

100.0 
104.0 
108.0 
112.0 

CHGDIF_P 
CHGDIF_M 
CUTDIF_P 
CUTDIF_M 

DINT 
DINT 
DINT 
DINT 

L#5000 
L#5000 
L#2000 
L#2000 

Changeover difference plus    
Changeover difference minus 
Switch-off difference plus 
Switch-off difference minus 
Range: 
 1 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 1 µm to 100 000 000 µm at resolution 

of <1 µm/pulse 

"Changeover difference" defines the changeover point from which the drive changes from rapid traverse to creep speed. 
"Switch-off difference" defines the switch-off point starting from which the drive (creep speed) is switched off. Starting from 
this point, the FM 451 assumes monitoring functions. 
The values apply to all targets that the FM 451 approaches, with the exception of the increment dimension 255. 
 
Rules 
 The values for the plus and minus directions can be different. 
 The changeover difference must be greater than the switch-off difference. 
 The changeover difference must lie within the operating range. 
 The changeover difference must be less than the rotary axis end. 
 The switch-off difference must be greater than half the target range. 
 Select a sufficient distance between the changeover point and the switch-off point to ensure that the drive's speed can 

be safely reduced from rapid traverse to creep speed. 
 Select the distance between the switch-off point and the target to ensure the drive comes to a standstill within the 

target range. 
 The changeover point, the switch-off point, and the start of the target range must be separated from each other by at 

least 8 ms. 
Further information on the layout of the ranges can be found in chapter "Ranges and switching points of the positioning 
module (Page 16)". 

 

① Operating range 

②③ Changeover difference plus / minus 

④⑤ Switch-off difference plus / minus 
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Address Name Type Initial value Comment 

⑥ Standstill range 

⑦ Target range 

⑧ Changeover point 

⑨ Switch-off point 

 

 
Address Name Type Initial value Comment 

76.0 TRG_RANGE DINT L#1000 Target range   
 0 = No monitoring 
Range: 
 1 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 1 µm to 100 000 000 µm at resolution 

of <1 µm/pulse 

The target range lies symmetrically around the target. 
A value specification of 0 switches off the monitoring of the target range. 
For information about target approach, refer to chapter "End of a positioning (Page 93)". 

 

 
Address Name Type Initial value Comment 

84.0 ZSPEED_R DINT L#1000 Standstill range   
 0 = No monitoring 
Range: 
 1 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 1 µm to 100 000 000 µm at resolution 

of <1 µm/pulse 

The standstill range lies symmetrically around the target. Monitoring is performed to determine whether the drive remains 
on an approached target position or drifts away from it. 
If the standstill range is exited without a valid traversing job, the FM 451 signals an error. 
A setting of 0 deactivates the standstill monitoring function. 
Recommendation: The standstill range should be greater than the target range. 
Also note chapter "End of a positioning (Page 93)", which presents the target approach and the individual monitoring 
functions and messages. 
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Address Name Type Initial value Comment 

88.0 ZSPEED_L DINT L#30000 Standstill velocity   
 0 = No monitoring 
 1 µm/min to 100 000 µm/min 

The standstill velocity is used as the reference velocity for the end of positioning. (Refer also to chapter End of a 
positioning (Page 93)).   
A setting of 0 deactivates the standstill velocity monitoring function. 

 

 
Address Name Type Initial value Comment 

80.0 MON_TIME DINT L#2000 Monitoring time   
 0 = No monitoring 
 1 to 100 000 ms 

The module uses the monitoring time to monitor 
 The movement of the axis up to the switch-off point. 

The monitoring time starts when the positioning starts and is retriggered on each actual value change in the traversing 
direction. 

 The target approach. 

The positioning must end within the monitoring time. 

The monitoring time is retriggered when the switch-off difference is reached for the last time. 
 The plausibility of the actual values at the switching points. 

An oscillation of the axis at the switching points results in operating errors. 
A value specification of 0 switches off the monitoring functions. 
Actual monitoring time   
You can specify all values from the defined range for the monitoring time. 
 0: Monitoring is switched off. 
 1 to 100 000 ms: The FM 451 rounds the specified time to a multiple of 8 ms (module cycle). Ideally, you should 

therefore specify the monitoring time in 8 ms increments. 
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Address Name Type Initial value Comment 
99.1 EI_TYPE BOOL FALSE Evaluate enable input 

0 = Level-controlled 
1 = edge controlled 

The enable input is an external input that can be used to execute positioning due to an external event. 
 Level-controlled (EI_TYPE=0)  

Traversing begins when you create a "1" signal at the enable input and is ended when you create a "0" signal at the 
enable input. 

 Edge-controlled (EI_TYPE=1)  

Traversing begins with detection of a rising edge at the enable input. The additional signal characteristic at this input 
does not affect the course of the motion that was started. 
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8.4 Machine data of the axis 

Axis data     
 

Address Name Type Initial value Comment 
12.0 AXIS_TYPE DINT L#0 Axis type: 

0 = Linear axis 
1 = Rotary axis 

A linear axis has a limited physical traversing range.  
 

 
A rotary axis is not restricted in its motion range by mechanical limit stops. 
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Address Name Type Initial value Comment 

16.0 ENDROTAX DINT L#100000 End of rotary axis: 
Range: 
 1 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 1 µm to 100 000 000 µm at resolution 

<1 µm/pulse 

The "end of rotary axis" value is the theoretical maximum actual value of the axis. However, the theoretical maximum value 
is never indicated, because it also represents the physical start position of the rotary axis (= zero). 
The maximum value displayed for a rotary axis value is:  
End of rotary axis [µm] - resolution [µm / pulse] * 1 [pulse]  
Example: End of rotary axis 1000 mm, resolution 1000 µm / pulse 
The displayed value jumps: 
 from 999 mm to 0 mm, at a positive rotational direction 
 from 0 mm to 999 mm, at a negative rotational direction 
Rotary axis with absolute encoders 
The rotary range (0 to end of rotary axis) of a rotary axis with an absolute encoder must correspond exactly to the encoder 
range of the absolute encoder. 

 

 

 
Address Name Type Initial value Comment 

44.0 REFPT DINT L#0 Reference point coordinate:   
Range: 
 -1 000 000 000 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 -100 000 000 µm to 100 000 000 µm at resolution 

<1 µm/pulse 

Incremental encoder: 
You require the reference point coordinate for the "Reference point approach" mode. If the axis is not synchronized 
following writing and activating of machine data, the actual value is set to the value of the reference point coordinate. 
Absolute encoder (SSI) 
You require the reference point coordinate for the mechanical adjustment of the encoder. 
For more information, refer to the description of absolute encoder adjustment in the chapter "Determining the absolute 
encoder adjustment (Page 83)", which explains the interaction of the absolute encoder adjustment with other data. 
The value of the reference point coordinate must lie within the operating range: 
 Linear axis 

Including the software limit switch 
 Rotary axis 

Greater than or equal to 0 and less than the "end of rotary axis" value (0 ≤ reference point coordinate < "End of rotary 
axis"). 
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Address Name Type Initial value Comment 

52.0 REFPT_TYPE DINT L#0 Type of reference point approach:   
Ranges: 
0 = Plus, reference point switch in plus direction 
1 = Plus, reference point switch in minus direction 
2 = Minus, reference point switch in plus direction 
3 = Minus, reference point switch in minus direction 

With Type of reference point approach, you determine the conditions for the axis synchronization. 
 First you specify the start direction of the reference point approach. 
 Then, you define the position of the zero mark that results in synchronization relative to the reference point switch. 
The use of this data is described in chapter "Configuring reference point approach mode (Page 105)". 

 

 
Address Name Type Initial value Comment 

99.0 REFPT_SPD BOOL TRUE Start velocity for reference point approach 
0 = Rapid traverse 
1 = Creep speed 

You use this data to select the velocity for the start of a reference point approach. 

 

 
Address Name Type Initial value Comment 

64.0 
68.0 

SSW_STRT 
SSW_END 

DINT 
DINT 

L#-100000000 
L#100000000 

Software limit switch start   
Software limit switch end   
Range: 
 -1 000 000 000 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 -100 000 000 µm to 100 000 000 µm at 

resolution <1 µm/pulse 

These axis data are only used for a linear axis. 
The software limit switches are monitored if the axis is synchronized. The range limited by the software limit switches is the 
operating range. 
The software limit switch start (SLS) must always be less than the software limit switch end (SLE). 
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Address Name Type Initial value Comment 

 
Incremental encoder 
The axis is initially not synchronized after each restart of the FM 451. The assigned software limit switches are not 
monitored until the axis is synchronized. 
Absolute encoder (SSI) 
The axis is synchronized once the FM 451 has received a complete, error-free message frame for the associated channel. 
The software limit switches are monitored starting from this time. 
The absolute encoder must cover at least the operating range including the software limit switches. 
Relationship: operating range, encoder range, traversing range     
 The "operating range" is defined by your task-specific software limit switch settings. 
 The "encoder range" represents the range explicitly covered by the encoder. For a linear axis, the module applies this 

range symmetrically across the operating range, i.e., it shifts the encoder range in order to equalize the distances 
between the software limit switches and the ends of the encoder range (see figure). 

 The "traversing range" represents the range of values that the FM 451 is capable of processing. The "traversing range" 
is dependent on the resolution. 

 

 
Address Name Type Initial value Comment 

4.0 EDGEDIST   DINT L#0 Minimum edge distance    
Range: 
 0 to 1 000 000 000 µm at resolution ≥1 µm/pulse 
 0 to 100 000 000 µm at resolution <1 µm/pulse 

This machine data defines a range after detection of the start of a measurement for an edge detection. The measurement 
will be discarded if the measuring operation ends within this range. 
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8.5 Machine data of the encoder 

Definition    
The encoder returns position data (see chapter "Encoder (Page 141)") to the module, where 
they are evaluated and converted into an actual value based on the set resolution. 

The correct definition of the encoder's machine data is essential for ensuring consistency 
between the calculated and physical actual position of the axis. 

Data in the parameter DB    
 

Address Name Type Initial value Comment 
20.0 ENC_TYPE   DINT L#1 Encoder type and message frame length:      

Range of values: 
1 = 5 V incremental 
2 = 24 V incremental 
3 = SSI 13-bit message frame length 
4 = SSI 25-bit message frame length 

With the "message frame length" you define the clock frame output by the positioning module. 
 

 
Address Name Type Initial value Comment 

24.0 DISP_REV   DINT L#80000 Distance per encoder revolution:    
Range of values: 
1 µm to 1 000 000 000 µm 

With the "Distance per encoder revolution" machine data, you inform the positioning module about the distance covered by 
the drive system per encoder revolution. 
The "Distance per encoder revolution" value depends on the axis configuration and the way in which the encoder is 
mounted. You must take all transmission elements, such as couplings or gears, into account. 
Chapter "Resolution (Page 86)" describes the relationship between the "Distance per encoder revolution" machine data 
and "Increments per encoder revolution". 
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Address Name Type Initial value Comment 

32.0 INC_REV   DINT L#500 Increments per encoder revolution:    
Range of values: 
1 to 225 

The machine data "increments per encoder revolution" defines the number of increments output by an encoder per 
revolution. The positioning module calculates the resolution based on this value and the "Distance per encoder revolution" 
machine data. 
Incremental encoder    
Any value within the range of values can be input. The module evaluates the increments in 4 operations (see chapter 
"Incremental encoder (Page 141)"). 
Absolute encoder   
The individual encoder models must be differentiated for the limits. Only values in powers of 2 are allowed for the input 
(see chapter "Absolute encoders (Page 144)"). 
 Single-turn encoder with (number of revolutions = 1) 13-bit message frame length: 

– Minimum value = 4 
– Maximum value = 8192 

 Multiturn encoder (number of revolutions > 1) with 25-bit message frame length: 
– Minimum value = 4 
– Maximum value = 8192 

 Single-turn encoder with 25-bit message frame length and number of revolutions = 1: 
– Minimum value = 4 
– Maximum value = 225 

Linear scales are assigned as multiturn encoders as follows: 
 Increments per encoder revolution = 8192 
 Number of revolutions x 8192 ≥ number of increments of the linear scale 

 

 
Address Name Type Initial value Comment 
36.0 NO_REV   DINT L#1 Number of encoder revolutions:   

Range of values: 
1 (single-turn encoder) 
2 to  4096 in powers of 2 (multiturn encoder) 

The machine data "number of encoder revolutions" is only used for absolute encoders. You use it to define the maximum 
possible number of revolutions for this encoder.  
The overall number of steps of the encoder is not machine data. It is calculated as follows:   
Total number of steps = increments per encoder revolution  x  number of revolutions 
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Address Name Type Initial value Comment 

40.0 BAUDRATE   DINT L#0 Baud rate:   
Range of values: 
0 = 125 kHz 
1 = 250 kHz 
2 = 500 kHz 
3 = 1000 kHz 

With the "baud rate" machine data, you define the data transmission rate between the SSI encoder and the positioning 
module. 
This entry is irrelevant for incremental encoders. 
The maximum baud rate depends on the cable length:    
 320 m → 125 kHz 
 160 m → 250 kHz 
 63 m → 500 kHz 
 20 m → 1000 kHz 

 

 
Address Name Type Initial value Comment 

59.0 CNT_DIR   BOOL FALSE Count direction:     
0 = Normal 
1 = Inverted 

With the "count direction" machine data, you adapt the position feedback direction to the direction of the axis movement. 
Also, take the rotation directions of all transmission elements into account (for example, couplings and gears). 
 Normal = incremental count pulses (incremental encoder) or encoder values (absolute encoder) represent increasing 

actual position values 
 Inverted = incremental count pulses (incremental encoder) or encoder values (absolute encoder) represent decreasing 

actual position values 
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Address Name Type Initial value Comment 

  
63.0 
63.1 
63.2 

  
MON_WIRE   
MON_FRAME   
MON_PULSE   

  
BOOL 
BOOL 
BOOL 

  
TRUE 
TRUE 
TRUE 

Monitoring functions:     
1 = Wire break 
1 = Message frame error (must always be 1) 
1 = Missing pulses 

Wire break   
When monitoring is activated, the positioning module monitors all cables for a 5 V incremental encoder and an absolute 
encoder. The monitoring detects: 
 Wire break 
 Short circuit on individual cables 
 Edge interval of counting pulses (also for 24 V incremental encoder) 
For monitoring for a 24 V incremental encoder, you must set a monitoring time MON_TIME > 0. 
For 5 V incremental encoders without zero marks, you must disable the wire break monitoring or interconnect the N and /N 
signals externally (see chapter "Incremental encoder (Page 141)"). 
Message frame error   
The module monitors the message frame of an absolute encoder (SSI): 
 Start and stop bit errors 
Message frame error monitoring cannot be disabled for absolute encoders (SSI). 
Missing pulses (incremental encoder)    
An incremental encoder must always return the same number of increments between two successive zero marks. The 
positioning module checks whether the zero mark of an incremental encoder coincides with the correct encoder value. 
You must disable missing pulse monitoring for encoders without zero marks. 
You must also disable wire-break monitoring or interconnect the zero mark inputs N and /N externally. 
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8.6 Determining the absolute encoder adjustment 

Definition  
The absolute encoder adjustment and the reference point coordinate is used to explicitly 
map the encoder's value range to the coordinate system of the axis. 

Determining the correct absolute encoder adjustment   
After the first configuration further steps must be taken to ensure that a correct relationship is 
created between the encoder and coordinate system. The order of events is shown using the 
parameter assignment screens.  

1. Traverse the axis to a defined, reproducible point to which a unique coordinate is 
assigned. 

This could, for example, be the "software limit switch end". 

2. Call the job "Set reference point" with the coordinate of the point defined under 1. 

The positioning module now determines an encoder value for the reference point 
coordinate entered in the channel DB (REFPT in channel DB), namely the absolute 
encoder adjustment. You can read out this value in the service screen of the parameter 
assignment interface. 

3. Enter the value read out from the service screen in the "Absolute encoder adjustment" 
field on the "Axis" tab of the parameter assignment interface. 

4. Save your parameter assignment to the corresponding parameter DB using the export 
function. 

5. Close the parameter assignment interface by selecting Save and Exit. 

6. Download the data in HW Config to the CPU. 

7. Restart the CPU (cold restart) to apply the data. 

  Note 

You perform this adjustment just once during the commissioning. After a configuration, 
the position module is synchronized during start-up as soon as a complete, faultless 
message frame of the encoder is received after start-up. 
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Data in the parameter DB 
 
Address Name Type Initial value Comment 
44.0 REFPT DINT L#0 Reference point coordinate 

Range: 
 -1 000 000 000 µm to 1 000 000 000 µm at 

resolution ≥1 µm/pulse 
 -100 000 000 µm to 100 000 000 µm at 

resolution < 1 µm/pulse 

48.0 ENC_ADJ DINT L#0 Absolute encoder adjustment: 
Range: 0 to (225-1)  

Example of an absolute encoder adjustment   
The following assumptions apply to the example: 

● Reference point coordinate = -125 mm 

● Operating range from SSW_STRT = -1000 mm to SSW_END = 1000 mm 

● Absolute encoder adjustment = 0 

● Encoder range = 2048 increments with a resolution of 1 mm/pulse 

● The absolute encoder used cannot be adjusted mechanically with precision and it also is 
not possible to set the encoder value specifically. 

 
Example of an absolute encoder adjustment 
 

 
  
1) Assignment of the coordinate system to the encoder values with the specified absolute encoder 
adjustment. The encoder value 0 corresponds to the actual value -125. 
2) Desired classification of the coordinate system to the encoder. At this position the coordinate 
should be -125. 
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Result in accordance with "Set reference point" 
After "Set reference point" the relationship looks as follows: 

The reference point coordinate on the axis (-125) is assigned to the encoder value (1798) 
determined from the absolute encoder adjustment. 

 
The encoder supplies 2048 unique values. The operating range is established by the 
software limit switches. Because of the selected resolution of 1 mm per pulse, the encoder 
however can cover a greater operating range than the one provided by the software limit 
switches. 

With the set resolution, the operating range is already covered with 2001 values. Therefore, 
in the example, 47 pulses "remain" and these are symmetrically positioned around the 
operating range. 

Otherwise: Mechanical adjustment of the encoder    
A correct relationship between the coordinate system and the encoder can be achieved as 
follows: 

1. Traverse the axis to a reproducible position (e.g., the software limit switch start). 

2. Enter this coordinate value in the machine data as the reference point coordinate. 

3. Read the encoder value shown at this position from the service screen of the 
configuration software. 

4. Enter this value in the machine data as the absolute encoder adjustment. 

After the parameter assignment a correct actual value will always be shown. 

Instead of steps 3 and 4, you can also set the encoder to zero via "Reset", if available, and 
enter the value "0" in the machine data as the absolute encoder adjustment. 
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8.7 Resolution 

Definition 
The resolution indicates the traversing distance corresponding to one pulse. It is a 
measurement for the precision of the positioning and also determines the possible maximum 
traversing range of the positioning module. 

The resolution (RES) can be calculated as in the following table:  

 
 Incremental encoder Absolute encoder 
Input values  Distance per encoder revolution 

 Increments per encoder revolution: 
– Pulse evaluation: 4x 
– 1 increment = 4 pulses 

 Distance per encoder revolution 
 Increments per encoder revolution: 

– 1 increment = 1 pulse 

Calculation 

 
 

 

 Note 

All position information is rounded up to the integral multiple of the resolution. This way the 
entered values differentiate from the used values. 

 

Range of values of the resolution 
The chosen system of units determines the range of values of the resolution: 

 
System of 
units 

Information in ... Range of values of the resolution 

mm 10-3 mm 0,1∙10-3 .... 1000*10-3 mm/pulse 
inch 10-4 inch 0,1∙10-4 .... 1000*10-4 inch/pulse 
degrees 10-4 degrees 

10-3 degrees 
10-2 degrees 

0,1∙10-4 .... 1000*10-4 degrees/pulse 
0,1∙10-3 .... 1000*10-3 degrees/pulse 
0,1∙10-2 .... 1000*10-2 degrees/pulse 
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Example 
● An incremental encoder has the following data: 

– Increments per encoder revolution: 5000 

– Distance per encoder revolution: 1000 mm 

– 1 increment = 4 pulses 

This results in the resolution (4 x evaluation): 

 
● An SSI encoder has the following data: 

– Increments per encoder revolution: 4096 

– Distance per encoder revolution: 1000 mm 

– 1 increment = 1 pulse 

This results in the resolution: 

 

Relationship between the traversing range and resolution 
The traversing range is restricted by the numerical representation in the position module. 
This numerical representation varies depending on the resolution. You should thus make 
sure that your specifications are always within the permitted limits. 

The maximum traversing range is illustrated in the following table: 

 
Resolution (RES) lies in the range Maximum traversing range 
0,1 µm/pulse ≤ RES < 1 µm/pulse -108 µm to 108 µm (-100 m to +100 m) 
1 µm/pulse ≤ AUFL ≤ 1000 µm/pulse -1 09 µm to 109 µm (-1000 m to +1000 m) 
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8.8 Increment 

8.8.1 Increments 

Definition 
Increments are target specifications that can be controlled by the positioning module with the 
relative/absolute incremental approach mode. 

Prerequisites for increments 
The target that is to be approached must be at a distance in front of the respective software 
limit switch of at least one-half the target range. 

 
Figure 8-1 Limits for increment specifications 
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8.8.2 Increment number 1 to 100 

Increment number 1 to 100 
You have the option of entering up to 100 increments in a table. These are valid both for the 
relative incremental approach as well as for the absolute incremental approach. 

Note that the positioning module does not permit negative values for the relative incremental 
approach. The values will be interpreted by the positioning module - depending on the 
direction of movement - as either a positive or a negative difference. 

 

 Note 

The entry is made in the unit in accordance with the set system of units. In doing so, please 
observe the post-decimal places. 

Numerical example: 
 Incremental: 800 mm 
 System of units: 10-3 mm 
 Entry in the parameter DB: 800000 

Tip: in the increment table define separate areas for relative and absolute increments. 
 

Data used in the channel DB 
 
Address Name Type Initial value Comment 
35.4 TRGL1WR_EN BOOL FALSE 1 = write increment table 1 (increments 1 ... 50)  
35.5 TRGL2WR_EN BOOL FALSE 1 = write increment table 2 (increments 51 ... 100)  
36.6 TRGL1RD_EN BOOL FALSE 1 = read increment table 1 (increments 1 ... 50)  
36.7 TRGL2RD_EN BOOL FALSE 1 = read increment table 2 (increments 51 ... 100)  

Data used in the parameter DB 
 
Address Name Type Initial value Comment 
120.0 TRGL1.TRG[1] DINT L#0 Increment number 1 
. 
. 
. 

. 

. 

. 

. 

. 
  

. 

. 

. 

. 

. 

. 
316.0 TRGL1.TRG[50] DINT L#0 Increment number 50 

 
 
Increment table 1 

320.0 TRGL2.TRG[51] DINT L#0 Increment number 51 
. 
. 
. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 
516.0 TRGL2.TRG[100] DINT L#0 Increment number 100 

 
 
Increment table 2 
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8.8.3 Increment number 252 

Increment number 252 
The increment number 252 gives you the option of moving the drive initially in a specified 
direction without a target (continuous traversing) and positioning the drive at the assigned 
target (increment) on occurrence of an external event at digital input xI3. 

The entries from the parameter DB for this increment are applicable to the changeover and 
switch-off differences. 

Data used in the channel DB 
 

Address Name Type Initial value Comment 
36.2 TRG252_254_EN BOOL FALSE 1 = Increment for increment number 252 or 254 
96.0 TRG252_254 DINT L#0 Increment for increment number 252 or 254 

Data used in the parameter DB 
 

Address Name Type Initial value Comment 
100.0 CHGDIF_P DINT L#5000 Changeover difference plus 
104.0 CHGDIF_M DINT L#5000 Changeover difference minus 
108.0 CUTDIF_P DINT L#2000 Switch-off difference plus 
112.0 CUTDIF_M DINT L#2000 Switch-off difference minus 
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8.8.4 Increment number 254 

Increment number 254 
You can use the increment number 254 as an additional distance specification independent 
of the increment table. The entries from the parameter DB for this increment are applicable 
to the changeover and switch-off differences. 

Data used in the channel DB 
 

Address Name Type Initial value Comment 
36.2 TRG252_254_EN BOOL FALSE 1 = Write increment for increment number 

252 or 254 
96.0 TRG252_254 DINT L#0 Write increment for increment number 252 or 

254 

Data used in the parameter DB 
 

Address Name Type Initial value Comment 
100.0 CHGDIF_P DINT L#5000 Changeover difference plus 
104.0 CHGDIF_M DINT L#5000 Changeover difference minus 
108.0 CUTDIF_P DINT L#2000 Switch-off difference plus 
112.0 CUTDIF_M DINT L#2000 Switch-off difference minus 
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8.8.5 Increment number 255 

Increment number 255 
Increment number 255 provides you an additional distance specification. 

You transfer the switch-off differences and the changeover differences together with the 
increment. Unlike the other increments, increment 255 uses the values specified in the 
channel DB for the switch-off and changeover differences. The entries from the machine 
data are not applicable for this increment. 

Data used in the channel DB 
 

Address Name Type Initial value Comment 
36.3 TRG255_EN BOOL FALSE 1 = Write increment for increment number 255 
100.0 TRG255 DINT L#0 Increment for increment number 255 
104.0 CHGDIF255 DINT L#0 Changeover differences for increment number 255 
108.0 CUTDIF255 DINT L#0 Switch-off differences for increment number 255 
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Operating modes and jobs 9
9.1 End of a positioning 

Definition   
The end of a positioning is indicated by the checkback signal WORKING = 0. It can be 
reached in three different ways:   

● Target approach 

● Shutdown 

● Cancel 

Monitoring functions  
During the end of a positioning, the following monitoring functions are active: 

● Monitoring time 

The monitoring time is retriggered at the switch-off point for the last time and loses its 
validity at the end of the positioning.  

The end of the positioning must be reached within this time; otherwise, the outputs are 
switched off and the "Error during target approach" operating error (error number 5) is 
signaled. 

● Monitoring of target range 

The FM 451 places a symmetrical range around each target, thereby defining the 
positioning accuracy of your application. During a target approach, the axis must come to 
a standstill within this range. A value specification of 0 switches off the tolerance for the 
target approach. 
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● Monitoring of standstill velocity 

The standstill velocity is used to determine that the drive comes to a standstill within the 
target range. It is checked for violation after the switch-off point is reached. 

The drive velocity must be below the standstill velocity within the target range; otherwise, 
the FM 451 signals the "Target range overrun" operating error (error number 10). 

Falling short of the standstill velocity is monitored only once per target approach. 

Note that the standstill velocity can be fallen below briefly for the velocity determination of 
the module if the axis moves at a very low positioning velocity (less than 2 pulses per 8 
ms). 

● Monitoring of standstill range 

After the end of a positioning, the drive is monitored to determine whether it stays at or 
drifts off the approached target position. 

The standstill range is monitored 

– After the FM 451 has signaled the checkback signal "PEH" 

– If the monitoring time is exceeded 

– If the standstill velocity is fallen below 

If the standstill range is exited without a valid traversing job, the FM 451 signals the 
"Standstill range exited" operating error (error number 6). 
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Target approach  
The target approach in the "Absolute/relative incremental approach" modes starts when the 
switch-off point is reached. Starting from this point, the drive is switched off and the FM 451 
assumes monitoring functions. 

Depending on the assigned monitoring functions, there are different scenarios for generating 
the "PEH (POS_RCD)" checkback signal. The positioning is canceled as soon as a 
checkback signal "PEH (POS_RCD)" is not generated. 

Case 1: You have assigned: 

● Target range (TRG_RANGE) > 0 

● Standstill velocity (ZSPEED_L) > 0 

● Monitoring time (MON_TIME) > 0 

PEH is generated if the velocity falls below the standstill velocity and the target range is 
reached. It makes no difference which condition is satisfied first. 

PEH is not generated if the actual value does not reach the target range within the 
monitoring time or the target range is overrun without the velocity falling below the 
standstill velocity.   

 
① Changeover difference plus 
② Switch-off difference plus 
③ Standstill range 
④ Target range 
⑤ Standstill velocity reached 
⑥ Target range reached at VStill: PEH is set 
tÜ Monitoring time 
Figure 9-1 Target approach of an incremental approach 
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Case 2: You have assigned: 

● Target range (TRG_RANGE) > 0 

● Standstill velocity (ZSPEED_L) = 0 

● Monitoring time (MON_TIME) > 0 

PEH is generated if the target range is reached. 

PEH is not generated if the actual value does not reach the target range within the 
monitoring time.   

 
① Changeover difference plus 
② Switch-off difference plus 
③ Standstill range 
④ Target range 
⑤ Target range reached at VStill: PEH is set 
tÜ Monitoring time 
Figure 9-2 Target approach of an incremental approach 
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Case 3: You have assigned: 

● Target range (TRG_RANGE) = 0 

● Standstill velocity (ZSPEED_L) > 0 

● Monitoring time (MON_TIME) > 0 

PEH is generated if the velocity falls below the standstill velocity and the target is then 
reached. 

PEH is not generated if the actual value does not reach the target within the monitoring 
time or the target range is overrun without the velocity falling below the standstill velocity. 

 
① Changeover difference plus 
② Switch-off difference plus 
③ Standstill range 
④ Standstill velocity reached 
⑤ Target reached: PEH is set 
tÜ Monitoring time 
Figure 9-3 Target approach of an incremental approach 
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Case 4: You have assigned: 

● Target range (TRG_RANGE) = 0 

● Standstill velocity (ZSPEED_L) = 0 

● Monitoring time (MON_TIME) > 0 

PEH is generated if the target is reached. 

PEH is not generated if the actual value does not reach the target within the monitoring 
time. 

 
① Changeover difference plus 
② Switch-off difference plus 
③ Standstill range 
④ Target reached: PEH is set 
tÜ Monitoring time 
Figure 9-4 Target approach of an incremental approach 

Case 5: You have assigned: 

● Target range (TRG_RANGE) ≥ 0 

● Standstill velocity (ZSPEED_L) ≥ 0 

● Monitoring time (MON_TIME) = 0 

In this scenario, if the positioning comes to a standstill prior to the target range, the end of 
the positioning is not recognized. PEH is not generated, and the WORKING checkback 
signal remains set. You can only cancel the positioning by canceling the drive enable 
(DRV_EN = 0). 
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Shutdown without specified target  
Shutdown means: the positioning operation is terminated in a controlled manner, complying 
with the differences of rapid traverse via creep speed. 

The positioning is shut down, if 

● The FM 451 receives a STOP signal (STOP=1) 

● The "Jog" and "Reference point approach" modes are terminated 

● Operator error or operating error number 9 occurs 

The "PR (POS_RCD)" checkback signal is not set. The sequences are analogous to target 
approach. 

 
① Changeover difference plus 
② Switch-off difference plus 
③ Target range 

Figure 9-5 Shutdown of a positioning 
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Cancel  
Cancel means: the positioning is immediately ended without using the changeover difference 
and switch-off difference from rapid traverse or creep speed to standstill. All the relevant 
outputs of the respective control mode are switched off immediately, and: 

● Increment = actual value 

● Distance-to-go = zero 

The positioning is canceled if 

● The drive enable signal is deleted (DRV_EN=0) 

● The CPU goes to STOP 

● Diagnostic error or any operating error except the "Target overrun" operating error (error 
number 9) occurred 

The "PR (POS_RCD)" checkback signal is not set in "Incremental approach" mode. 

If a standstill velocity is assigned, the standstill monitoring is activated as soon as the 
velocity falls below the standstill velocity. If the standstill velocity is not assigned, the 
standstill monitoring is activated when the outputs are switched off. 

 
Figure 9-6 Cancelation of a positioning 

Data used in the parameter DB   
 

Address Name Type Initial value Comment 
76.0 TRG_RANGE DINT L#1000 Target range 
80.0 MON_TIME DINT L#2000 Monitoring time 
84.0 ZSPEED_R DINT L#1000 Standstill range 
88.0 ZSPEED_L DINT L#30000 Standstill velocity 

Checkback signals in the channel DB   
 

Address Name Type Initial value Comment 
23.1 WORKING BOOL FALSE 1 = Positioning running (processing running) 
25.7 POS_RCD BOOL FALSE 1 = Position reached 
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9.2 Configuring jog mode 

Definition   
In "Jog" mode you move the drive in one direction by pushing a button. You must install one 
button each for the two directions (plus and minus). You can use "Jog" mode for both 
synchronized and non-synchronized axes. 

For a non-synchronized axis, jogging involves a positioning in the specified direction. 

For a synchronized axis (linear axis), jogging involves a positioning to the software limit 
switches. 

Requirement 
The axis parameters must be assigned. 

Sequence of "Jog" mode sequence  
The buttons for the positive and negative traversing direction must be installed for each 
channel. 

1. Set the control signal for jog mode (MODE_IN=1). 

2. Set the control signal for the drive enable (DRV_EN=1). 

3. Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 
input for the corresponding channel. 

4. Enter the start velocity. 

– Rapid traverse (MODE_TYPE=1) 

– Creep speed (MODE_TYPE=0) 
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5. Set the control signal for traversing direction plus or minus (DIR_P=1 or DIR_M=1). 

6. Call the FC ABS_CTRL. 

 
Figure 9-7 Example for "Jog" mode 

Data used in the channel DB 
 

Address Name Type Initial value Comment 
15.2 DIR_M BOOL FALSE 1 = Minus direction 
15.3 DIR_P BOOL FALSE 1 = Plus direction 
15.7 DRV_EN BOOL FALSE 1 = Switch on drive enable 
16.0 MODE_IN BYTE B#16#0 1 = Jog 
17.0 MODE_TYPE BYTE B#16#0 1 = Rapid traverse 

0 = Creep speed 
23.0 ST_ENBLD BOOL FALSE 1 = Start enabled 
23.1 WORKING BOOL FALSE 1 = Positioning running (processing running) 
23.2 WAIT_EI BOOL FALSE 1 = Axis waits for external enable 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 
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Shutdown of jogging  
"Jog" mode is shut down, if 

● You open the button used for jogging (DIR_M or DIR_P=0) 

● The FM 451 receives a STOP signal (STOP=1) 

● The actual value reaches the limit of the operating range for a synchronized linear axis 
The axis can only continue moving in the opposite direction. 

After traversing is shut down, it can continue in any direction. 

Canceling jogging  
"Jog" mode is canceled, if  

● The drive enable signal is deleted (DRV_EN=0) 

● A traversing range limit has been overrun for a linear axis 

Monitoring functions 
In jog mode, the following monitoring functions are not active at the end of the positioning: 

● Monitoring of standstill range 

● Monitoring of target range 

● Monitoring of standstill velocity 

This operation does not result in proper positioning for which the "Position reached" signal is 
finally set. 
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Operating range limit for a linear axis 
The limits for "Jog" mode differ between a synchronized and an unsynchronized axis. 

Table 9- 1 Jogging with synchronized and unsynchronized axes 

Axis is not synchronized Axis is synchronized 
If the traversing range limit is overrun while jogging,  
 The actual value indicated is no longer valid 
 The positioning is canceled 

 
  

 The actual value indicated is no longer valid 

Jogging involves a positioning to targets that are removed 
from the software limit switches by a distance equal to the 
whole target range. 
The operating range limits are determined from:  
 SLE 1/2 target range for the end of the linear axis in the 

plus direction 
 SLS+1/2 target range for the end of the linear axis in the 

minus direction 
If you do not open the button beforehand, the FM 451 shuts 
down at a target point that is positioned half the target range 
away from the respective software limit switch. All ranges 
that are necessary for proper shutdown are set by the 
FM 451 relative to this target point. 
 

 
  

 = Part of operating range in which a target position 
cannot be located 

① = Changeover difference plus 

② = Switch-off difference plus 

③ = 1/2 Target range 
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9.3 Configuring reference point approach mode 

Definition    
The "Reference point approach" mode can be used to synchronize the axis based on a 
recurring external event.   

Requirements 
● Incremental encoder with zero mark. 

● The axis parameters must be assigned. 

 
Connections Channel 1 Channel 2 Channel 3 

Digital input 1I0 Digital input 2I0 Digital input 3I0 Home position switch   
The reference point switch should be provided such that the drive can 
safely brake from rapid traverse to creep speed in the range of the 
switch. 
Digital input 1I1 Digital input 2I1 Digital input 3I1 Reversing switch   
When assigning parameters, ensure that the start of the reference point 
approach is assigned in the direction of the reversing switch. This is 
necessary to ensure that the reference point switch is always found. 

Enable input   Digital input 1I2 Digital input 2I2 Digital input 3I2 

Sequence of "Reference point approach" mode   
1. Set the value for the reference point coordinate in the parameter DB (REFPT). 

2. Enter the type of "Reference point approach" in the parameter DB. 

Options: 

 
Start in direction ... Triggers synchronization ...  

plus  First zero mark after exiting the reference point 
switch in plus direction 

REFPT_TYPE=0 

plus  First zero mark after exiting the reference point 
switch in minus direction 

REFPT_TYPE=1 

minus  First zero mark after exiting the reference point 
switch in plus direction 

REFPT_TYPE=2 

minus  First zero mark after exiting the reference point 
switch in minus direction 

REFPT_TYPE=3 

1. Enter the start velocity. 

– Rapid traverse (REFPT_SPD=0) 

– Creep speed (REFPT_SPD=1) 

2. Write and enable machine data. 
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3. Set the control signal for reference point approach mode (MODE_IN=3). 

– The buttons for the positive and negative traversing direction must be installed for 
each channel. 

4. Set the control signal for the drive enable (DRV_EN=1). 

5. Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 
input for the corresponding channel. 

6. Set the control signal for traversing direction plus or minus or the start signal (DIR_P=1, 
DIR_M=1, or START=1). 

7. Call the FC ABS_CTRL. 

Table 9- 2 Start commands for a reference point approach 

Start 
command 

Task Comment 

DIR_P The drive starts in the direction of positive 
values. Therefore it moves in the 
direction of the traversing range end. 

If a negative direction is entered in the 
machine data, the FM 451 signals an 
operator error. No reference point 
approach is performed. 

DIR_M The drive starts in the direction of 
negative values. Therefore, it moves in 
the direction of the traversing range start. 

If a positive direction is entered in the 
machine data, the FM 451 signals an 
operator error. No reference point 
approach is performed. 

START The drive starts in the direction that was 
entered in the machine data. 

 

 
 

 Note 

The following applies to the rotary axis: Reproducibility of the reference point is only ensured 
if the ratio of the End of rotary axis value and the Distance per encoder revolution value is an 
integer. 
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Example for "Reference point approach" mode 
 

 
  
* The start signals are reset by the FC ABS_CTRL. 
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Data used in the channel DB 
 

Address Name Type Initial value Comment 
15.0 START BOOL FALSE 1 = Start positioning  
15.2 DIR_M BOOL FALSE 1 = Minus direction 
15.3 DIR_P BOOL FALSE 1 = Plus direction 
15.7 DRV_EN BOOL FALSE 1 = Switch on drive enable 
16.0 MODE_IN BYTE B#16#0 3 = Reference point approach 
23.0 ST_ENBLD BOOL FALSE 1 = Start enabled 
23.1 WORKING BOOL FALSE 1 = Positioning running (processing running) 
23.2 WAIT_EI BOOL FALSE 1 = Axis waiting for external enable 
25.0 SYNC BOOL FALSE 1 = Axis is synchronized 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 

Data used in the parameter DB 
 

Address Name Type Initial value Comment 
44.0 REFPT DINT L#0 Reference point coordinate 
52.0 REFPT_TYPE DINT L#0 Type of reference point approach 
99.0 REFPT_SPD BOOL TRUE Start velocity for reference point approach 

0 = Rapid traverse 
1 = Creep speed 

Effects of the operating mode 
● Synchronization is canceled when traversing starts. 

● The actual position is set to the value of the reference point coordinate when the "SYNC" 
checkback signal is set. 

● The operating range is specified on the axis. 

● The individual points within the operating range maintain their original value, but have 
new physical positions. 

● The reference point switch must be connected 

– For channel 1 at digital input I1 

– For channel 2 at digital input I5 

● The reference point switch must be furnished such that the drive can safely brake from 
rapid traverse to creep speed in the range of the switch. 

● When assigning parameters, ensure that the start of the reference point approach is 
assigned in the direction of the reversing switch. This is necessary to ensure that 
synchronization is achieved. 
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● The reversing switch must be connected 

– For channel 1 at digital input I2 

– For channel 2 at digital input I6 

● If the enable input is to be evaluated, connect 

– The switch to digital input I3 for channel 1 

– The switch to digital input I7 for channel 2 

● The channel for which a reference point approach is to be performed must be assigned. 

● You have defined the following in the machine data: 

– Type of reference point approach 

– Start velocity for a reference point approach 

Canceling the reference point approach   
"Reference point approach" mode is canceled, if  

● The drive enable signal is deleted (DRV_EN=0) 

● A traversing range limit has been overrun for a linear axis 

Reference point approach as a function of the start position   
For a reference point approach you must distinguish between various scenarios that depend 
on the following: 

● Location of the drive at the time a reference point approach is started 

● Assigned start direction 

● Assigned location of the zero mark relative to the reference point switch 
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The following table describes the scenarios for REFPT_TYPE 0 and 1. The figures apply 
analogously to REFPT_TYPE 2 and 3. 

 

Table 9- 3 Options for reference point approach 

Conditions for reference point approach Sequence of reference point approach 
Example of reference point approach (REFPT_TYPE=0): 
 Start direction is plus. 
 Position of zero mark of reference point switch is 

assigned in the plus direction. 

 

 
Example of reference point approach (REFPT_TYPE=1): 
 Start direction is plus. 
 Position of zero mark of reference point switch is 

assigned in the minus direction. 

 

 
  

Example of reference point approach (REFPT_TYPE=0): 
 Start direction must be assigned in the plus direction. 
 Position of zero mark of reference point switch is 

assigned in the plus direction. 
 The reversing switch is more positive than the reference 

point switch. 
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Conditions for reference point approach Sequence of reference point approach 
Example of reference point approach (REFPT_TYPE=1): 
 Start direction is plus. 
 Position of zero mark of reference point switch is 

assigned in the minus direction. 
 Start position of reference point approach is on the 

reference point switch. 

 

 
  

Example of reference point approach (REFPT_TYPE=0): 
 Start direction is plus. 
 Position of zero mark of reference point switch is 

assigned in the plus direction. 
 The reversing switch is more positive than the reference 

point switch. 

 

 
  

Example of reference point approach (REFPT_TYPE=0): 
 Start direction is plus. 
 Position of zero mark of reference point switch is 

assigned in the plus direction. 
 Start velocity= creep speed 

 

 
  

R = Direction reversal 
REF = Reference point switch 
UM = Reversing switch 
N = Zero mark of the encoder 
SYNC = Synchronization has been achieved 
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9.4 Configuring incremental approach mode 

Definition    
With "incremental approach", the FM 451 can move the drive 

● To absolute targets 

● Relatively by an incremental distance in a specified direction 

You specify the target or the relative distances as increments of the FM 451. You have the 
option of entering up to 100 increments in a table. These are applicable to relative 
incremental approach mode and to absolute incremental approach mode. You can use the 
increment 254 and increment 255 to specify the distance independent of the increment table 
(see chapter "Increments (Page 88)"). 

The increment 252 gives you the option of moving the drive initially in a specified direction 
without a target (continuous traversing) and positioning the drive at the assigned target on 
occurrence of an external event (xI3).   

Requirements    
● The axis parameters must be assigned. 

● The axis must be synchronized. 

● The increments must be available on the module. 

Interpretation of the increments 
Depending on which incremental approach you select, the FM 451 interprets the 
specifications differently. 

● Absolute incremental approach:  
The increments are interpreted as an absolute target position.  
With a rotary axis, the end of the rotary axis must not be overrun. 

● Relative incremental approach:  
The increments are interpreted as a relative distance from the start position.  
With a rotary axis, the end of the rotary axis must not be overrun (multiple rotations are 
permissible). 

  Note 

Only positive increments are allowed for the "Relative incremental approach" mode. The 
signs of the increments result from the DIR_P and DIR_M direction specifications. 
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Sequence of "Incremental approach" mode with increment number 1 - 100     
 

Absolute incremental approach   Relative incremental approach   Step 

Increment number 1 - 100 
1 Set the control signal for the "Absolute 

incremental approach" mode (MODE_IN=5). 
Set the control signal for the "Relative 
incremental approach" mode (MODE_IN=4).

2 Enter the increments in the tables (TRGL1; TRGL2). 
3 Write the increment tables (TRGL1/2WR_EN=1). 
4 Set the control signal for the drive enable (DRV_EN=1). 
5 Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 

input for the corresponding channel. 
6 Enter the increment number (MODE_TYPE=1...100). 
7 Set the control signal: 

 Linear axis: 
– START; the direction is determined 

explicitly by the target and the current 
actual value. 

 Rotary axis: 
– START; the target is approached on 

the shortest path. 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

Set the control signal: 
 Linear axis: 

– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

 Rotary axis: 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

8 Call the FC ABS_CTRL. 
Steps 2 and 3 are only necessary if no increments are yet available or the existing increments are to 
be changed. 



Operating modes and jobs  
9.4 Configuring incremental approach mode 

 FM 451 positioning module 
114 Operating Instructions, 05/2011, A5E01092713-02 

Sequence of "Incremental approach" mode with increment number 252      
 

Absolute incremental approach Relative incremental approach Step 

Increment number 252 
1 Set the control signal for the "Absolute 

incremental approach" mode (MODE_IN=5). 
Set the control signal for the "Relative 
incremental approach" mode (MODE_IN=4).

2 Set the control signal for the drive enable (DRV_EN=1). 
3 Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 

input for the corresponding channel. 
4 Enter the incremental dimension number (MODE_TYPE=252). 
5 Enter the start velocity. 

 Rapid traverse (SPEED252=1) 
 Creep speed (SPEED252=0) 

6 Enter the increment for the increment number 252 (TRG252_254). 
7 Set the trigger bit for writing the increment (TRG252_254_EN=1). 
8 Set the control signal: 

 Linear axis/rotary axis: 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

9 Call the FC ABS_CTRL. 
10 When an external event occurs (digital input xI3), the positioning to the assigned target 

(increment) is performed. 
The actions listed in items 6 and 7 can also be performed only during traversing. In this case, the FM 
451 module controls a target up to the increment specification. This target is located a distance in 
front of the respective software limit switch equal to half the target range. 
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Sequence of "Incremental approach" mode with increment number 254      
 

Absolute incremental approach Relative incremental approach Step 

Increment number 254 
1 Set the control signal for the "Absolute 

incremental approach" mode 
(MODE_IN=5). 

Set the control signal for the "Relative 
incremental approach" mode (MODE_IN=4). 

2 Set the control signal for the drive enable (DRV_EN=1). 
3 Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 

input for the corresponding channel. 
4 Enter the increment number (MODE_TYPE=254). 
5 Enter the increment for the increment number 254 (TRG252_254). 
6 Set the trigger bit for writing the increment (TRG252_254_EN=1). 
7 Set the control signal: 

 Linear axis: 
– START; the direction is 

determined explicitly by the target 
and the current actual value. 

 Rotary axis: 
– START; the target is approached 

on the shortest path. 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

Set the control signal: 
 Linear axis: 

– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

 Rotary axis: 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

8 Call the FC ABS_CTRL. 
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Sequence of "Incremental approach mode" with increment number 255      
 

Absolute incremental approach  Relative incremental approach  Step 

Increment number 255 
1 Set the control signal for the "Absolute 

incremental approach" mode 
(MODE_IN=5). 

Set the control signal for the "Relative 
incremental approach" mode (MODE_IN=4). 

2 Set the control signal for the drive enable (DRV_EN=1). 
3 Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 

input for the corresponding channel. 
4 Enter the increment number (MODE_TYPE=255). 
5 Enter the increment for the increment number 255 (TRG255). 
6 Enter the value for the changeover difference of the increment number 255 (CHGDIF255). 
7 Enter the value for the switch-off difference of the increment number 255 (CUTDIF255). 
8 Set the trigger bit for writing the increment, switch-off difference, and changeover difference 

(TRG255_EN=1). 
9 Set the control signal: 

 Linear axis: 
– START; the direction is 

determined explicitly by the target 
and the current actual value. 

 Rotary axis: 
– START; the target is approached 

on the shortest path. 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

Set the control signal: 
 Linear axis: 

– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

 Rotary axis: 
– DIR_P; start in plus direction 
– DIR_M; start in minus direction 

10 Call the FC ABS_CTRL. 
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Example of incremental approach mode 
 

 
* The start signals are reset by the FC ABS_CTRL. 
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Data used in the channel DB    
 
Address Name Type Initial value Comment 
15.0 START BOOL FALSE 1 = Start positioning  
15.2 DIR_M BOOL FALSE 1 = Minus direction 
15.3 DIR_P BOOL FALSE 1 = Plus direction 
15.6 SPEED252 BOOL FALSE Start velocity for incremental approach with 

increment number 252 
0 = Creep speed 
1 = Rapid traverse 

15.7 DRV_EN BOOL FALSE 1 = Switch on drive enable 
16.0 MODE_IN BYTE B#16#0 4 = Relative incremental approach 

5 = Absolute incremental approach 
17.0 MODE_TYPE BYTE B#16#0 Increment number 1 - 100, 252, 254, or 255 
23.0 ST_ENBLD BOOL FALSE 1 = Start enabled 
23.1 WORKING BOOL FALSE 1 = Positioning running (processing running) 
23.2 WAIT_EI BOOL FALSE 1 = Axis waiting for external enable 
25.7 POS_RCD BOOL FALSE 1 = Position reached 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 
36.2 TRG252_254_EN BOOL FALSE 1 = Write increment for increment number 252 or 

254 
36.3 TRG255_EN BOOL FALSE 1 = Write increment for increment number 255 
35.4 TRGL1WR_EN BOOL FALSE 1 = Write increment table 1 (increment number 

1...50) 
35.5 TRGL2WR_EN BOOL FALSE 1 = Write increment table 2 (increment number 

51...100) 
96.0 TRG252_254 DINT L#0 Write increment for increment number 252 or 254 
100.0 TRG255 DINT L#0 Increment for increment number 255 
104.0 CHGDIF_255 DINT L#0 Changeover difference for increment number 255 
108.0 CUTDIF_255 DINT L#0 Switch-off difference for increment number 255 



 Operating modes and jobs 
 9.4 Configuring incremental approach mode 

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 119 

Data used in the parameter DB    
 
Address Name Type Initial value Comment 
100.0 CHGDIF_P DINT L#5000 Changeover difference plus 
104.0 CHGDIF_M DINT L#5000 Changeover difference minus 
108.0 CUTDIF_P DINT L#2000 Switch-off difference plus 
112.0 CUTDIF_M DINT L#2000 Switch-off difference minus 
120.0 TRGL1.TRG[1] DINT L#0 Increment number 1 
. 
. 
. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 
316.0 TRGL1.TRG[50] DINT L#0 Increment number 50 

 
 
Increment table 1 

320.0 TRGL2.TRG[51] DINT L#0 Increment number 51 
. 
. 
. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 
516.0 TRGL2.TRG[100] DINT L#0 Increment number 100 

 
 
Increment table 2 

Distance-to-go   
The distance-to-go is the difference between the target (increment) and actual value. This is: 

● Positive, if the target has not yet been reached 

● Negative, if the target has already been overrun 

Shutdown of incremental approach    
Incremental approach mode is shut down when the FM 451 receives a STOP signal 
(STOP=1). 

After traversing is shut down, there is distance-to-go remaining. 

The remaining distance-to-go for relative incremental approach and absolute incremental 
approach with increment number 252 can be traveled to the end if all of the following 
conditions are met: 

● The operating mode is unchanged 

● The increment number is unchanged 

● The direction is unchanged 

● The remaining distance-to-go is greater than the assigned switch-off difference 

You traverse the distance-to-go by starting the relative incremental approach or the absolute 
incremental approach with increment number 252 again without making any changes. 
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Canceling the incremental approach    
The incremental approach mode is canceled when the "drive enable" signal is deleted 
(DRV_EN=0). 

Deleting the distance-to-go   
The "Delete distance-to-go" job deletes a pending distance-to-go. 

For incremental approach with increment number 252, traversing restarts with continuous 
traversing after deleting the distance-to-go. 

You also delete the pending distance-to-go when you call another operating mode or start 
the operating mode in the opposite direction. 

Data used in the channel DB    
 
Address Name Type Initial value Comment 
35.2 DELDIST_EN BOOL FALSE 1 = Delete distance-to-go 
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9.5 Configuring set actual value/set actual value on-the-fly/cancel set 
actual value 

Definition       
You use the "Set actual value" or "Set actual value on-the-fly" jobs to assign a new 
coordinate to the current encoder value. The operating range is projected on a different 
range of the axis. 

You determine the shift in the operating range with (ACTnew - ACTcurrent). 

● ACTnew is the specified value 

● ACTcurrent is the actual value at the time of execution 

Requirements   
● The axis parameters must be assigned. 

● The axis must be synchronized. 

The positioning must be ended for "Set actual value". 

Job sequence      
1. Enter the coordinate for the actual value (ACTnew) (AVAL, FVAL). 

– Linear axis: 

You must select the specified actual value such that the software limit switches are 
still within the permissible traversing range after the job is called.  

The amount of the shift resulting from (ACTnew - ACTcurrent) must be less than or equal 
to the amount of the permitted traversing range (maximum 100 m or 1000 m). 

– Rotary axis: 

Rule for the specified actual value: 

0 ≤ actual value < end of rotary axis 

2. Set the relevant trigger bit (AVAL_EN=1, FVAL_EN=1). 

"Set actual value" is executed immediately. 

"Set actual value on-the-fly" is executed at the next positive edge at digital input xI3. 
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Data used in the channel DB     
 

Address Name Type Initial value Comment 
35.7 AVAL_EN BOOL FALSE 1 = Set actual value 
36.0 FVAL_EN BOOL FALSE 1 = Set actual value on-the-fly 
84.0 AVAL DINT L#0 Coordinate for "Set actual value" 
88.0 FVAL DINT L#0 Coordinate for "Set actual value on-the-fly" 

Effects of the job   
In the example "set actual value " to 300 mm, you can see how this job projects the 
operating range onto a certain position of the axis. This produces the following effects: 

● The actual position is set to the value of the actual value coordinate. 

● The operating range is shifted on the axis. 

● The individual points (e.g., software limit switch end) within the operating range maintain 
their original value, but have new physical positions. 

Table 9- 4 Shifting of the operating range on the axis using "Set actual value" 

Set actual value SLS ACT SLE 
 
 
 
-400 
 
   

 
 
 
100 
 
   

 
 
 
400 
 
   

 

         

 
 
 
-400 
   

 
 
 
300 
   

 
 
 
400 
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Canceling the job   
The "Cancel set actual value" job can be used to reset the most recent operating range shift 
caused by "Set actual value". 

Once "Set actual value on-the-fly" has been initiated, it can no longer be canceled before 
execution by a positive edge at digital input xI3. However, it can be overwritten by a new "Set 
actual value on-the-fly". These jobs are reset the next time the module starts up. 

Data used in the channel DB   
 
Address Name Type Initial value Comment 
35.3 AVALREM_EN BOOL FALSE 1 = Cancel set actual value 
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9.6 Configuring zero offset 

Definition 
The "zero offset" job lets you shift the zero point in the coordinate system by a defined value. 

The sign determines the offset direction in the coordinate system. 

Determining a new coordinate 
All values of the shifted coordinate system can be calculated according to the following 
formula: 

Coordinatenew = Coordinateold - (ZPOnew - ZPOold) 

ZPOold designates an existing zero offset.  

If no zero offset was active prior to the call, set the value 0 for ZPOold. 

You can use this to determine the coordinate values for the software limit switches, for 
example. 

Requirements 
● The positioning must be ended. 

● The axis parameters must be assigned. 

Job sequence 
1. Enter the value for the zero offset (ZOFF). 

– Linear axis: 

The zero offset must be selected so that the software limit switches remain within the 
permissible numerical range after the job is called. 

– Rotary axis: 

Rule for the zero offset: 

value of zero offset ≤ end of rotary axis 

2. Set the relevant trigger bit (ZOFF_EN=1). 
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Data used in the channel DB 
 
Address Name Type Initial value Comment 
36.1 ZOFF_EN BOOL FALSE 1 = Set zero offset 
80.0 ZOFF DINT L#0 Zero offset 

Effects of the job on a linear axis 
Based on the example of a zero offset of -200 mm, you can see that this job shifts the 
coordinate system positively. This produces the following effects: 

● The operating range is not physically shifted. 

● The various points (such as the software limit switches) are assigned new coordinate 
values. 

Table 9- 5 Coordinate system shift as a result of zero offset 

Zero offset SLS ACT SLE 
 
 
 
-400 
 
   

 
 
 
200 
 
   

 
 
 
400 
 
   

 

         

 
 
 
-200 
   

 
 
 
400 
   

 
 
 
600 
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Effects of the job on a rotary axis 
Based on the example of a zero offset by -45°, you can see how this job rotates the 
coordinate system: 

 
Figure 9-8 Rotation of the coordinate system as a result of zero offset 

Including a ZPOold = 0, the result is a new value of 385°. 

Because the actual value starts over at 0 at the end of the rotary axis with a positive direction 
of rotation, the actual value of 25° is calculated from: 

Coordinatenew = Coordinateold - (ZPOnew - ZPOold) - end of rotary axis 

Loss of synchronization 
If synchronization is lost due to an error or is reset due to "reference point approach", a zero 
offset remains active. 

Canceling the job 
A zero offset of 0 mm resets any existing zero offset. 
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9.7 Configuring set reference point 

Definition    
You use the "set reference point" job to synchronize the axes. The job shifts the operating 
range. All the shifts that were created with set actual value are retained.    

The setting projects the operating range on the axis. Therefore, by entering different values, 
the operating range can be moved to any position within the physical area of the axis. 

Prerequisites    
● The positioning must have ended. 

● The axis parameters must be assigned. 

Job sequence    
1. Enter the value for the reference point coordinate (REFPT). 

– Linear axis: 

The reference point coordinate must not lie outside of the software limit switches. This 
also applies to the reference point coordinate in a shifted coordinate system. 

– Rotary axis: 

Rule for the reference point coordinate: 

0 ≤ reference point coordinate < end of rotary axis 

2. Set the respective trigger bit (REFPT_EN). 

Data used in the channel DB    
 
Address Name Type Initial value Comment 
25.0 SYNC BOOL FALSE 1 = axis is synchronized 
35.6 REFPT_EN BOOL FALSE 1 = set reference point 
92.0 REFPT DINT L#0 Reference point coordinate 
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Effects of the job    
In the example "set reference point" to 400 mm you can see how this job projects the 
operating range onto a specific, physical position of the axis. This has the following results: 

● The actual position is set on the value of the reference point coordinate. 

● The operating range is shifted on the axis. 

● The individual points (e.g. software limit switch end) maintain their original value, but are 
located at new positions. 

● The SYNC bit in the checkback signals is set. 

Table 9- 6 Shift of the operating range on the axis by means of "set reference point" 

Set reference point SLS ACTUAL SLE 
 
 
 
 
-400 
  
  

 
 
 
 
200 
  
  

 
 
 
 
400 
  
  

 

         

 
 
 
-400 
   

 
 
 
400 
   

 
 
 
400 
   

Special features of the absolute encoder 
This job is required for an absolute adjustment (refer to section entitled "Determining the 
absolute encoder adjustment (Page 83)"). 



 Operating modes and jobs 
 9.8 Configuring length measurement / edge detection 

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 129 

9.8 Configuring length measurement / edge detection 

Definition 
The "length measurement" and "edge detection" let you determine the length of a workpiece. 

The "length measurement" or "edge detection" function switch is active and remains active 
until you disable it or select the other measuring method. If you select both measuring 
methods in parallel, FC ABS_CTRL activates the length measurement. 

Requirements 
● The positioning must be ended. 

● The axis parameters must be assigned. 

● The axis must be synchronized. 

● A bounce-free switch must be connected to input xI3.  

● If these jobs are selected during a positioning, "length measurement" and "edge 
detection" can only be executed with the next positioning. 

Job sequence 
Depending on the type of measurement, the FM 451 updates the data on the module at a 
different time. The FM 451 reports each update in a parameter on the checkback interface. 

 
Sequence Length measurement Edge detection 

   

 
1 Set the function switch for "length measurement" 

(MSR_ON). 
Enter a value for the minimum edge distance (EDGEDIST) 
in the parameter DB. Write and enable machine data. 

2 Start a positioning. Set the "edge detection" function switch (EDGE_ON). This 
sets the MSR_DONE parameter. 

3 A positive edge at input xI3 starts the length 
measurement. 

Start a positioning. 

4 A negative edge at input xI3 stops the current 
measurement. The FM 451 updates the start 
value, end value, and length data. 

A positive edge at input xI3 starts the measurement. After 
the "minimum edge distance" is traversed, the 
measurement is valid. This is signaled with 
MSR_DONE=0. The results of the measurement are 
updated and can be read out, and the start value of the 
measurement is entered; the end value and length 
assume the value -1. 
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Sequence Length measurement Edge detection 
5 When parameter MSR_DONE is set, the 

FM 451 reports the data update. The parameter 
indicates completion of the measurement. The 
results of the measurement can be read out. 

After the update, the FM 451 reports the change by 
resetting the MSR_DONE parameter. 

6 The next start of a measurement at a positive 
edge at xI3 resets the MSR_DONE parameter. 

A negative edge at input xI3 stops the current 
measurement. The FM 451 updates the data for the end 
value of the measurement and length. 

7 - After the update, the FM 451 reports the change by setting 
the MSR_DONE parameter. The results of the 
measurement can be read out. 

8 - The next start of a measurement at a positive edge at xI3 
resets the MSR_DONE parameter. 

Data used in the parameter DB 
 
Address Name Type Initial value Comment 
4.0 EDGEDIST DINT L#0 Minimum edge distance for edge detection 
The measurement will be discarded if the end of the measuring operation is within this range (BEG_VAL, END_VAL, and 
LEN_VAL=-1). 

Data used in the channel DB 
 
Address Name Type Initial value Comment 
25.1 MSR_DONE BOOL FALSE 1 = Length measurement/edge detection completed 
34.3 EDGE_ON BOOL FALSE 1 = Edge detection ON 
34.4 MSR_ON BOOL FALSE 1 = Length measurement ON 
35.0 MDWR_EN BOOL FALSE 1 = Write machine data  
35.1 MD_EN BOOL FALSE 1 = Enable machine data 
37.0 MSRRD_EN BOOL FALSE 1 = Read measured values 
136.0 BEG_VAL DINT L#0 Start value of length measurement/edge detection 
140.0 END_VAL DINT L#0 End value of length measurement/edge detection 
144.0 LEN_VAL DINT L#0 Length 



 Operating modes and jobs 
 9.8 Configuring length measurement / edge detection 

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 131 

Boundary conditions for a length measurement 
● The CPU program requires an interval of sufficient length between the off and on edges 

at input xI3 in order to correctly evaluate the result of the measurement before a new 
measurement starts. 

● The minimum interval between the positive and negative edges at input xI3 and between 
the negative edge and the next positive edge at input xI3 must be greater than 8 ms. 

Faulty measurement 
The FM 451 returns the length value -1 in the event of a faulty length measurement/edge 
detection. A length measurement is faulty if: 

● The length measured for a rotary axis is greater than 231. 

● The on and off edges are detected simultaneously by the FM 451 (for example, due to 
switch bounce). 
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9.9 Configuring loop approach 

Definition   
You use "loop approach" to specify the direction in which a target is approached with a 
frictional connection. You can use loop approach if a frictional connection between the motor 
and axis can only be ensured in one direction. 

A target that is approached in the opposite direction is initially overrun. Then, the FM 451 
performs a direction reversal and approaches the target in the specified direction. 

Requirements    
● The axis parameters must be assigned. 

● The axis must be synchronized. 

● For a loop approach to the target in the direction opposite to the traversing direction, the 
maximum target position is: 

– In the plus traversing direction 

Target < SLE - 1/2 Target range - Switch-off difference plus - Changeover difference 
minus 

– In the minus traversing direction 

Target > SLS + 1/2 Target range + Switch-off difference minus + Changeover 
difference plus 

● A loop approach is not performed if the target is approached in the direction of the loop 
approach. In this case, an incremental approach without direction reversal is performed. 

● The sequence of the "incremental approach" mode must be known (see chapter 
"Configuring incremental approach mode (Page 112)"). 

Loop approach sequence    
1. Set the control signal for the absolute/relative incremental approach mode 

(MODE_IN=4/5). 

2. Set the control signal for the drive enable (DRV_EN=1). 

3. Set the function switch for "Do not evaluate enable input" (EI_OFF=1) or wire the enable 
input for the corresponding channel. 

4. Enter the increment number (MODE_TYPE=1...100, 254, 255). Increment number 252 is 
not permissible in this case. 

5. Set the function switch (PLOOP_ON / MLOOP_ON=1). 

6. Start the incremental approach. 
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Data used in the channel DB    
 
Address Name Type Initial value Comment 
15.0 START BOOL FALSE 1 = Start positioning  
15.2 DIR_M BOOL FALSE 1 = Minus direction 
15.3 DIR_P BOOL FALSE 1 = Plus direction 
15.7 DRV_EN BOOL FALSE 1 = Switch on drive enable 
16.0 MODE_IN BYTE B#16#0 4/5 = Relative/absolute incremental approach 
17.0 MODE_TYPE BYTE B#16#0 Increment number 1 - 100 or 254 or 255 
34.0 PLOOP_ON BOOL FALSE 1 = Loop approach in plus direction 
34.1 MLOOP_ON BOOL FALSE 1 = Loop approach in minus direction 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 

Fictitious target   
If you start a positioning to a target that is located in the direction opposite that of the 
assigned loop approach, the FM 451 determines a fictitious target for this target. The FM 451 
performs a direction reversal at the fictitious target and then approaches the target in the 
proper direction.   

This fictitious target must be at a distance in front of the respective software limit switch of at 
least one-half the target range. 

The distance of the fictitious target from the assigned target is direction dependent. 
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Table 9- 7 Calculation of the location of the fictitious target for loop approach   

Specifications Position of the fictitious target 
Parameter assignment: 
Loop + (frictional connection 
plus) and travel in minus 
direction. 

The fictitious target (Targetf) has the value: 
Targetf = Target - Switch-off difference minus - Changeover 
difference plus 
 

 
  

Parameter assignment: 
Loop - (frictional connection 
minus) and travel in plus 
direction. 

The fictitious target (Targetf) has the value: 
 
Targetf = Target + Switch-off difference plus + Changeover 
difference minus 
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Example 
Based on a positioning with loop approach to a maximum target in the plus direction, you 
see the position of the fictitious target. 

 
① Negative changeover difference 
② Positive switch-off difference 
③ 1/2 target range 

Figure 9-9 Loop approach to a maximum target in plus direction 
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9.10 Enable input 

Definition 
The enable input is an external input that can be used to execute a positioning due to an 
external event. 

Evaluate enable input (EI_OFF=0) 
The relevant enable input (xI2) must be wired for the channel. 

You have the option to prepare for the start of a positioning. You start the positioning 
independent of the program sequence of your user program by applying a "1" signal at the 
enable input.  

You have the following options for evaluating the enable inputs: 

● Level-controlled (EI_TYPE=0) 

– Traversing begins when you apply a "1" signal at the enable input and is ended when 
you apply a "0" signal at the enable input. 

● Edge-controlled (EI_TYPE=1) 

– Traversing begins with detection of a rising edge at the enable input. The additional 
signal characteristic at this input no longer affects the course of the motion that was 
started. 

Do not evaluate enable input (EI_OFF=1)  
If you disable the evaluation of the enable input, an operating mode starts immediately after 
the start signal is detected. In this case, you cannot prepare an operating mode and start it at 
a future specified time. 

Data used in the channel DB 
 
Address Name Type Initial value Comment 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 

Data used in the parameter DB 
 
Address Name Type Initial value Comment 
99.1 EI_TYPE BOOL FALSE 0 = Level-controlled 

1 = Edge-controlled 
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9.11 Read position data 

Definition 
With the "read position data" job you can read the increment, distance-to-go and speed at 
the current time. 

Job sequence 
1. Set the trigger bit in the channel DB (ACTSPD_EN=1). 

2. The data is then stored in the channel DB. 

Data used in the channel DB 
 
Address Name Type Initial value Comment 
37.1 ACTSPD_EN BOOL FALSE 1 = read position data 
112.0 ACTSPD DINT L#0 Current speed 
116.0 DIST_TO_GO DINT L#0 Distance-to-go 
120.0 ACT_TRG DINT L#0 Current increment 
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9.12 Read encoder data 

Definition   
With the "read encoder data" job you can read the current data of the encoder as well as the 
value for the absolute encoder adjustment.  

Prerequisites    
You can read the value for the absolute adjustment after you have carried out the "set 
reference point" job (refer to the section entitled "Determining the absolute encoder 
adjustment (Page 83)"). 

Job sequence    
1. Set the trigger bit in the channel DB (ENCVAL_EN=1). 

2. The data is then stored in the channel DB. 

Data used in the channel DB    
 

Address Name Type Initial value Comment 
37.2 ENCVAL_EN BOOL FALSE 1 = read encoder values  
124.0 ENCVAL DINT L#0 Actual encoder value (internal representation) 
128.0 ZEROVAL DINT L#0 Last zero mark value (internal representation) 
132.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 
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9.13 Checkback signals for the positioning 

Definition  
The checkback signals for the positioning inform you about the current status of the 
positioning. 

Sequence   
The data will be saved to the channel DB at each call of FC ABS_CTRL. 

Data used in the channel DB   
 

Address Name Type Initial value Comment 
23.0 ST_ENBLD BOOL FALSE 1 = Start enabled 
23.1 WORKING BOOL FALSE 1 = Positioning running (processing running) 
23.2 WAIT_EI BOOL FALSE 1 = Axis waiting for external enable 
23.4 SPEED_OUT BOOL FALSE 0 = Creep speed 

1 = Rapid traverse 
23.5 ZSPEED BOOL FALSE 1 = Axis is located in the standstill range 
23.6 CUTOFF BOOL FALSE 1 = Axis is located in the switch-off range 
23.7 CHGOVER BOOL FALSE 1 = Axis is located in the changeover range 
24.0 MODE_OUT BYTE B#16#0 Active operating mode  
25.2 GO_M BOOL FALSE 1 = Axis moves in minus direction 
25.3 GO_P BOOL FALSE 1 = Axis moves in plus direction 
25.5 FVAL_DONE BOOL FALSE 1 = Set actual value on-the-fly completed 
25.7 POS_RCD BOOL FALSE 1 = Position reached 
26.0 ACT_POS DINT L#0 Current actual value (current position of axis) 
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9.14 Checkback signal for the diagnostics 

Definition  
The "checkback signal for the diagnostics" informs you of occurring diagnostic events.  

Sequence   
1. If the module enters a new event in the diagnostic buffer, it sets the DIAG bit in all the 

channels in the checkback interface. Every time an error occurs, all of the error classes 
listed in the appendix "Data blocks and error lists (Page 189)" create an entry in the 
diagnostic buffer. The DIAG bit is also set when the diagnostic buffer is deleted. 

2. If it is not possible to call an operating mode or control an active operating mode, or if this 
was carried out incorrectly, the module sets an operator error (OT_ERR) in the checkback 
interface. The cause of error is then entered in the diagnostic buffer. While the operating 
error exists, you can neither start a new operating mode nor continue with the halted one. 
You acknowledge an existing operating error with OT_ERR_A=1. 

3. If the module detects a write job with faulty data, it sets the DATA_ERR bit. The cause of 
error is then entered in the diagnostic buffer. 

4. The checkback signals are stored in the channel DB. 

5. When the diagnostic buffer is read, the module sets the DIAG bit back to 0 in all 
channels. 

Data used in the channel DB   
 
Address Name Type Initial value Comment 
22.2 DIAG BOOL FALSE 1 = Diagnostic buffer changed 
22.3 OT_ERR BOOL FALSE 1 = Operator error 
22.4 DATA_ERR BOOL FALSE 1 = Data error 
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Encoder 10
10.1 Incremental encoder 

Connectable incremental encoders  
Only incremental encoders with two pulses electrically offset at 90° with or without zero 
marks are supported: 

● Encoders with asymmetrical output signals with 24 V level 

– Limit frequency = 50 kHz 

– cable up to 100 m long 

● Encoders with symmetrical output signals with 5 V differential interface in accordance 
with RS 422 

– Limit frequency = 500 kHz 

– with 5 V voltage supply: cable up to 32 m long 

– with 24 V voltage supply: cable up to 100 m long 

 

 Note 

If the 5 V encoder does not output a zero mark signal and wire-break monitoring is enabled, 
you must interconnect the zero mark signal inputs N and /N externally so that the inputs will 
exhibit different signal levels (for example, N to 5V, /N to ground). 

 

Signal forms   
The following figure illustrates the signal forms of encoders with asymmetrical and 
symmetrical output signals.      
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Table 10- 1 Incremental encoder signal forms 

asymmetrical symmetrical 
 

    

 

    

  

Signal evaluation 

increments  
An increment identifies a signal period of the two signals (A and B) of an encoder. This value 
is specified in the technical specifications of an encoder and / or on its ID plate. 

 
Figure 10-1 Increments and pulses 
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Pulses  
The positioning module evaluates all 4 edges of signals A and B in every increment 
(quadruple evaluation).  

 
Pulses 
1 increment (encoder specification) = 4 pulses (FM evaluation) 

Response times   
The positioning module has the following response times for connected incremental 
encoders: 

 
Response times 
Response time = switching cycle of the connected switching elements 

 
 

 Note 

You can compensate for the minimum response time by assigning the changeover difference 
and switch-off difference accordingly. 

 

Indecision  
The indecision influences the precision of the positioning. In the case of incremental 
encoders the indecision is negligible. 
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10.2 Absolute encoders 

Single-turn and multiturn encoders       
Absolute encoders are divided into the categories: 

● Single-turn encoder 

The total range of single-turn encoders is scaled to one revolution.  

● Multiturn encoder 

The total range of multiturn encoders is scaled to several revolutions. 

Connectable absolute encoders 
Absolute encoders with serial interface are supported. Position data are transferred 
synchronously using the SSI protocol (SynchronousSerialInterface). FM 451 only supports 
GRAY code. The arrangement of the data bits in the message frames produce the data 
formats 25-bit (fir tree) and 13-bit (half fir tree). 

 
Encoder type Message frame length 

Single-turn encoder 13 bit 
Single-turn encoder 25 bit 
Multiturn encoder 25 bit 

Data transmission    
The data rate for data transmission depends on the cable length (see appendix "Technical 
specifications (Page 179)"). 

Pulse evaluation of absolute encoder    
 
Pulse evaluation of absolute encoder 
1 increment (encoder default) = 1 pulse (FM evaluation) 
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Response times    
With absolute encoders, the FM 451 has the following response times: 

 
Response times 
Minimum response time = message frame runtime + switching time of the connected switching elements 
Maximum response time = 2 x message frame runtime + monoflop time + switching time of the connected switching 
elements 
With programmable absolute encoders: 
Maximum response time = message frame runtime + monoflop time + switching time of the connected switching elements 
+1/max. step sequence rate 

Monoflop time    
The monoflop time is 64 µs. 

Encoders with values outside the limits indicated here are not permitted. 

Message frame runtimes    
The message frame runtimes depend on the baud rate: 

 
Baud rate Message frame runtime for 13 bits Message frame runtime for 25 bits 
0.125 MHz 112 µs 208 µs 
0.250 MHz 56 µs 104 µs 
0.500 MHz 28 µs 52 µs 
1.000 MHz 14 µs 26 µs 

Example of response times 
The following example shows how to calculate the minimum and maximum response times. 
In the example a programmable encoder is not used. 

● Switching time of the hardware: Approx. 150 µs 

● Message frame runtime: 26 µs at a baud rate of 1 MHz (25-bit message frame) 

● Monoflop time: 64 μs 

Minimum response time = 26 µs + 150 µs = 176 µs 

Maximum response time = 2 x 26 µs + 64 μs + 150 µs = 266 µs 

 
 

 Note 

You can compensate for the minimum response time by assigning the changeover and 
switch-off differences accordingly. 
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Indecision   
The indecision is the difference between the minimum and maximum response times. With 
an absolute encoder it is as follows: 

 
Indecision 
Indecision = Message frame runtime + monoflop time 
With programmable absolute encoders: 
Indecision = Message frame runtime + monoflop time+ 1/max. step sequence frequency   
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Diagnostics 11
11.1 Possibilities of error display and error evaluation 

Information regarding errors    
You receive information regarding errors in the following ways: 

● Observe the error LEDs on the module. 

You can look up the meaning of the error LEDs in the section entitled "Significance of the 
error LED (Page 149)". 

● Connect your PG with the CPU and open the error evaluation screen of the configuration 
software. The current (error) status of the module is shown with the error class, error 
number, and in plain text. If necessary, update the display by pressing the "update" 
button. Causes and remedies for the displayed error messages can be found in the error 
list, in the appendix under "Error classes (Page 199)". 

● Provide your user program with a detailed error evaluation (refer to the section entitled 
"Error display with OP (Page 150)") or a response to a diagnostic alarm (refer to the 
sections entitled "Error display with OP (Page 150)" and "Diagnostic interrupts 
(Page 157)"). 

● For a display in an OP: Read out the diagnostic buffer of the module cyclically in your 
user program. Evaluate the diagnostic DB in the OP. The meaning of error class and 
error number can be found in the error list, in the appendix under "Error classes 
(Page 199)". 

Delete diagnostic buffer   
In order for you to chronologically organize error messages better, the positioning module 
offers the possibility of completely deleting the diagnostic buffer. But this is then only 
possible when the positioning has already ended and the channel has been assigned. 
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11.2 Types of error 

11.2.1 Synchronous errors 

Description    
These errors occur synchronously to a job or to the start of a positioning. Synchronous errors 
are operator errors (error class 2), data errors (error class 4), machine data errors (error 
class 5), increment table errors (error class 6) (refer to the appendix for a description of error 
classes). 

11.2.2 Asynchronous errors 

Description   
These errors occur during operation on account of external events. They trigger a diagnostic 
interrupt. Asynchronous errors are operating errors (error class 1) and diagnostic errors 
(error class 128) (refer to the appendix for a description of error classes). 



 Diagnostics 
 11.3 Significance of the error LED 

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 149 

11.3 Significance of the error LED 

Error LED 
The status and error display indicate various error states. The LEDs are lit, even with errors 
that occur briefly, for at least 3 seconds. 

 
Figure 11-1 Status and error displays of FM 451 

 
Display Meaning Notes 

INTF (red)  
LED - ON 

Group error for 
internal error 

This LED indicates the following error state of the FM 451: 
 Module defect 
 Internal (channel) error 
 The FM 451 is not configured. Configure the module. 

EXTF (red)  
LED - ON 

Group error for 
external error 

This LED indicates an external (channel) error. 
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11.4 Error display with OP 

Program structure 
The following figure shows the "General program structure" presented in chapter 
"FC ABS_CTRL (FC 1) (Page 41)", expanded to include the readout of the diagnostic buffer 
for display on an OP. The FC ABS_DIAG stores the diagnostic buffer in a DB that can be 
displayed by the OP.  

 
Figure 11-2 Program structure with diagnostic display for the OP 
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11.5 Error evaluation in the user program 

Error response in the user program    
In the user program you can respond selectively to errors. The following methods can be 
used: 

● The return value (RET_VAL) of the integrated standard FCs: 

this value is redetermined each time the function is called.  

RET_VAL = -1 is a group display for a synchronous error in a job or when communicating 
with the module. 

● An error bit (_ERR) belongs to each job. This is a group display for an error in the job or 
one of its predecessors in a job chain: 

the error bit is set for a write job and its subsequent jobs when a data error is reported by 
the module or a communication error occurs. 

With reading jobs the error bit is set for the job in question when a communication error 
occurs. 

The FC ABS_CTRL resets the error bits after a job has been processed. These should 
however be cancelled by the user program in the case of an error assessment. 

● The checkback signal DATA_ERR as a group display for an error that the module has 
detected during a write job. The signal will be established again with the next write job. 

● The checkback signal OT_ERR (operator error) as a group display for an error that the 
module has detected when starting a traverse. The error must be acknowledged with 
OT_ERR_A=1 after the cause has been remedied. 

● The checkback signal DIAG is set when the contents of the diagnostic buffer have 
changed. This signal can come along later than the signals DATA_ERR and OT_ERR. 

● The communication error JOB_ERR includes the error code in the case of a 
communication problem between the FC and the module (refer to list of JOB_ERR 
messages in the appendix "List of JOB_ERR messages (Page 198)"). The value is 
redetermined after a job has been processed and is stored in the channel DB for the 
FC ABS_CTRL and in the diagnostic DB for the FC ABS_DIAG. 

● The FC ABS_DIAG for reading out the diagnostic buffer of the module. Here you can 
discover the error causes for synchronous and asynchronous events. 

● Diagnostic interrupts for the fast response to events in the diagnostic interrupt OB 
(OB 82). 
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In the following figure you will find a possible program structure with which you can respond 
to the checkback signals "data error" (DATA_ERR), "operating error" (OT_ERR) and the 
error bits of the job (_ERR).  

 
Figure 11-3 User program with evaluation of the error bits in the jobs 
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The following image offers a possible program structure using which you can evaluate all the 
errors via the entries in the diagnostic DB. In this way you can respond to the program if one 
or more errors are reentered in the diagnostic buffer of the module. Some possible program 
responses are listed in the following detailed figures. 

 
Figure 11-4 User program with complete error evaluation via the diagnostic DB 
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Figure 11-5 Possible evaluation of a data error 

 
Figure 11-6 Possible evaluation of an operating error 

 
Figure 11-7 Possible evaluation of a diagnostic interrupt 
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Figure 11-8 Possible evaluation of a specifically stipulated error 
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11.6 Diagnostics buffer of the module 

Diagnostic events   
The module´s diagnostic buffer includes maximum 9 diagnostic events and is organized as a 
ring buffer. 

A diagnostic event is written in the buffer if an "incoming" (error) message is detected. This 
can be a message, a synchronous error (data error, operator error) or even an asynchronous 
error (operational error and diagnostics error). From a cause of error several entries can 
occur as follow-up errors. Outgoing messages do not create any entries in the diagnostic 
buffer. 

For each diagnostic event the following is given: 

● Status (always incoming) 

● Internal error 

● External error 

● Error class 

● Error number 

● Channel number 

● Increment number (in the case of increment table errors) 

When a diagnostic event is written in the diagnostic buffer, the checkback signal DIAG=1 is 
set in all assigned channels. 

With the FC ABS_DIAG, the diagnostic buffer can be transferred as a whole into a data block 
(diagnostic DB) or displayed via the error evaluation screen of the configuration software. If 
the diagnostic buffer is read, the module sets the checkback signal DIAG=0. 

 
 

 Note 

If the diagnostic buffer is read simultaneously from the FC ABS_DIAG and the error 
evaluation screen, it is possible that a new diagnostic event is not detected by the program. 
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11.7 Diagnostic interrupts 

Interrupt processing   
The FM 451 can trigger diagnostic interrupts. You process these interrupts in an interrupt 
OB. If an interrupt is triggered and the corresponding OB is not loaded, the CPU goes to 
STOP mode (refer to the Programming with STEP 7 Manual).  

You enable the processing of diagnostic interrupts as follows: 

1. Select the module in HW Config 

2. Select Edit > Object Properties > Basic Parameters and enable the diagnostic interrupt. 

3. Save and compile the hardware configuration. 

4. Download the hardware configuration to the CPU. 

Overview of the diagnostic interrupts    
Events and errors triggering a diagnostic interrupt: 

● Operating error 

● Incorrect machine data (when parameters assigned with SDB) 

● Diagnostic errors 

For the meaning of error classes and error numbers, refer to the error list in the appendix 
"Error classes (Page 199)". 

Reaction of FM 451 to an error with diagnostic interrupt    
● The positioning is canceled. 

● The synchronization is canceled when the following diagnostic interrupts occur: 

– Front connector missing, external auxiliary voltage for encoder supply missing 

– Zero mark error detected, cable fault (5 V encoder signals) 

– Traversing range exited (indicated by an operating error) 

– Set actual value cannot be executed (indicated by an operating error). 

● With one exception, control signals START, DIR_P, and DIR_M are no longer processed 

Exception: 

When an operating error occurs, jogging in the direction of the operating range is still 
possible. 

● Function switches and jobs continue to be processed. 
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FM 451 detects an error ("incoming")   
A diagnostic interrupt is an "incoming" event if at least one error is pending. If all errors were 
not eliminated, the remaining pending errors are reported again as "incoming" events. 

Sequence: 

1. The FM 451 detects one or more errors and generates a diagnostic interrupt. Either the 
"INTF" or "EXTF" LED illuminates. The error is entered in the diagnostic buffer. 

2. The operating system of the CPU calls OB 82. 

3. You can now evaluate the start information of OB 82. 

4. The OB82_MOD_ADDR parameter indicates which module triggered the interrupt. 

5. For further information, call FC ABS_DIAG. 

FM 451 detects the transition to the error-free state ("outgoing")   
A diagnostic interrupt is an "outgoing" event only if the last error on the module has been 
eliminated. 

Sequence: 

1. The FM 451 detects that all errors have been eliminated and triggers a diagnostic 
interrupt. The "INTF" or "EXTF" LED is no longer lit. The diagnostic buffer is not changed. 

2. The operating system of the CPU calls OB 82. 

3. The OB82_MOD_ADDR parameter indicates which module triggered the interrupt. 

4. Evaluate the OB82_MDL_DEFECT bit. 

When this bit is "0", no errors are present on the module. You can close the evaluation 
session at this point. 

Diagnostic interrupt as a function of the CPU status 
● Diagnostic interrupts are blocked by the FM 451 when the CPU is in STOP mode. 

● If not all of the pending errors are eliminated while the CPU is in STOP mode, the FM 451 
reports the remaining errors as "incoming" events again at the next CPU transition to 
RUN. 

● If all pending errors are eliminated while the CPU is in STOP mode, the FM 451 does not 
report its error-free state with a diagnostic interrupt at the next CPU transition to RUN. 
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Evaluation of a diagnostic interrupt in the user program    
The FM 451 sets the following entries in the local data of the diagnostic interrupt OB 
(OB 82). The errors are also entered in the diagnostic buffer (error class 128, for meaning 
and possible remedies, see appendix "Error classes (Page 199)"): 

 
Address Name Type Comment 

0.0 OB82_EV_CLASS BYTE Event class and identifiers: 
B#16#38: Outgoing event 
B#16#39: Incoming event 

1.0 OB82_FLT_ID BYTE Error code (B#16#42) 
2.0 OB82_PRIORITY BYTE Priority class: 

B#16#1A in RUN mode 
B#16#1C in START mode 

3.0 OB82_OB_NUMBR BYTE OB number (82) 
4.0 OB82_RESERVED_1 BYTE Reserved 
5.0 OB82_IO_FLAG BYTE Input module: B#16#54 
6.0 OB82_MDL_ADDR INT Logical base address of the module where the 

error occurred 
8.0 OB82_MDL_DEFECT BOOL Module fault 
8.1 OB82_INT_FAULT BOOL Internal error 
8.2 OB82_EXT_FAULT BOOL External error 
8.3 OB82_PNT_INFO BOOL Channel error present 
8.4 OB82_EXT_VOLTAGE BOOL External auxiliary voltage missing 
8.5 OB82_FLD_CONNCTR BOOL Front connector missing 
... Not used 
10.3 OB82_WTCH_DOG_FLT BOOL Watchdog timer responded 
... Not used 
12.0 OB82_DATE_TIME DATE_AND_TIME Date and time when the OB was called 
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Figure 11-9 Possible evaluation of a diagnostic interrupt 
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Examples 12
12.1 Introduction 

Example project 
The FM 451 configuration package you installed contains example projects showing you 
several typical applications based on a number of selected functions.  

The English example project is located in the following folder:  

...\STEP7\EXAMPLES\zDt18_01 folder 

It contains several S7 programs of various complexities and objectives. 

12.2 Prerequisites 

Conditions for executing the examples 
The following requirements must be met: 

● You have installed and completely wired an S7 station, consisting of a power supply 
module, a CPU, and an FM 451 module, version V2 or higher. The behavior of older 
versions may deviate from that described here. 

● STEP 7 as well as the configuration package for the FM 451 are correctly installed on 
your PC or programming device. The description of handling is based on STEP 7 V5.0. 
Deviations may occur in the case of other versions. 

● The programming device is connected to the CPU. 

You can operate an FM 351 or an FM 451 with the examples.  
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12.3 Prepare examples 

Procedure   
In order to work through the examples online, you must prepare as follows: 

1. Use SIMATIC Manager to open the example project zEn18_01_FMx51___Prog in the 
\STEP7\EXAMPLES folder (use the detailed representation to display the symbolic 
name) and copy it under a suitable name in your project directory (File > Save as). 

2. Insert in your project a station that complies with your hardware set-up. 

3. Configure all of the hardware with HW Config and save the configuration. 

4. Select an example program and copy the program to the offline CPU. 

5. Assign parameters for the FM 451 based on the "Getting Started". Use File > Export to 
export the parameters that are adapted to your system to the parameter DBs of all the 
examples, except for the "Getting Started" example. 

6. Enter the module address in the associated channel DB and, if necessary, also in the 
corresponding diagnostic DB in the "MOD_ADDR" parameter (refer to the section entitled 
Basics of programming a positioning module (Page 37)). 

7. Download the hardware configuration to your CPU. 

8. Download the blocks to your CPU. 

9. If you would like to try the next example, go to step 4. 

12.4 Example codes 

Examples in STL 
The examples are written in STL. You can view them directly via the LAD/FBD/STL editor.  

Select the view with "symbolic display", "icon selection" and "comment". If you have sufficient 
space on the screen, you can also view the "icon information". 
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12.5 Testing an example 

Test sequence  
Once you have made all the entries necessary for the respective example, download the 
entire block container to the CPU.  

The example programs include variable tables (VATs) you can use to view and change data 
blocks online, i.e. in CPU RUN mode. Select the views "icon" and "icon comment" from the 
variable table. Open a variable table, connect it with the configured CPU and cyclically 
monitor the variables. This way the displayed variables are constantly updated. By 
transmitting the control values you can change the values in the online data blocks. 

All examples assume that you have entered and saved the machine data with the parameter 
assignment screens. This allows you to work through the examples sequentially.  

12.6 Continuing to use an example 

Procedure 
You can continue using the code of examples directly as a user program. 

The code of examples is not optimized and also is not designed for all eventualities. Error 
evaluations have not been extensively programmed in the example programs so as not to 
make the programs too comprehensive.  

The "AllFunctions" example program can be used as a copy template in which, by means of 
modifying, you can compile the functions that can then be used as a basic template for your 
user program. 

The examples are prepared for channel 1 ("severalchannels" for channel 1 and 2). Use the 
LAD/FBD/STL editor to change the channel number. 
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12.7 Example program 1 "FirstSteps" 

Objective    
With this example you can commission your positioning module whose parameters you have 
assigned with the aid of "Getting Started".  

This example expands the program in the "Linking to the User Program" chapter of the 
"Getting Started" by an error evaluation. 

Requirements 
You have assigned the positioning module parameters as described in "Getting Started". 

In the channel DB, the address of your module is entered correctly in the MOD_ADDR 
parameter, and the channel number is correctly entered in the CH_NO parameter.  

Startup 
In the start-up OB (OB 100) you call the FC ABS_INIT, which resets all the control and 
checkback signals as well as the job management in the channel DB. 

Cyclic operation 
Open the variable table (VAT_CTRL_1), create the connection to the configured CPU and 
then monitor the variables. Transfer the prepared control values. Activate the 
"CHAN_1".DRV_EN: the drive is now enabled ("CHAN_1".ST_ENBLD=1). If the drive is not 
enabled, please check your enable inputs. 

 
 

CAUTION  
Start the drive by means of the two next steps. 

You can stop the drive again by using one of the following measures: 
 Reset the control value for the direction to 0 and activate 
 Reset the control value for the drive enable to 0 and activate 
 Bring the CPU to STOP 

 

 

Set DIR_P=1 to be able to move in the plus direction with the selected "Jog" mode. If you set 
DIR_P=0, the drive is shut down properly. 
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Error evaluation 
Create a data error by setting in the VAT_CTRL_1 the reference point coordinate 
"CHAN_1".REFPF outside of the operating range or the end of rotary axis. Then activate the 
job "set reference point" with "CHAN_1".REFPT_EN=1. The CPU goes to STOP. In an 
example, this is the simplest method of indicating an error. You can of course program a 
different error evaluation.  

Open HW Config and double-click the FM 451. This opens the configuration software. 
Display the cause of error via the Debug > Error evaluation screen.  

The status values in the VAT_CTRL_1 still show the status before the STOP of the CPU. 
Update the status values in order to view the done bits and error bits of the jobs. 

Proceed as follows to remedy the error: 

1. Enter a permissible value in the control value. 

2. Switch the CPU to STOP. 

3. Switch the CPU to RUN mode. 

4. Enable the control values. If you have already enabled the control values before the CPU 
is restarted, the initialization will reset them again in the OB 100 and they will therefore be 
ineffective. 
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12.8 Example program 2 "Commissioning" 

Aim    
In this example you commission the positioning module without using the parameter 
assignment screens. You control and monitor by means of variable tables (VAT).  

Requirements 
You have assigned the positioning module parameters as described in "Getting Started". 

In the channel DB, the address of your module is entered correctly in the MOD_ADDR 
parameter, and the channel number is correctly entered in the CH_NO parameter.  

In the diagnostic DB, the address of your module is entered correctly in the MOD_ADDR 
parameter. 

The supplied channel DB already includes the DB number 30 of the parameter DB for the 
machine data in the PARADBNO parameter. 

The machine data of your system are stored in the PARADB_1 data block.  

Start-up 
In the start-up OB (OB 100) call the FC ABS_INIT in order to initialize the channel DB. Then 
set the trigger bits for all jobs that you require after start-up of the module. 

Cyclic operation 
Open the variable table (VAT_CTRL_1), create the connection to the configured CPU and 
then monitor the variables. 

Transfer the prepared control values. "Jog" mode is set and the necessary enables are set. 
The drive turns by means of DIR_P=1. The actual value must change. In order to stop the 
drive, set STOP to "1" and transfer the control values. 

Activate and transfer the control value "CHAN_1".REFPT_EN (set reference point). The 
checkback signal "CHAN_1".SYNC =1 means: the channel is synchronized. 

In VAT_DIAG you can see the most important entries of the diagnostic buffer of the module. 
The meaning of the error classes and error numbers can be found in the manual in the 
appendix section entitled "Error classes (Page 199)". 
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Error evaluation 
Try to create more errors: 

● Specify a reference point coordinate that is greater than the operating range or the end of 
rotary axis. 

● Switch off the external auxiliary voltage. 

● Delete the PARADB_1 on the online CPU and try to write the machine data. In the 
example, the error evaluation is programmed in such a way that the CPU goes to STOP. 
When you update VAT_CTRL_1 again, the error code for this error is displayed in the 
"CHAN_1".JOB_ERR. The meaning of the error codes can be found in the manual in the 
appendix section entitled "List of JOB_ERR messages (Page 198)". 
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12.9 Example program 3 "AllFunctions" 

Objective    
This example uses all the functions of the FM 351 / 451: 

● Operating modes 

● Function switch 

● Write jobs 

● Read jobs 

You can use the example programs as copy templates. By means of modification, compile 
the functions that will form the basic template for your user program. The data that you must 
adapt to your application are identified with ***. Some functions are only available with the 
FM 451. 

Responses to external events and the error evaluation are system-specific and are therefore 
not included in this example. 

Requirements 
You have assigned the positioning module parameters as described in "Getting Started". 

In the channel DB, the address of your module is entered correctly in the MOD_ADDR 
parameter, and the channel number is correctly entered in the CH_NO parameter.  

The supplied channel DB already includes the DB number 30 of the parameter DB for the 
machine data in the PARADBNO parameter. 

The machine data of your system are stored in the PARADB_1 data block. 

Startup 
In the startup OB (OB 100) call the FC ABS_INIT in order to initialize the channel DB. Then 
set the trigger bits for all jobs that you require after startup of the module. 
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Operation 
The CPU is in STOP. Open the variable table USER_VAT and enter the necessary job 
number in the control values for your user program. The job numbers are explained in the 
code of the example. 

In doing so, the correct combination of user data "USER_DB".CTRL_SIG, 
"USER_DB".FUNC_SW, "USER_DB".WR_JOBS, "USER_DB".RD_JOBS and 
"USER_DB".RETVAL_CTRL is necessary. 

For more information, refer to the section entitled "Operating modes and jobs  (Page 93)". 

Create the connection to the configured CPU and transfer and activate the control values. 

Start the CPU (STOP > RUN). Monitor the checkback signals and actual values. 

You can repeat the processing of the step chain by means of a new STOP RUN transition of 
the CPU. Obviously, this action is not suitable for continuous operation. In the example we 
use this action so that the module is always reinitialized. 
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12.10 Example program 4 "OneChannel" 

Objective    
In this example you control a drive by means of the user program. The user program 
commissions the module after a CPU restart. Next, it executes a step sequence that is 
triggered by certain events.  

Using the variable tables, you define events, monitor the reactions of the module, and 
evaluate the diagnostic buffer.  

In this slightly more complex example, you can get to know the following block possibilities: 

● Issuing several jobs simultaneously 

● Mixing write and read jobs 

● Reading with a continuous job, without waiting for the end of the job 

● Evaluation of the checkback signals of the block 

● Evaluation of the checkback signals for an individual job 

● Resetting of done bits and error bits for individual jobs or all jobs 

● Central call of ABS_CTRL at the end of the user program 

Requirements 
You have assigned the positioning module parameters as described in "Getting Started". 

In the channel DB, the address of your module is entered correctly in the MOD_ADDR 
parameter, and the channel number is correctly entered in the CH_NO parameter.  

The supplied channel DB already includes the DB number 30 of the parameter DB for the 
machine data in the PARADBNO parameter. 

The machine data of your system are stored in the PARADB_1 data block.  

Startup 
In the start-up OB (OB 100) you set the start-up identifier (step 0) for the user program in the 
associated instance DB (USER_DB).  
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Operation 
The CPU is in STOP. Open the variable table USER_VAT, adapt the increment 
("USER_DB".TRG_INC_1, "USER_DB".TRG_INC_2), the changeover difference 
("USER_DB".CHGDIF) and the switch-off difference ("USER_DB".CUTDIF) to your system 
and transfer the control values. 

Start the CPU (STOP > RUN). Observe the step number of the step chain 
("USER_DB".STEPNO), the checkback signals and the actual values. After the initialization 
a "relative incremental approach" is carried out. The drive travels in a negative direction to its 
first position ("USER_DB".TRG_INC_1). 

Then the program waits in step 6 for an external trigger ("USER_DB".START_INC_2), in 
order to commence the next incremental approach in direction plus. When the position is 
reached, the step chain is at its end value (-2). The incremental approach with increment 
number 255 allows the transfer of the changeover difference and switch-off difference. With 
that you can test the conduct of your target approach. 

You can repeat the processing of the step chain by means of a new start (STOP > RUN) of 
the CPU. Obviously, this procedure is not suitable for continuous operation. In the example 
we use this to achieve that the module is always reinitialized. 

Error evaluation 
In the case of an error in the processing, the step chain is brought to a halt. Step number -1 
will be entered.  

Try to create errors that will be stored by the central error evaluation as group errors in the 
"USER_DB".ERR bit. 

● In the USER_VAT, enable the prepared control value for the increment number 1 
("USER_DB".TRG_INC_1), which is greater than the software limit switch. 

The step chain is brought to a stop and -1 is shown as the step number. Check the errors 
by means of the error evaluation screen. 

● In the USER_VAT enable further control values one after the other for the increment 
number 1 ("USER_DB".TRG_INC_1), increment number 255 ("USER_DB".TRG_INC_2), 
and the change-over difference ("USER_DB".CHGDIF) and switch-off difference 
("USER_DB".CUTDIF). For the error inspection proceed as you would with increment 1. 



Examples  
12.10 Example program 4 "OneChannel" 

 FM 451 positioning module 
172 Operating Instructions, 05/2011, A5E01092713-02 

User program FB 1 (USER_PROG) 
The user program uses the data in the module-specific data blocks (USER_DB) in the form 
<block name>.<symbolic identifier>. This way, the user program can operate a channel 
precisely.  

In this program mode you can access the data in the data block by means of the symbolic 
identifiers. The indirect addressing for several channels can be found in the example 
program 6 "SeveralChannels". 

The user program executes a step sequence as follows: 

Step 0: The positioning module is initialized. Associated data is set to the jobs that are to be 
executed when the module is restarted. 

Step 1: The program waits for the jobs set in Step 0 to be executed. 

Step 2: The assigned value of the increment "USER_DB".TRG_INC_1 is entered in the 
increment table. Then the increment table is written in the module. The control signals for the 
first incremental approach will be issued simultaneously. The FC ABS_CTRL ensures the 
correct sequence of execution from step 2. 

Step 3: The program waits for the set write job to be executed. 

Step 4: The program waits for the checkback signal "PR" and the updated position values 
from the first incremental approach. 

Step 5: The assigned values for the second incremental approach, changeover difference, 
and switch-off difference are entered in the channel DB. Then, with 
"USER_DB".START_INC_2 the second incremental approach is started with increment 
number 255. 

Step 6: The program waits for the set jobs to be executed. 

Step 7: The program waits for the checkback signal "PR" and the updated position values 
form the second incremental approach. 
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12.11 Example program 5 "DiagnosticsAndInterrupts" 

Objective    
This example includes a user program with the same formulation as in the example program 
4 "OneChannel". In addition, we show you how you evaluate a diagnostic interrupt for 
specific modules and then make this into a general module error in the user program.  

Requirements 
You have assigned the positioning module parameters as described in "Getting Started". 

In the channel DB, the address of your module is entered correctly in the MOD_ADDR 
parameter, and the channel number is correctly entered in the CH_NO parameter.  

In the diagnostic DB, the address of your module is entered correctly in the MOD_ADDR 
parameter. 

The supplied channel DB already includes in the PARADBNO parameter the DB number 
(30) of the parameter DB for the machine data. 

The machine data of your system are stored in the PARADB_1 data block.  

In the HW Config, enable the diagnostic interrupt for this module via Edit > Object properties 
> Basic parameters > Select interrupt > Diagnostics. Compile the hardware configuration, 
and then download it to the CPU.  

Startup 
In the startup OB (OB 100) you set the startup identifier (step 0) for the user program in the 
instance DB.  

Operation 
As in example program 4 "OneChannel".  
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Error evaluation 
In the case of an error in the processing, the step chain is brought to a halt. Step number -1 
will be entered. In the USER_VAT you will find the latest entry of the diagnostic buffer. You 
can determine the cause of error via the error class and error number (refer to the appendix 
section entitled "Error classes (Page 199)"). 

Try to create errors that will be stored by the central error evaluation as group errors in the 
"USER_DB".ERR bit. 

● In the USER_VAT, enable the prepared control value for the increment number 1 
("USER_DB".TRG_INC_1), which is greater than the software limit switch. 

The step chain is brought to a stop and -1 is shown as the step number. Check the errors 
via the error evaluation screen or the diagnostic data in the USER_VAT. 

● In the USER_VAT enable further control values one after the other for the increment 
number 1 ("USER_DB".TRG_INC_1), increment number 255 ("USER_DB".TRG_INC_2), 
and the change-over difference ("USER_DB".CHGDIF) and switch-off difference 
("USER_DB".CUTDIF). For the error inspection proceed as you would with increment 1. 

● Create the diagnostic interrupts by disconnecting the auxiliary voltage of the module or 
removing the front connector. The diagnostics error "USER_DB".ERR_MOD and group 
error "USER_DB".ERR will be 1 and the step number will be -1. 

User program (FB PROG) 
The formulation is as in example program 4 "OneChannel". 

In this example, no special measures are taken for placing after the error remedy. 

Diagnostic interrupt (OB 82) 
In the diagnostic interrupt, depending on the address of the interrupt-triggering module 
(OB82_MDL_ADDR) the error identifier in the associate instance DB (USER_DB) of the user 
program is entered. A response takes place in the cyclic user program. 
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12.12 Example program 6 "SeveralChannels" 

Objective 
This example contains the same user program as example program 4 "OneChannel", but it 
operates 2 channels of the module. The user program uses a separate instance of 
ABS_CTRL and ABS_DIAG for each channel, a multiple instance is not possible. The user 
program expects a channel number as input parameter. The DB numbers for channel and 
diagnostic DBs associated with this channel are stored as constants in the program and can 
by adjusted by you. 

Requirements 
You have assigned the channel 1 parameters as described in "Getting Started". Use Edit > 
Copy channel to copy channel 1 to channel 2. If necessary, adapt the parameters of channel 
2. Save the hardware configuration and download it to the CPU. 

In the channel DB, the address of your module is entered correctly in the MOD_ADDR 
parameter, and the channel number is correctly entered in the CH_NO parameter.  

In the diagnostic DB, the address of your module is entered correctly in the MOD_ADDR 
parameter. 

The supplied channel DBs already include the DB number 30 or 31 of the parameter DB for 
the machine data in the PARADBNO parameter. 

In the data blocks PARADB_1 and PARADB_2 the machine data is stored for in each case 
one channel of your system. 

In HW Config, enable the diagnostic interrupt for this module with Edit > Object Properties > 
Basic Parameters > Interrupt Selection > Diagnostics. Compile the hardware configuration, 
and then download it to the CPU.  

A variable table is set up for each channel.  

Startup 
In the startup OB (OB 100) you set the startup identifier (step 0) for the user program in both 
instance DBs (USER_DB_1, USER_DB_2). 

Operation 
The CPU is in STOP. Open the USER_VAT_1 and USER_VAT_2 and transfer their control 
values.  

Start the CPU (STOP > RUN). You can see how the actual positions of both channels 
change.  
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Error evaluation 
As in example program 5 "DiagnosticsAndInterrupts", however separately for each channel.  

User program (FB PROG) 
Objective and order of events of the user program are as in example program 5 
"DiagnosticsAndInterrupts" and in example program 4 "OneChannel". 

The user program is designed for operation with several channels, as it indirectly accesses 
the module-specific data blocks (channel DBs, diagnostic DB and parameters DBs). The 
channel number specified during call up is used in the user program to select the instance 
DBs. With this type of programming, you cannot use symbolic names for the data in the data 
blocks because of the "Open global data block" instruction used in the user program.  

Diagnostic interrupt (OB 82) 
In the diagnostic interrupt, the error identifier is entered in the associated instance DB of the 
user program according to the address of the interrupt-triggering channel 
(OB82_MDL_ADDR).  
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Technical specifications A
A.1 General technical specifications 

The following technical data are described in the SIMATIC S7-400 Automation System 
S7-400 Module Data Manual 
(http://support.automation.siemens.com/WW/view/en/1117740). 

● Electromagnetic compatibility 

● Transport and storage conditions 

● Mechanical and climatic environmental conditions 

● Specifications for insulation tests, protection class, and degree of protection 

● Standards, certificates, and approvals 

Observe installation guidelines   
SIMATIC products meet the requirements if you follow the installation instructions described 
in the manuals when installing and operating the equipment. 

http://support.automation.siemens.com/WW/view/en/1117740�
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A.2 Technical Specifications of the FM 451 

Technical specifications 
 

Technical specifications 
Dimensions and weight 

Dimensions W x H x D (mm) 50 × 290 × 280 
Weight Approx. 1300 g 

Current, voltage and power 
Current consumption from backplane bus Typ. 550 mA 
Power loss Typ. 12 W 
Auxiliary voltage for the encoder supply Auxiliary voltage: 24 V DC (X1, terminal 3) 

(permissible range: 20.4 to 28.8 V) 
Encoder supply  5 V encoder supply 

– 5.2 V ± 2% 
– Max. 300 mA/axis 
– Short-circuit-proof 

 24 V encoder supply 
– 1L+ -2 V 
– Max. 300 mA/axis 
– Short-circuit-proof 

 Current consumption from 1L+ (without load): 
Max. 100 mA (X1, terminal 3) 

Auxiliary voltage for the load current supply Auxiliary voltage: 24 V DC (X1, terminal 13, 14, 25, 26, 37, 
and 38) 
(permissible range: 20.4 to 28.8 V) 

Power supply of the digital inputs and outputs Current consumption from 2L+ (channel 1), 3L+ (channel 2), 
4L+ (channel 3) (without load): 
Max. 50 mA  
 Insulation test voltage: 500 V DC 

Load voltage polarity reversal protection No 
Encoder inputs 

Position detection  Incremental 
 Absolute 

Signal voltages  Symmetrical inputs: 5 V in accordance with RS 422 
 Asymmetrical inputs: 24 V/ typ. 9 mA 

Input frequency and cable length for symmetrical 
incremental encoder with 5 V supply 

Max. 500 kHz for 32 m shielded cable length 

Input frequency and cable length for symmetrical 
incremental encoder with 24 V supply 

Max. 500 kHz for 100 m shielded cable length 

Input frequency and cable length for asymmetrical 
incremental encoder with 24 V supply 

Max. 50 kHz for 100 m shielded cable length 
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Technical specifications 
Data transmission rate and cable length for absolute 
encoder 

 Max. 125 kHz for 320 m shielded cable length 
 Max. 250 kHz for 160 m shielded cable length 
 Max. 500 kHz for 63 m shielded cable length 
 Max. 1 MHz for 20 m shielded cable length 

Listen mode with absolute encoder No 
Input signals  Incremental: 2 pulse trains, 90° phase shift, 1 zero pulse 

 Absolute: absolute value 

Digital inputs 
Number of digital inputs 12 
Number of simultaneously controllable digital inputs 12 
Galvanic isolation No 
Status display Yes, one green LED per digital input 
Input voltage  0 signal: -30 ... 5 V 

 1 signal: 11 ... 30 V 

Input current  0 signal: 1.5 mA at 2.5 V 
 1 signal: 9 mA at 24 V 

Input delay (1I0, 1I1, 1I2, and 2I0, 2I1, 2I2, and 3I0, 3I1, 3I2)  0 → 1 signal: Typ. 3 ms 
 1 → 0 signal: Typ. 3 ms 

Input delay (1I3, 2I3 and 3I3)  0 → 1 signal: Typ. 300 µs 
 1 → 0 signal: Typ. 300 µs 

Connection of a 2-wire BERO Supported 
Unshielded cable length Max. 50 m at 1I3, 2I3, and 3I3 

Max. 100 m at 1I0, 1I1, 2I0, 2I1, 2I2, 3I0, 3I1, and 3I2 
Shielded cable length Max. 600 m 
Dielectric test VDE 0160 

Digital outputs 
Number of outputs 12 
Galvanic isolation No 
Status display Yes, one green LED per digital output 
Output current  0 signal: 0.5 mA 

 1 signal: 0.5 A  
(permissible range: 5 ... 600 mA) 

 Lamp load: 5 W 

Output delay at output current 0.5 A   0 → 1 signal: Max. 300 µs 
 1 → 0 signal: Max. 300 µs 

Signal level for 1 signal 2L+ - 0.8 V, 3L+ - 0.8 V, 4L+ - 0.8 V 
Control of a digital input Yes 
Control of a count input Yes 
Short-circuit protection Yes, electronic clocking in case of overtemperature 
Limiting of inductive switch-off voltage 2L+ - 39 V, 3L+ - 39 V, 4L+ - 39 V 
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Technical specifications 
Switch rate  Resistive load: Max. 100 Hz 

 Inductive load: Max. 0.5 Hz 

Total current of digital outputs Demand factor 100%: 
At 20 °C and 60 °C: 6 A 

Unshielded cable length Max. 100 m 
Shielded cable length Max. 600 m 
Dielectric test VDE 0160 

 
 

DANGER  
An overload in the output current of the digital outputs can destroy the module. 

Make sure not to exceed 600 mA.  
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Connection diagrams B
B.1 Overview 

Overview  
The following table describes encoders that you can connect to the positioning module. The 
connection diagrams for these encoders are described in this appendix: 

 
In the chapter ... you will find the pin 

assignment for 
Connecting cable Comment 

Connection diagram for 
incremental encoder Siemens 
6FX2001-2 (Up=5 V; RS 422) 

Incremental encoder  
Siemens 
6FX2001-2 

4 x 2 x 0.25 + 2 x 1 mm2 Incremental encoders: 
Up=5 V, RS 422 

Connection diagram for 
incremental encoder Siemens 
6FX2001-2 (Up=24 V; RS 422) 

Incremental encoder  
Siemens 
6FX2001-2 

4 x 2 x 0.5 mm2 Incremental encoders: 
Up=24 V, RS 422 

Connection diagram for 
incremental encoder Siemens 
6FX2001-4 (Up=24 V; HTL) 

Incremental encoder  
Siemens 
6FX2001-4 

4 x 2 x 0.5 mm2 Incremental encoders: 
Up=24 V, HTL 

Connection diagram for  
absolute encoder Siemens 
6FX2001-5 (Up=24 V; SSI) 

Absolute encoder  
Siemens 
6FX2001-5 

4 x 2 x 0.5 mm2 Absolute encoder: 
Up=24 V, SSI 
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B.2 Connection diagram for incremental encoder Siemens 6FX 2001-2 
(Up=5V; RS 422) 

Connection diagram 
The following figure shows the connection diagram for the incremental encoder Siemens 
6FX 2001-2 (Up=5 V: RS 422): 

 
Connection diagram 

 

      

12-pin circular connector Socket 
Siemens 6FX2003-0SU12 
Connection side (solder side) 

 

     

 
(1) Twisted-pair cables 
 
* Pins 10 and 11 are internally bridged. 
** Pins 2 and 12 are internally bridged. 

 

      

  
15-pin sub D connector, connection side 
(solder side) metallized housing with screw 
interlock 6FC9341-1HC 
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B.3 Connection diagram for incremental encoder Siemens 6FX 2001-2 
(Up=24V; RS 422) 

Connection diagram 
The following figure shows the connection diagram for an incremental encoder Siemens 
6FX2001-2 (Up=24 V; RS 422): 

 
Connection diagram 

 

      

Circular connector 12-pin socket 
Siemens 6FX2003-0SU12 
Connection side (solder side) 

 

     

 
(1) Twisted-pair cables 
 
* Pins 10 and 11 are internally bridged. 
** Pins 2 and 12 are internally bridged. 

 

      

  
 15-pin sub D connector, connection side 
(solder side) metallized housing with screw 
interlock 6FC9341-1HC 



Connection diagrams  
B.4 Wiring diagram of the incremental encoder Siemens 6FX 2001-4 (Up = 24 V; HTL) 

 FM 451 positioning module 
184 Operating Instructions, 05/2011, A5E01092713-02 

B.4 Wiring diagram of the incremental encoder Siemens 6FX 2001-4 
(Up = 24 V; HTL) 

Connection diagram 
The following figure shows the connection diagram for an incremental encoder Siemens 
6FX2001-4 (Up=24 V; HTL): 

 
Connection diagram 

 

      

Circular connector 12-pin socket 
Siemens 6FX2003-0SU12 
Connection side (solder side) 

 

     

  
* Pins 10 and 11 are internally bridged. 
** Pins 2 and 12 are internally bridged. 

 

      

  
15-pin sub D connector, connection side 
(solder side) metallized housing with screw 
interlock 6FC9341-1HC 

 
 

 Note 

To connect a non-SIEMENS incremental encoder in a push-pull configuration (current 
sourcing/sinking), observe the following: 
 Current sourcing: Connect RE (9) to ground (7). 
 Current sinking: Connect RE (9) to +24 V (5). 
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B.5 Connection diagram for absolute encoder Siemens 6FX 2001-5 
(Up=24V; SSI) 

Connection diagram 
The following figure shows the connection diagram for an absolute encoder Siemens 
6FX2001-5 (Up=24 V; SSI): 

 
Connection diagram 

 

      

Circular connector 12-pin socket 
Siemens 6FX2003-0SU12 
Connection side (solder side) 

 

     

 
(1) Twisted-pair cables 

 

      

  
15-pin sub D connector, connection side 
(solder side) metallized housing with screw 
interlock 6FC9341-1HC 
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Data blocks and error lists C
C.1 Content of the channel DB 

Data of channel DB   
 

 Note 

Do not modify any data not listed in this table. 
 

 

Table C- 1 Content of the channel DB 

Address Name Type Initial value Comment 
Addresses  
0.0 MOD_ADDR INT 0 Module address 
2.0 CH_NO INT 1 Channel number 
10.0 PARADBNO INT -1 Number of the parameter DB 
Control signals  
14.3 OT_ERR_A BOOL FALSE 1 = Acknowledge operator error 
15.0 START BOOL FALSE 1 = Start positioning  
15.1 STOP BOOL FALSE 1 = Stop active traversing 
15.2 DIR_M BOOL FALSE 1 = Minus direction 
15.3 DIR_P BOOL FALSE 1 = Plus direction 
15.6 SPEED252 BOOL FALSE Start velocity for incremental approach with increment 

number 252: 
0 = Creep speed 
1 = Rapid traverse 

15.7 DRV_EN BOOL FALSE 1 = Switch on drive enable 
16.0 MODE_IN BYTE B#16#0 Required operating mode 

0 = No operating mode 
1 = Jog 
3 = Reference point approach 
4 = Relative incremental approach 
5 = Absolute incremental approach 

17.0 MODE_TYPE BYTE B#16#0  Start velocity for jog mode 

0 = Creep speed 

1 = Rapid traverse 
 Increment number for the incremental approach mode 



Data blocks and error lists  
C.1 Content of the channel DB 

 FM 451 positioning module 
188 Operating Instructions, 05/2011, A5E01092713-02 

Address Name Type Initial value Comment 
Checkback signals  
22.2 DIAG BOOL FALSE 1 = Diagnostic buffer changed 
22.3 OT_ERR BOOL FALSE 1 = Operator error occurred 
22.4 DATA_ERR BOOL FALSE 1 = Data error 
22.7 PARA BOOL FALSE 1 = Axis parameters assigned 
23.0 ST_ENBLD BOOL FALSE 1 = Start enabled 
23.1 WORKING BOOL FALSE 1 = Positioning running (processing running) 
23.2 WAIT_EI BOOL FALSE 1 = Axis waiting for external enable 
23.4 SPEED_OUT BOOL FALSE 0 = Creep speed 

1 = Rapid traverse 
23.5 ZSPEED BOOL FALSE 1 = Axis is located in the standstill range 
23.6 CUTOFF BOOL FALSE 1 = Axis is located in the switch-off range 
23.7 CHGOVER BOOL FALSE 1 = Axis is located in the changeover range 
24.0 MODE_OUT BYTE B#16#0 Active operating mode  
25.0 SYNC BOOL FALSE 1 = Axis is synchronized 
25.1 MSR_DONE BOOL FALSE 1 = Length measurement/edge detection completed 
25.2 GO_M BOOL FALSE 1 = Axis moves in minus direction 
25.3 GO_P BOOL FALSE 1 = Axis moves in plus direction 
25.5 FVAL_DONE BOOL FALSE 1 = Set actual value on-the-fly completed 
25.7 POS_RCD BOOL FALSE 1 = Position reached 
26.0 ACT_POS DINT L#0 Current actual value (current position of axis) 
Function switches  
34.0 PLOOP_ON BOOL FALSE 1 = Loop approach in plus direction 
34.1 MLOOP_ON BOOL FALSE 1 = Loop approach in minus direction 
34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input 
34.3 EDGE_ON BOOL FALSE 1 = Edge detection ON 
34.4 MSR_ON BOOL FALSE 1 = Length measurement ON 
Trigger bits for write jobs   
35.0 MDWR_EN BOOL FALSE 1 = Write machine data  
35.1 MD_EN BOOL FALSE 1 = Enable machine data 
35.2 DELDIST_EN BOOL FALSE 1 = Delete distance-to-go 
35.3 AVALREM_EN BOOL FALSE 1 = Cancel set actual value 
35.4 TRGL1WR_EN BOOL FALSE 1 = Write increment table 1 (increment number 1...50) 
35.5 TRGL2WR_EN BOOL FALSE 1 = Write increment table 2 (increment number 51...100) 
35.6 REFPT_EN BOOL FALSE 1 = Set reference point 
35.7 AVAL_EN BOOL FALSE 1 = Set actual value 
36.0 FVAL_EN BOOL FALSE 1 = Set actual value on-the-fly 
36.1 ZOFF_EN BOOL FALSE 1 = Set zero offset 
36.2 TRG252_254_EN BOOL FALSE 1 = Write increment for increment number 252 or 254 
36.3 TRG255_EN BOOL FALSE 1 = Write increment for increment number 255 
36.4 DELDIAG_EN BOOL FALSE 1 = Clear diagnostic buffer 
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Address Name Type Initial value Comment 
Trigger bits for read jobs   
36.5 MDRD_EN BOOL FALSE 1 = Read machine data 
36.6 TRGL1RD_EN BOOL FALSE 1 = Read increment table 1 (increment number 1...50) 
36.7 TRGL2RD_EN BOOL FALSE 1 = Read increment table 2 (increment number 51...100) 
37.0 MSRRD_EN BOOL FALSE 1 = Read measured values 
37.1 ACTSPD_EN BOOL FALSE 1 = Read actual velocity, distance-to-go, and current 

increment 
37.2 ENCVAL_EN BOOL FALSE 1 = Read encoder values 
Done bits for function switches   
38.0 PLOOP_D BOOL FALSE 1 = "Loop approach in plus direction" job completed 
38.1 MLOOP_D BOOL FALSE 1 = "Loop approach in minus direction" job completed 
38.2 EI_D BOOL FALSE 1 = "Do not evaluate enable input" job completed 
38.3 EDGE_D BOOL FALSE 1 = "Edge detection ON" job completed 
38.4 MSR_D BOOL FALSE 1 = "Length measurement ON" job completed 
Done bits for write jobs   
39.0 MDWR_D BOOL FALSE 1 = "Write machine data" job completed 
39.1 MD_D BOOL FALSE 1 = "Activate machine data" job completed 
39.2 DELDIST_D BOOL FALSE 1 = "Delete distance-to-go" job completed 
39.3 AVALREM_D BOOL FALSE 1 = "Cancel set actual value" job completed 
39.4 TRGL1WR_D BOOL FALSE 1 = "Write increment table 1" job completed 
39.5 TRGL2WR_D BOOL FALSE 1 = "Write increment table 2" job completed 
39.6 REFPT_D BOOL FALSE 1 = "Set reference point" job completed 
39.7 AVAL_D BOOL FALSE 1 = "Set actual value" job completed 
40.0 FVAL_D BOOL FALSE 1 = "Set actual value on-the-fly" job completed 
40.1 ZOFF_D BOOL FALSE 1 = "Set zero offset" job completed 
40.2 TRG252_254_D BOOL FALSE 1 = "Write increment for increment number 252 or 254" job 

completed 
40.3 TRG255_D BOOL FALSE 1 = "Write increment for increment number 255" job 

completed 
40.4 DELDIAG_D BOOL FALSE 1 = "Clear diagnostic buffer" job completed 
Done bits for read jobs   
40.5 MDRD_D BOOL FALSE 1 = "Read machine data" job completed 
40.6 TRGL1RD_D BOOL FALSE 1 = "Read increment table 1" job completed 
40.7 TRGL2RD_D BOOL FALSE 1 = "Read increment table 2" job completed 
41.0 MSRRD_D BOOL FALSE 1 = "Read measured values" job completed 
41.1 ACTSPD_D BOOL FALSE 1 = "Read actual velocity, distance-to-go, and current 

increment" job completed 
41.2 ENCVAL_D BOOL FALSE 1 = "Read encoder values" job completed 
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Address Name Type Initial value Comment 
Error bits for function switches   
42.0 PLOOP_ERR BOOL FALSE 1 = Error in "Loop approach in plus direction" job 
42.1 MLOOP_ERR BOOL FALSE 1 = Error in "Loop approach in minus direction" job 
42.2 EI_ERR BOOL FALSE 1 = Error in "Do not evaluate enable input" job 
42.3 EDGE_ERR BOOL FALSE 1 = Error in "Edge detection ON" job 
42.4 MSR_ERR BOOL FALSE 1 = Error in "Length measurement ON" job 
Error bits for write jobs   
43.0 MDWR_ERR BOOL FALSE 1 = Error in "Write machine data" job 
43.1 MD_ERR BOOL FALSE 1 = Error in "Activate machine data" job 
43.2 DELDIST_ERR BOOL FALSE 1 = Error in "Delete distance-to-go" job 
43.3 AVALREM_ERR BOOL FALSE 1 = Error in "Cancel set actual value" job 
43.4 TRGL1WR_ERR BOOL FALSE 1 = Error in "Write increment table 1" job 
43.5 TRGL2WR_ERR BOOL FALSE 1 = Error in "Write increment table 2" job 
43.6 REFPT_ERR BOOL FALSE 1 = Error in "Set reference point" job 
43.7 AVAL_ERR BOOL FALSE 1 = Error in "Set actual value" job 
44.0 FVAL_ERR BOOL FALSE 1 = Error in "Set actual value on-the-fly" job 
44.1 ZOFF_ERR BOOL FALSE 1 = Error in "Set zero offset" job 
44.2 TRG252_254_ERR BOOL FALSE 1 = Error in "Write increment for increment number 252 or 

254" job 
44.3 TRG255_ERR BOOL FALSE 1 = Error in "Write increment for increment number 255" job 
44.4 DELDIAG_ERR BOOL FALSE 1 = Error in "Clear diagnostic buffer" job 
Error bits for read jobs   
44.5 MDRD_ERR BOOL FALSE 1 = Error in "Read machine data" job 
44.6 TRGL1RD_ERR BOOL FALSE 1 = Error in "Read increment table 1" job 
44.7 TRGL2RD_ERR BOOL FALSE 1 = Error in "Read increment table 2" job 
45.0 MSRRD_ERR BOOL FALSE 1 = Error in "Read measured values" job 
45.1 ACTSPD_ERR BOOL FALSE 1 = Error in "Read actual velocity, distance-to-go, and 

current increment" job 
45.2 ENCVAL_ERR BOOL FALSE 1 = Error in "Read current encoder values" job 
Job management for FC ABS_CTRL   
48.0 JOB_ERR INT 0 Error number of communication error 
50.0 JOBBUSY BOOL FALSE 1 = At least one job is busy  
50.1 JOBRESET BOOL FALSE 1 = Reset all error bits and done bits 
Data element for "Zero offset" job (FM 451)    
80.0 ZOFF DINT L#0 Zero offset 
Data element for "Set actual value" job   
84.0 AVAL DINT L#0 Coordinate for "Set actual value" 
Data element for "Set actual value on-the-fly" job (FM 451)    
88.0 FVAL DINT L#0 Coordinate for "Set actual value on-the-fly" 
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Address Name Type Initial value Comment 
Data element for "Set reference point" job   
92.0 REFPT DINT L#0 Coordinate for "Set reference point" 
Data element for "Write increment for increment number 252 or 254" job     
96.0 TRG252_254 DINT L#0 Write increment for increment number 252 or 254  
Data for "Write increment for increment number 255" job   
100.0 TRG255 DINT L#0 Increment for increment number 255  
104.0 CHGDIF255 DINT L#0 Changeover difference for increment number 255 
108.0 CUTDIF255 DINT L#0 Switch-off difference for increment number 255 
Data for "Read position data" job   
112.0 ACTSPD DINT L#0 Current velocity 
116.0 DIST_TO_GO DINT L#0 Distance-to-go 
120.0 ACT_TRG DINT L#0 Current increment 
Data for "Read encoder data" job   
124.0 ENCVAL DINT L#0 Actual encoder value (internal representation) 
128.0 ZEROVAL DINT L#0 Last zero mark value (internal representation) 
132.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 
Data for "Length measurement/edge detection" job (FM 451)    
136.0 BEG_VAL DINT L#0 Start value of length measurement/edge detection 
140.0 END_VAL DINT L#0 End value of length measurement/edge detection 
144.0 LEN_VAL DINT L#0 Length 
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C.2 Content of the parameter DB 

Data of parameter DB    
 

 Note 

Do not modify any data not listed in this table. 
 

 

Table C- 2 Content of the parameter DB 

Address Name Type Initial value Comment 
Machine data   
4.0 EDGEDIST DINT L#0 Minimum edge distance 
8.0 UNITS DINT L#1 System of units 
12.0 AXIS_TYPE DINT L#0 0 = Linear axis 

1 = Rotary axis 
16.0 ENDROTAX DINT L#100000 End of rotary axis 
20.0 ENC_TYPE DINT L#1 Encoder type, message frame length 
24.0 DISP_REV DINT L#80000 Distance per encoder revolution 
32.0 INC_REV DINT L#500 Increments per encoder revolution 
36.0 NO_REV DINT L#1 Number of encoder revolutions 
40.0 BAUDRATE DINT L#0 Baud rate 
44.0 REFPT DINT L#0 Reference point coordinate 
48.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 
52.0 REFPT_TYPE DINT L#0 Type of reference point approach 
59.0 CNT_DIR BOOL FALSE Count direction: 

0 = Normal 
1 = Inverted 

63.0 MON_WIRE BOOL TRUE 1 = Wire break monitoring 
63.1 MON_FRAME BOOL TRUE 1 = Message frame error monitoring 
63.2 MON_PULSE BOOL TRUE 1 = Missing pulses monitoring 
64.0 SSW_STRT DINT L#-100000000 Software limit switch start 
68.0 SSW_END DINT L#100000000 Software limit switch end 
76.0 TRG_RANGE DINT L#1000 Target range 
80.0 MON_TIME DINT L#2000 Monitoring time [ms] 
84.0 ZSPEED_R DINT L#1000 Standstill range 
88.0 ZSPEED_L DINT L#30000 Upper limit of standstill velocity 
92.0 CTRL_TYPE DINT L#1 Control mode (1 - 4) 
99.0 REFPT_SPD BOOL TRUE Start velocity for reference point approach: 

0 = Rapid traverse 
1 = Creep speed 
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Address Name Type Initial value Comment 
Machine data   
99.1 EI_TYPE BOOL FALSE Enable input: 

0 = Level-controlled 
1 = Edge-controlled 

100.0 CHGDIF_P DINT L#5000 Changeover difference plus 
104.0 CHGDIF_M DINT L#5000 Changeover difference minus 
108.0 CUTDIF_P DINT L#2000 Switch-off difference plus 
112.0 CUTDIF_M DINT L#2000 Switch-off difference minus 
Increment table 1   
120.0 TRGL1.TRG[1] DINT L#0 Increment number 1 
. 
  
.  

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 
316.0 TRGL1.TRG[50] DINT L#0 Increment number 50 

 
 
Increment table 1 
  

Increment table 2   
320.0 TRGL2.TRG[51] DINT L#0 Increment number 51 
. 
  
. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 
516.0 TRGL2.TRG[100] DINT L#0 Increment number 100 

 
 
Increment table 2 
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C.3 Data and structure of the diagnostic DB 

Data and structure of the diagnostic DB 
 

 

 Note 

You must not change any data that is not listed in this table. 
 

 

Table C- 3 Structure of the diagnostic DB 

Address Name Type Initial value Comment 
0.0 MOD_ADDR  INT 0 Module address 
256.0 JOB_ERR INT 0 Error number of the communication error 
258.0 JOBBUSY BOOL FALSE 1 = job active 
258.1 DIAGRD_EN BOOL FALSE 1 = definitely read diagnostics buffer 
260.0 DIAG_CNT INT 0 Number of valid entries in the list 
262.0 DIAG[1] STRUCT  Diagnostics data - latest entry 
272.0 DIAG[2] STRUCT  Diagnostics data - second entry 
282.0 DIAG[3] STRUCT  Diagnostics data - third entry 
292.0 DIAG[4] STRUCT  Diagnostics data - fourth entry 
302.0 DIAG[5] STRUCT  Diagnostics data - fifth entry 
312.0 DIAG[6] STRUCT  Diagnostics data - sixth entry 
322.0 DIAG[7] STRUCT  Diagnostics data - seventh entry 
332.0 DIAG[8] STRUCT  Diagnostics data - eighth entry 
342.0 DIAG[9] STRUCT  Diagnostics data - ninth entry 
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The structure of the diagnostics entry DIAG[n] is developed as follows: 

Table C- 4 Structure of the diagnostics entry 

Address Name Type Initial value Comment 
+0.0 STATE BOOL FALSE 0 = incoming event 

1 = outgoing event 
+0.1 INTF BOOL FALSE 1 = internal error 
+0.2 EXTF BOOL FALSE 1 = external error 
+2.0 FCL INT 0 Error class: 

1: Operating error 
2: Operating errors 
4: Data error 
5: Machine data error 
6: Increment table error 
15: Messages 
128: Diagnostics errors 

+4.0 FNO INT 0 Error number 
+6.0 CH_NO INT 0 Channel number  
+8.0 TRG_NO INT 0 Increment number 
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C.4 List of JOB_ERR messages 

JOB_ERR messages 
 
JOB_ERR 
(Hex) 

JOB_ERR 
(Dez) 

JOB_ERR 
(Int) 

Meaning 

80A0 32928 -32608 Negative acknowledgement when reading from the module. The module 
has been removed during the read operation - or the module is faulty. 

80A1 32929 -32607 Negative acknowledge when writing to the module. The module has been 
removed during the write operation - or the module is faulty. 

80A2 32930 -32606 DP protocol error with layer 2 
80A3 32931 -32605 DP protocol error with user interface / user 
80A4 32932 -32604 Communication on C bus interrupted 
80B0 32944 -32592 Data record / job unknown. 
80B1 32945 -32591 Incorrect length specification. Parameter FM_TYPE in the channel DB is 

not correctly set for the module being used. 
80B2 32946 -32590 The configured slot is not assigned. 
80B3 32947 -32589 Actual module type dissimilar to the set module type. 
80C0 32960 -32576 The module does not yet have ready the data to be read. 
80C1 32961 -32575 The data of a same-named write job is not yet ready on the module. 
80C2 32962 -32574 The module is currently processing the possible maximum of jobs. 
80C3 32963 -32573 Required equipment (memory etc.) is currently in use. 
80C4 32964 -32572 Communication error 
80C5 32965 -32571 Distributed I/O unavailable. 
80C6 32966 -32570 Priority class cancellation (restart or background) 
8522 34082 -31454 Channel DB or parameter DB too short. The data cannot be read from the 

DB. (write job) 
8532 34098 -31438 The DB number of the parameter is too large. (write job) 
853A 34106 -31430 Parameter DB does not exist. (write job) 
8544 34116 -31420 Error with the n-th (n > 1) read access on a DB after an error has occurred. 

(write job) 
8723 34595 -30941 Channel DB or parameter DB too short. The data cannot be written in the 

DB. (read job) 
8730 34608 -30928 Parameter DB in the CPU is write-protected. The data cannot be written in 

the DB (read job). 
8732 34610 -30926 The DB number of the parameter is too large. (read job) 
873A 34618 -30918 Parameter DB does not exist. (read job) 
8745 34629 -30907 Error with the n-th (n > 1) write access on a DB after an error has occurred. 

(read job) 
The errors 80A2..80A4 as well as 80Cx are temporary, i.e. they can be remedied after a waiting time without you having to 
do anything. 
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C.5 Error classes 

Error classes   
Class 1: Operating error   

Operating errors are detected asynchronously to an operator input/control. Operating errors 
cause the positioning to be canceled, except in the case of error number 9. Error number 9 
causes the positioning to be shut down. 

 
No. Meaning Diagnostic 

interrupt 
Software limit switch start overrun 1 
Cause The actual value is outside the operating range 

Yes 

Software limit switch end overrun 2 
Cause The actual value is outside the operating range 

Yes 

Traversing range start overrun 3 
Cause Traversing range limit overrun (coordinates of the 

traversing range limits also belong to the traversing range) 

Yes 

Traversing range end overrun 4 
Cause Traversing range limit overrun (coordinates of the 

traversing range limits also belong to the traversing range) 

Yes 

Error during target approach 5 
Cause Target range was not reached within the monitoring time 

Yes 

Standstill range exited 6 
Cause The actual value is outside the standstill range 

Yes 

Positive feedback 7 
Cause Actual value change > 1/2 standstill range in the wrong 

direction 

Yes 

Missing actual value change or actual value change is too small 8 
Cause No actual value change or an actual value change 

opposite the desired direction within the monitoring time 

Yes 

Target overrun (FM 451) 9 
Cause The target was overrun during "Set actual value on-the-fly" 

Yes 

Target range overrun 10 
Cause Target range was overrun after target approach 

Yes 

Changeover point switched incorrectly 11 
Cause Axis is oscillating in the changeover point. 

Yes 

Switch-off point switched incorrectly 12 
Cause Axis is oscillating in the switch-off point/reversal point 

Yes 

Target range start switched incorrectly 13 
Cause Axis is oscillating in the target range 

Yes 
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No. Meaning Diagnostic 
interrupt 

Change greater than half the rotary axis range 14 
Cause The velocity/frequency is too high or there are faulty actual 

value jumps 

Yes 

Change greater than the rotary axis range 15 
Cause The velocity/frequency is too high or there are faulty actual 

value jumps 

Yes 

Increment for increment number 252 not transferred (FM 451) 16 
Cause The increment was not transferred 

Yes 

Increment for increment number 252 cannot be approached (FM 451) 17 
Cause The distance between the current actual position and the 

specified increment is less than the changeover difference 
or switch-off difference 

Yes 

Incorrect increment for increment number 252 (FM 451) 18 
Cause The increment is outside the operating range 

Yes 

 

Class 2: Operator errors   

Operator errors are detected when control signals in the user data area are changed. The 
operator errors cause the positioning to shut down. 

 
No. Meaning Diagnostic 

interrupt 
Impermissible operating mode  1 
Cause The selected operating mode is not permissible 

No 

Impermissible interface job 3 
Cause The selected signal is not permitted with this operating 

mode 

No 

Incorrect operating mode parameter 4 
Cause  In "jog" mode the velocity specification is not equal to 

the rapid traverse or creep speed 
 In "incremental approach" mode, the increment is a 

value other than 1 - 100, 252, 254, or 255 

No 

Start enable not found 5 
Cause Start enable for starting not found 

No 

Target/target range is outside the operating range 7 
Cause Specified or calculated target is outside the software limit 

switches 

No 

Axis parameters not assigned 8 
Cause Incorrect machine data or no machine data were assigned 

for the axis 

No 
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No. Meaning Diagnostic 
interrupt 

Axis not synchronized 9 
Cause The "incremental approach" mode is possible only with an 

already synchronized axis 

No 

Target/distance increment cannot be positioned 10 
Cause The distance between the current actual position and the 

specified target is less than the switch-off difference 

No 

Reference point approach not possible 17 
Cause An SSI encoder was connected 

No 

Relative or absolute incremental approach not possible 18 
Cause The increment is invalid. 

No 

Switch-off difference is less than 1/2 the target range with increment 
number 255 

19 

Cause The switch-off difference for increment 255 is less than half 
the target range 

No 

Traversing in specified direction not allowed 20 
Cause The distance to the software limit switch is insufficient 

No 

 

Class 4: Data error   

Data errors are detected synchronously to an operator input/control. Data errors do not result 
in an error response. 

 
No. Meaning Diagnostic 

interrupt 
Specified increment too large 6 
Cause The value is outside ±100 m or ±1000 m. The distance 

increment/target must not be greater than the traversing 
range. 
For a rotary axis, the coordinate must be ≥0 and less than 
the end of rotary axis. 

No 

Zero offset error  10 
Cause The zero offset is greater than ±100 m or ±1000 m.  

The software limit switches are outside the traversing 
range (-100 m to +100 m or -1000 m to +1000 m)  
after setting the zero offset. 
Rotary axis: The absolute value of the zero offset is greater 
than the end of rotary axis. 

No 

Faulty actual value specification 11 
Cause Linear axis: The coordinate lies outside the current 

(possibly offset) software limit switches. 
Rotary axis: The coordinate is < 0 or greater than the end 
of the rotary axis. 

No 
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No. Meaning Diagnostic 
interrupt 

Reference point error 12 
Cause Linear axis: The coordinate lies outside the current 

(possibly offset) software limit switches. 
Rotary axis: The coordinate is < 0 or greater than the end 
of the rotary axis. 

No 

Enable machine data not permitted 20 
Cause There are no new (error-free) machine data on the module. 

No 

Illegal bit-coded setting 27 
Cause Unused and, in this case, unwritten bits are not 0. 

No 

Illegal bit coding 29 
Cause Unused and, in this case, unwritten bits are not 0. 

No 

Cancel set actual value not possible 34 
Cause With an SSI encoder and a linear axis, the actual position 

value would be outside the operating range after making 
the setting. 

No 

Changeover difference error with increment number 255 36 
Cause The value is outside the permitted numeric range of 

±100 m or ±1000 m. 
For a rotary axis, the coordinate must be ≥0 and less than 
the end of rotary axis. 

No 

Switch-off difference error with increment number 255 37 
Cause The value is outside the permitted numeric range of 

±100 m or ±1000 m. 
The switch-off difference must be less than the changeover 
difference. 

No 

Axis parameters not assigned 107 
Cause The axis has no machine data or the machine data are not 

activated. 

No 

Axis not synchronized 108 
Cause A "set actual value" or "set actual value on-the-fly" job was 

initiated although the axis is not synchronized. 

No 
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Class 5: Machine data error   

The diagnostic interrupt is only triggered if an error is detected in the system data block 
(SDB). Machine data errors do not result in an error response. 

 
No. Meaning Diagnostic 

interrupt 
Error in hardware interrupt setting 5 
Cause You have attempted to select a hardware interrupt that the 

module does not support 

Yes 

Incorrect minimum edge distance (FM 451) 6 
Cause You have entered a value < 0 or > 109 µm as the minimum 

edge distance 

Yes 

Incorrect system of units 7 
Cause The value for the system of units is outside the permitted 

range of 1 to 4 and 6 

Yes 

Incorrect axis type 8 
Cause You have specified neither 0 nor 1 as the axis type 

Yes 

Incorrect end of rotary axis 9 
Cause The value for the end of rotary axis is outside the permitted 

range of 1 to 109 µm or 1 to 108 µm (depending on the 
resolution) 

Yes 

Incorrect encoder type 10 
Cause The value for the encoder type is outside the permitted 

range of 1 to 4 

Yes 

Incorrect distance per encoder revolution 11 
Cause The value for distance per encoder revolution is outside the 

permitted range of 1 to 109 µm (regardless of the 
resolution) 

Yes 

13 Incorrect number of increments per encoder revolution  
(see chapter "Machine data of the encoder (Page 79)") 

Yes 

14 Incorrect number of revolutions  
(see chapter "Machine data of the encoder (Page 79)") 

Yes 

Incorrect baud rate 15 
Cause You have specified a baud rate value outside the permitted 

range of 0 to 3 

Yes 

Incorrect reference point coordinate 16 
Cause The coordinate is outside the range of -100 m to +100 m or 

-1000 m to +1000 m (depending on the resolution). 
Linear axis: The coordinate is outside the operating range.  
Rotary axis: The coordinate is greater than the end of 
rotary axis or < 0. 

Yes 

Incorrect absolute value adjustment 17 
Cause SSI encoder: The value of the absolute encoder 

adjustment is not in the encoder range (increments per 
encoder revolution x number of revolutions - 1). 

Yes 
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No. Meaning Diagnostic 
interrupt 

Incorrect type of reference point approach 18 
Cause You have specified a value other than 0, 1, 2, and 3 

Yes 

Incorrect count direction 19 
Cause You have specified a value other than 0 and 1 

Yes 

Hardware monitoring not possible 20 
Cause You have set message frame error monitoring to "FALSE" 

in the parameter DB 
The monitoring of missing pulses is not possible with the 
encoder used. Disable the MON_PULSE parameter. 

Yes 

Incorrect software limit switch start 21 
Cause Linear axis: The software limit switch start is outside the 

traversing range (-100 m to +100 m or -1000 m to 
+1000 m, depending on the resolution). 
Linear axis: The software limit switch start (including any 
existing zero offset) is less than -100 m or -1000 m 
(depending on the resolution). 

Yes 

Incorrect software limit switch end 22 
Cause Linear axis: The software limit switch end is outside the 

traversing range (-100 m to +100 m or -1000 m to 
+1000 m, depending on the resolution) or is less than the 
software limit switch start. 
Linear axis: The software limit switch end (including any 
existing zero offset) is greater than +100 m or +1000 m 
(depending on the resolution). 

Yes 

Incorrect maximum velocity 23 
Cause The data that are not listed in the parameter DB must be 0. 

Yes 

Incorrect target range  24 
Cause Linear axis: Range between 0 to 100 m or 1000 m, 

depending on the resolution. 
Rotary axis: Range greater than the end of rotary axis. 

Yes 

Incorrect monitoring time 25 
Cause The value for the monitoring time is outside the permitted 

range of 0 to 100 000 ms 

Yes 

Incorrect standstill range 26 
Cause Linear axis: Range between 0 to 100 m or 1000 m, 

depending on the resolution. 
Rotary axis: Range greater than the end of rotary axis. 

Yes 

Incorrect standstill velocity 127 
Cause The value for the standstill velocity is outside the permitted 

range of 0 to 100 000 µm/min 

Yes 

Incorrect control mode 128 
Cause You have specified a control mode value outside the 

permitted range of 1 to 4 

Yes 

Incorrect start velocity for the reference point approach 129 
Cause You have specified neither 0 nor 1 as the start velocity 

Yes 
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No. Meaning Diagnostic 
interrupt 

Incorrect changeover difference in plus direction 130 
Cause Linear axis: Range between 0 to 100 m or 1000 m 

(depending on the resolution). 
Rotary axis: Range greater than the end of rotary axis and 
less than 1/2 the target range. 

Yes 

Incorrect changeover difference in minus direction 131 
Cause Linear axis: Range between 0 to 100 m or 1000 m 

(depending on the resolution). 
Rotary axis: Range greater than the end of rotary axis and 
less than 1/2 the target range. 

Yes 

Incorrect switch-off difference in plus direction 132 
Cause The switch-off difference is greater than the plus 

changeover difference, less than 1/2 target range, or is 
outside the permissible range between 0 to 100 m or 0 to 
1000 m (depending on resolution). 

Yes 

Incorrect switch-off difference in minus direction 133 
Cause The switch-off difference is greater than the minus 

changeover difference, less than 1/2 target range, or is 
outside the permissible range between 0 to 100 m or 0 to 
1000 m (depending on resolution). 

Yes 

Incorrect resolution 200 
Cause You have specified a resolution < 0.1 µm/pulse or 

>1000 µm/pulse. 
You have specified a distance per encoder revolution and a 
number of pulses per encoder revolution, that results in a 
resolution of < 0.1 or > 1000. 

Yes 

Encoder does not match the operating range/rotary axis range 201 
Cause SSI encoder and rotary axis: The encoder does not cover 

the exact rotary axis range. 
Linear axis: The encoder does not cover at least the 
operating range (including software limit switches). 

Yes 
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Class 6: Increment table error   

The increment table errors do not result in an error response. 

 
No. Meaning Diagnostic 

interrupt 
Specified increment in the increment table is too large 6 
Cause The value is outside ±100 m or ±1000 m. The distance 

increment/target must not be greater than the traversing 
range. 
For a rotary axis, the coordinate must be ≥0 and less than 
the end of rotary axis. 

No 

 

Class 15: Messages   

Messages do not result in an error response. 

 
No. Meaning Diagnostic 

interrupt 
Start of parameter assignment 1 
Cause The module has detected a parameter assignment via a 

system data block 

No 

End of parameter assignment 2 
Cause The module has processed the parameter assignment via 

a system data block error-free 

No 

Distance to changeover point too short 11 
Cause The hardware response times cannot be adhered to 

because the distance between the switching points is too 
short 

No 

Distance to reversal point too short 12 
Cause The hardware response times cannot be adhered to 

because the distance between the switching points is too 
short 

No 

Distance to switch-off point too short 14 
Cause The hardware response times cannot be adhered to 

because the distance between the switching points is too 
short 

No 

Distance to target range start too short 15 
Cause The hardware response times cannot be adhered to 

because the distance between the switching points is too 
short 

No 
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Class 128: Diagnostic errors   

 
No. Meaning Diagnostic 

interrupt 
External auxiliary voltage missing 
Cause  External auxiliary 24 V voltage is not connected or has 

failed 
 Fuse on the module is defective 
 Undervoltage 
 Ground wire break 
 Short circuit (e.g., at the connected encoder) 

Effect  The positioning is canceled on all channels 
 Outputs are switched off 
 Cancelation of synchronization for incremental 

encoders if the auxiliary voltage for the encoder supply 
is missing 

 The FM 451 parameters are not assigned 
 The start enable is cleared 

4 

Remedy Make sure that the 24 V connection is correct (If the 24 V 
connection is correct, then the module is defective) 

Yes 

Front connector missing (FM 451) 
Cause Front connector of the positioning module is not inserted 
Effect  Missing external auxiliary 24 V voltage 

 Module is not ready for operation 

5 

Remedy Insert the front connector onto the positioning module 

Yes 

Watchdog timer responded 
Cause  Strong interference on the FM 451 

 Error in the FM 451 

Effect  Module is reset 
 All outputs are switched off 
 Provided that after resetting the module no module 

defect is detected, the module is ready for operation 
again 

 The module signals the expired WATCHDOG with 
"incoming" and "outgoing" 

51 

Remedy  Eliminate the interference 
 Contact the relevant sales department who will require 

details of the circumstances leading to the error 
 Replace the FM 451 

Yes 
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No. Meaning Diagnostic 
interrupt 

Encoder wire break 
Cause  Encoder cable cut or not plugged in 

 Encoder has no transverse signals 
 Incorrect pin assignment 
 Cable length too long 
 Encoder signals short-circuited 
 Edge error of encoder signals 
 Maximum input frequency of encoder input exceeded 
 Encoder supply failure 

Effect  The positioning is canceled 
 Outputs are switched off 
 With incremental encoders, synchronization is canceled 
 The start enable is cleared 

144 

Remedy  Check the encoder cable 
 Comply with the encoder specifications 
 Monitoring can be temporarily disabled using the 

parameter assignment dialog, but at the responsibility 
of the operator 

 Comply with the technical specifications of the module 

Yes 

Absolute encoder error 
Cause The message frame traffic between the FM 451 and the 

absolute encoder (SSI) is incorrect or interrupted: 
 Encoder cable cut or not plugged in 
 Incorrect encoder type 
 Encoder incorrectly set (programmable encoders) 
 Message frame length incorrectly specified 
 Encoder returns incorrect values (encoder defective) 
 Interference injection on measuring system cable 
 Selected baud rate is too high 
 Monoflop time of encoder greater than 64 µs 

Effect  The positioning is canceled 
 Outputs are switched off 
 The start enable is cleared 

145 

Remedy  Check the encoder cable 
 Check the encoder 
 Check the message frame traffic between the encoder 

and FM 451 

Yes 



 Data blocks and error lists 
 C.5 Error classes 

FM 451 positioning module 
Operating Instructions, 05/2011, A5E01092713-02 207 

No. Meaning Diagnostic 
interrupt 

Missing pulses of incremental encoder 
Cause  Encoder monitoring has detected missing pulses 

 Number of increments per encoder revolution 
incorrectly entered 

 Encoder defective: does not return the defined number 
of pulses 

 Faulty or missing zero mark 
 Interference on the encoder cable 

Effect  The positioning is canceled 
 Outputs are switched off 
 The start enable is cleared 

146 

Remedy  Enter the correct number of increments per encoder 
revolution (parameter assignment screen) 

 Check the encoder and its cable 
 Comply with shielding and grounding regulations 
 Monitoring can be temporarily disabled using the 

parameter assignment screen, but at the responsibility 
of the operator 

Yes 
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A 
Absolute encoder, 144 

Data transmission, 144 
Increments per encoder revolution, 80 
Message frame runtimes, 145 
Monoflop time, 145 
Pulse evaluation, 144 
Response times, 145 

Absolute encoder adjustment, 83 
Alternative, 85 
Determining, 83 
Example, 84 

Absolute incremental approach, 113 
Activate increment 252 

Data for job, 193 
Activate increment 254 

Data for job, 193 
Activate increment 255 

Data for job, 193 
Actual monitoring time, 73 
Actual position value (ACT_POS) 

Example, 53 
Addresses, 189 
Applications 

Parameter transmission, 55 
Assigning parameters, 59 

Requirement, 35 
Assignment 

Front connector, 25 
Asymmetrical output signals, 141 
Asynchronous errors, 148 
Auxiliary voltage 

Encoder supply, 26 
Axis 

Machine data, 75 
Axis data, 75 

B 
Baud rate, 81 
BEG_VAL, 130 
Block library, 37 
Block templates, 37, 49 
Blocks 

Downloading to CPU, 61 
Bounce-free switch, 129 

C 
Cable length 

Maximum, 81 
Calculation 

Resolution, 86 
Call 

FB ABS_DIAG, 47 
FC ABS_CTRL, 41 
FC ABS_INIT, 40 

Call parameters 
FB ABS_DIAG, 47 
FC ABS_CTRL, 41 
FC ABS_INIT, 40 

Cancel, 100 
Incremental approach, 120 

Cancel set actual value, 121 
Data in the channel DB, 123 

Canceling 
Set actual value, 123 
Zero offset, 126 

Canceling jogging, 103 
Canceling the reference point approach, 109 
CH1, CH2, and CH3 encoders, 22 
Changeover difference, 16 
Changeover difference minus, 71 
Changeover difference plus, 71 
Changeover point, 16 
Changing 

Increment tables, 64 
Machine data, 63 

Channel DB, 49 
Content, 189 
Preparing, 60 
Structure, 49 
Task, 49 

Checkback signal for the diagnostics, 140 
Data in the channel DB, 140 
Sequence, 140 

Checkback signals, 190 
Direct access, 52 
Reading, 41, 52 

Checkback signals for the positioning 
Data in the channel DB, 139 
Sequence, 139 
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Checkback signals for the positioning, 139 
Checkback signals in the channel DB 

End of a positioning, 100 
Class 1, 199 
Class 128, 207 
Class 15, 206 
Class 2, 200 
Class 4, 201 
Class 5, 203 
Class 6, 206 
CNT_DIR, 81 
Commissioning, 57 

Example, 164 
Commissioning without parameter assignment screens 

Example, 166 
Configuration package 

Content, 35 
installing, 35 

Configuration software, 59 
Connecting cables, 32 
Connecting the encoders, 24 
Connection diagrams, 183 
Contactor circuit 

Operating principle, 30 
Content 

Channel DB, 189 
Configuration package, 35 
Parameter DB, 194 

Continuous traversing, 112 
Control circuit, 11, 29 
Control mode, 28 
Control signals, 189 

Direct access, 53 
FC ABS_CTRL, 44 
Writing, 41, 53 

Controlled positioning, 15 
Controlling the drive 

Example, 170 
Count direction, 81 
CPU, 13 

Startup, 44 
Creating 

Project, 57 

D 
Data 

Diagnostic DB, 196 
Data block used 

FB ABS_DIAG, 47 
FC ABS_INIT, 40 

Data blocks used 

FC ABS_CTRL, 41 
Data for job 

Activate increment 252, 193 
Activate increment 254, 193 
Activate increment 255, 193 
Length measurement/edge detection, 193 
Read encoder data, 193 
Read position data, 193 
Set actual value, 192 
Set actual value on-the-fly, 192 
Set reference point, 193 
Zero offset, 192 

Data in the channel DB 
Cancel set actual value, 123 
Checkback signal for the diagnostics, 140 
Checkback signals for the positioning, 139 
Edge detection, 130 
Enable input, 136 
Encoder data, 138 
Incremental approach, 118, 120 
Length measurement, 130 
Loop approach, 133 
Position data, 137 
Set actual value, 122 
Set actual value on-the-fly, 122 
Set reference point, 127 

Data in the parameter DB 
Edge detection, 130 
Enable input, 136 
End of a positioning, 100 
Incremental approach, 119 
Machine data of the encoder, 79 

Data transmission 
Absolute encoder, 144 

Data update 
Edge distance, 129 
Length measurement, 129 

Delete diagnostic buffer, 147 
Deleting the distance-to-go, 120 
Determining 

Absolute encoder adjustment, 83 
Diagnostic DB, 50 

Data, 196 
Preparing, 61 
Structure, 50, 196 
Task, 50 

Diagnostic events, 156 
Diagnostic interrupts, 157 

Evaluation, 159 
Incoming, 158 
Outgoing, 158 
Overview, 157 
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Reaction of FM 451, 157 
Diagnostics and interrupts 

Example, 173 
Diagnostics entry 

Structure, 197 
Digital inputs, 27 
Digital outputs, 28 
Direct access 

Checkback signals, 52 
Control signals, 53 

Direction reversal, 133 
DISP_REV, 79 
Distance per encoder revolution, 79 
Distance-to-go, 119 
Do not evaluate enable input, 136 
Done bits 

for function switches, 191 
for read jobs, 191 
For write jobs, 191 

Downloading 
Blocks, 61 

Drive 
Machine data, 68 

Drive data, 68 

E 
Edge detection, 129 

Data in the channel DB, 130 
Data in the parameter DB, 130 
Requirement, 129 
Sequence, 129 

Edge distance 
Data update, 129 
Result, 129 

EDGE_ON, 130 
EDGEDIST, 78, 130 
Effects 

Set actual value, 122 
Set reference point, 128 
Zero offset, 125 

EMERGENCY STOP switch, 11, 21 
Enable input, 105 

Data in the channel DB, 136 
Data in the parameter DB, 136 

Enable input, 105 
Enabling 

Machine data, 63 
ENC_TYPE, 79 
Encoder, 12 

Machine data, 79 
Mechanical adjustment, 85 

Multi-turn, 144 
Single-turn, 144 

Encoder data, 138 
Data in the channel DB, 138 
Requirement, 138 
Sequence, 138 

Encoder interface, 22 
Encoder interfaces, 22 
Encoder range, 78 
Encoder supply 

Auxiliary voltage, 26 
Encoder type, 79 
Encoders 

Connecting, 24 
End 

Positioning, 93 
End of a positioning 

Checkback signals in the channel DB, 100 
Data in the parameter DB, 100 

END_VAL, 130 
Error behavior 

FC ABS_CTRL, 45 
Error bits 

for function switches, 192 
for read jobs, 192 
For write jobs, 192 

Error classes, 199 
Error display, 147 
Error evaluation, 147 

User program, 151 
Error LED, 149 
Evaluation 

Diagnostic interrupts, 159 
Example 

Absolute encoder adjustment, 84 
Actual position value (ACT_POS), 53 
Commissioning, 164 
Commissioning without parameter assignment 
screens, 166 
continue to use, 163 
Controlling the drive, 170 
Diagnostics and interrupts, 173 
executing, 161 
Initialize module, 168 
Overvoltage protection, 31 
Resolution, 87 
START signals of channel 2, 53 
use, 162 

Example codes, 162 
Example project, 161 
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F 
Fast access 

Module data, 52 
Faulty length measurement, 131 
FB 2 

FB ABS_DIAG, 47 
FB ABS_DIAG, 47 

Call, 47 
Call parameters, 47 
Data block used, 47 
Jobs, 47 
Malfunction, 48 
Return values, 47 
Startup, 48 
Tasks, 47 

FC 0 
FC ABS_INIT, 40 

FC 1 
FC ABS_CTRL, 41 

FC ABS_CTRL, 41 
Call, 41 
Call parameters, 41 
Control signals, 44 
Data blocks used, 41 
Error behavior, 45 
Function switches, 42 
Job management, 192 
Jobs, 42, 44 
Return values, 42 
Tasks, 41 

FC ABS_INIT, 40 
Call, 40 
Call parameters, 40 
Data block used, 40 
Return values, 40 
Tasks, 40 

FCs and DBs 
Technical specifications, 51 

Fictitious target, 133 
First parameter assignment 

Increment tables, 64 
Machine data, 63 

FM 451 
Installing, 19 
Removing, 19 
Startup, 44 
Technical specifications, 51 

FM 451 positioning module, 12 
Front connector, 25 

Assignment, 25 
Wiring, 32 

Function switches, 190 

Done bits, 191 
Error bits, 192 
FC ABS_CTRL, 42 

Functions, 37 

G 
Getting prepared for programming, 58 

H 
Hardware installation, 58 
Hardware limit switch, 11, 21 
Home position switch, 105 

I 
INC_REV, 80 
Increment, 142 
Increment number 1 to 100, 89 
Increment number 1-100, 113 
Increment number 252, 90, 114 
Increment number 254, 91, 115 
Increment number 255, 92, 116 
Increment table 1, 195 
Increment tables 

Changing, 64 
First parameter assignment, 64 
Reading, 64, 65 
Writing, 64 

Incremental approach, 112 
Cancel, 120 
Data in the channel DB, 118, 120 
Data in the parameter DB, 119 
Increment number 1-100, 113 
Increment number 252, 114 
Increment number 254, 115 
Increment number 255, 116 
Requirement, 112 
Shutdown, 119 

Incremental approach with increment number 252 
Sequence, 114 

Incremental approach with increment number 254 
Sequence, 115 

Incremental approach with increment number 255 
Sequence, 116 

Incremental encoder, 141 
Increments per encoder revolution, 80 
Missing pulses, 82 
Response times, 143 
Signal forms, 141 
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Increments, 63, 88 
Requirement, 88 

Increments per encoder revolution, 80 
Indecision, 143, 146 
Initialize module 

Example, 168 
Installation guidelines, 179 
Installing 

Configuration package, 35 
FM 451, 19 

INTF LED, 149 

J 
Job 

Cancel set actual value, 121 
Set actual value, 121 
Set actual value on-the-fly, 121 
Set reference point, 127 

Job management, 41 
for FC ABS_CTRL, 192 

Job processing 
Sequence, 43 

Job status, 45 
JOB_ERR 

Messages, 198 
Jobs 

FB ABS_DIAG, 47 
FC ABS_CTRL, 42, 44 

Jog mode, 101 
Operating mode sequence, 101 

Jogging, 101 

L 
LED EXTF, 149 
LEN_VAL, 130 
Length measurement, 129 

Data in the channel DB, 130 
Data update, 129 
Faulty, 131 
Minimum, 131 
Requirement, 129 
Result, 129 
Sequence, 129 

Length measurement/edge detection 
Data for job, 193 

Load circuit, 29 
Loop approach, 132 

Data in the channel DB, 133 
Requirement, 132 

Sequence, 132 
Loss of 

Synchronization, 126 

M 
Machine data, 63, 194 

Axis, 75 
Baud rate, 81 
Changing, 63 
Count direction, 81 
Distance per encoder revolution, 79 
Drive, 68 
Enabling, 63 
Encoder, 79 
Encoder type, 79 
First parameter assignment, 63 
Increments per encoder revolution, 80 
Message frame length, 79 
Minimum edge distance, 78 
Monitoring functions, 82 
Number of encoder revolutions, 80 
Reading, 64 
Writing, 63 

Machine data of the encoder 
Data in the parameter DB, 79 

Malfunction 
FB ABS_DIAG, 48 

Maximum cable length, 81 
Mechanical adjustment 

Encoder, 85 
Message frame error, 82 
Message frame length, 79 
Message frame runtimes 

Absolute encoder, 145 
Messages 

JOB_ERR, 198 
Minimum edge distance, 78 
Minimum length measurement, 131 
Missing pulses 

Incremental encoder, 82 
Module cycle, 51 
Module data 

Fast access, 52 
MON_FRAME, 82 
MON_PULSE, 82 
MON_WIRE, 82 
Monitoring functions, 82, 93 
Monitoring time, 73, 93, 95, 96 
Monoflop time 

Absolute encoder, 145 
Motor, 11 
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Motor circuit-breaker, 21 
MSR_DONE, 130 
MSR_ON, 130 
MSRRD_EN, 130 
Multiturn encoder, 144 

N 
NO_REV, 80 

O 
Operating mode 

Incremental approach, 112 
Operating principle 

Contactor circuit, 30 
Operating range, 16 
Output signal 

asymmetrical, 141 
symmetrical, 141 

Overview 
Diagnostic interrupts, 157 

Overvoltage protection 
Example, 31 

P 
Parameter DB 

Areas, 50 
Content, 194 
Structure, 50 
Task, 50 

Parameter transmission 
Applications, 55 

Position 
Sub D sockets, 22 

Position data, 137 
Data in the channel DB, 137 

Position of the fictitious target, 134 
Positioning 

End, 93 
Power unit, 29 
Power unit, 29 
Preparing 

Channel DB, 60 
Diagnostic DB, 61 
Programming, 58 

Program structure, 46 
Programming, 37 
Protective circuit, 29 
Pulse, 143 

Pulse evaluation 
Absolute encoder, 144 

R 
Range of values 

Resolution, 86 
Reaction of FM 451 

Diagnostic interrupts, 157 
Read encoder data 

Data for job, 193 
Read jobs, 43 

Done bits, 191 
Error bits, 192 
Trigger bits, 191 

Read position data 
Data for job, 193 
Sequence, 137 

Reading 
Checkback signals, 41, 52 
Increment tables, 64, 65 
Machine data, 64 

Reference point approach, 105 
Reference point approach mode, 105 

Operating mode sequence, 105 
Reference point coordinate, 76 
Reference point switch, 25 
Reference velocity, 73 
Relationship 

Traversing range, 87 
Relative incremental approach, 113 
Removing 

FM 451, 19 
Requirement 

Assigning parameters, 35 
Edge detection, 129 
Encoder data, 138 
Incremental approach, 112 
Increments, 88 
Length measurement, 129 
Loop approach, 132 
Set actual value, 121 
Set reference point, 127 
Zero offset, 124 

Resolution, 86 
Calculation, 86 
Example, 87 
Range of values, 86 
Traversing range, 87 

Response times 
Absolute encoder, 145 
Incremental encoder, 143 
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Result 
Edge distance, 129 
Length measurement, 129 

Return values 
FB ABS_DIAG, 47 
FC ABS_CTRL, 42 
FC ABS_INIT, 40 

Reversing switch, 25, 105 

S 
Safety concept, 21 
Safety system, 11 
Safety-relevant switches, 58 
Selecting 

System of units, 66 
Sequence 

Checkback signal for the diagnostics, 140 
Checkback signals for the positioning, 139 
Edge detection, 129 
Encoder data, 138 
Incremental approach with increment number 1-
100, 113 
Incremental approach with increment number 
252, 114 
Incremental approach with increment number 
254, 115 
Incremental approach with increment number 
255, 116 
Job processing, 43 
Length measurement, 129 
Loop approach, 132 
Read position data, 137 
Set actual value, 121 
Set actual value on-the-fly, 121 
Set reference point, 127 
Zero offset, 124 

Set actual value, 121 
Canceling, 123 
Data for job, 192 
Data in the channel DB, 122 
Effects, 122 
Requirement, 121 
Sequence, 121 

Set actual value on-the-fly, 121 
Data for job, 192 
Data in the channel DB, 122 
Sequence, 121 

Set reference point, 127 
Data for job, 193 
Data in the channel DB, 127 
Effects, 128 

Requirement, 127 
Sequence, 127 
Synchronization, 127 

Setting up a project, 57 
Shutdown, 99 

Incremental approach, 119 
Shutdown of jogging, 103 
Signal forms 

Incremental encoder, 141 
Single-turn encoder, 144 
Slot, 19 
Software limit switch end, 77 
Software limit switch start, 77 
Standard system of units, 66 
Standstill range, 16, 72 
Standstill velocity, 73 
START signals of channel 2 

Example, 53 
Startup 

CPU, 44 
FB ABS_DIAG, 48 
FM 451, 44 

Step sequence frequency, 146 
Structure 

Channel DB, 49 
Diagnostic DB, 50, 196 
Diagnostics entry, 197 
Parameter DB, 50 

Sub D sockets 
Position, 22 

Switches 
Safety-relevant, 58 

Switching points, 16 
Switching ranges, 16 
Switch-off difference, 16 
Switch-off point, 16 
Symmetrical output signals, 141 
Synchronization 

Loss of, 126 
Reference point approach, 105 
Set reference point, 127 

Synchronous errors, 148 
System of units 

Selecting, 66 
Standard, 66 

T 
Target, 16 
Target approach, 95 
Target range, 16, 72 
Task 
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Channel DB, 49 
Diagnostic DB, 50 
Parameter DB, 50 

Tasks 
FB ABS_DIAG, 47 
FC ABS_INIT, 40 

Technical specifications 
FCs and DBs, 51 
FM 451, 51 

Test sequence 
Example, 163 

Test steps 
Function switches, 60 
Jobs, 60 
Operating modes, 60 

Testing, 59 
Tool, 19 
Total number of encoder steps, 80 
Traversing range, 78 

Relationship, 87 
Resolution, 87 

Trigger bits 
for read jobs, 191 
For write jobs, 190 

Type of reference point approach, 77, 109 
Types of error, 148 

U 
UDT, 49 
User program 

Error evaluation, 151 

W 
Wire break, 82 
Wiring, 58 

Front connector, 32 
WORKING, 93 
Working range, 78 
Write jobs, 43 

Done bits, 191 
Error bits, 192 
Trigger bits, 190 

Writing 
Control signals, 41 
Control signals, 41 
Increment tables, 64 
Machine data, 63 

X 
X1, 25 

Z 
Zero offset, 124 

Canceling, 126 
Data for job, 192 
Data in the channel DB, 125 
Effects, 125 
Requirement, 124 
Sequence, 124 
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